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This workbook contains the exercises for a GIS course in the School of Earth and Environment at University of Leeds.
This workbook is provided in Word format. You can download alternative formats via Minerva, e.g. pdf or epub. Look for the link after the download. These alternative formats are not available directly from Clare.
You are welcome to keep your own notes within your copy of the workbook. An up-to-date version will always be available to you within Minerva. Updates may be made during the module based on questions from students and whether anything appears to be unclear. The date that each chapter was last updated will be just under the chapter heading.
If you are working with both Word and GIS open, you may find it easier to use the instructions if you use Reading view in Word. To try this go to View > Read Mode (Word Desktop app) or View > Reading View in Word online. The View menu will then let you change the background colour, the column width, and some other options. You will be able to change the width of Word and the text and images will scale properly.
To exit reading view, press the Esc key on your keyboard, or the Print Layout button at the bottom of the Word window. Hover over buttons to see a tooltip.
[image: images/svg/videocam-black-24dp.png] Office365 - assistive viewing features
This video clip can be found in the module area of Minerva or in the full list of video clips.
Software
The exercises in this workbook are written using QGIS and instructions for gaining access to the software are available in the software document in Minerva.
This workbook acknowledges use of QGIS: QGIS Development Team, 2023. QGIS Geographic Information System. Open Source Geospatial Foundation Project.
How to use these exercises
The following conventions are used:
Video clips of techniques are available in Minerva or in the list of videoclips. They aren’t fancy, just what you’d see if I gave a demonstration in class, but you may find them useful as a supplement to the written instructions.
They are shown as follows in the worksheets:
[image: images/svg/videocam-black-24dp.png] Spatial bookmarks in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Information boxes point out techniques that you may already know about. They are here as reminders, or as quick tips:
[image: images/svg/info-black-24dp.png] Adding a folder connection in the Catalog pane
If you can’t see your network drive or USB device in the list of folders when adding data or viewing the catalog you need to Connect to folder
For something you should do following previous instructions:
[image: images/svg/create-black-24dp.png] Change page size and orientation
Have a look for each of the tools suggested below and try them out to see what they do. Make notes in the spaces provided.
For a question:
[image: images/svg/help_outline-black-24dp.png] Question title
What do you think of this? Make your own notes either in the document (if you’re using the Word version) or in your own notebook.
For a warning - take note of these, they can often save you time and trouble:
[image: images/svg/warning-black-24dp.png] Warning
If you do x it won’t always work! Make sure that you do y.
For recommended reading related to the current section:
[image: images/svg/library_books_black_24dp.png] Recommended reading
Recommendations will usually be to books from the module reading list which is linked from Minerva.
Contact me
If you find any problems with these instructions, please get in touch with me giving full details of the section and the problem and I will do my best to correct it.
Email me at: c.e.gordon@leeds.ac.uk
Clare Gordon © 2023 The University of Leeds.
[image: ../../shared/docs/images/CreativeCommons88x31.png]
Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
Introduction to GIS with QGIS
The background to GIS and an explanation of what it is will be covered in the lecture before this class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate how to open a map project in QGIS
· select appropriate tools to navigate in a map document
· use layers to organise and display information on a map
Introduction to the exercises
The exercises in this workbook will build on each other so that by the end of this part of the module you will have used data from a variety of sources to create a map layout covering an area of North Wales near the village of Llanbedr. You will be able to include maps showing the gravity anomaly for the area and the geology. You will also include some interpretation of your maps.
[image: images/introduction/LlanbedrAirfield_small.jpg]
The view across Llanbedr Airfield, North Wales.
In this first section I have provided the data for you but as the exercises progress you will find out more about how to find your own data.
Obtaining the data for this chapter
You can download the data for this chapter from Minerva.
· Go to this module in Minerva, then to Learning Resources > GIS information > Week 7
· Download NorthWalesDataQ.zip from this folder by right-clicking and saving to your local disk.
· Create a folder called gis in your file system. You’ll need a total of about 170 MB of free space to complete the following exercises. 
· Move the downloaded data into your gis folder
· Unzip the file in this location
· In My Computer right-click on the zip file
· If you have 7-zip go to 7-zip > Extract Here[footnoteRef:57] [57:  7-zip is also open-source so if you want to install a copy on your own Windows computer you can - just download it from the 7-zip webpage.] 

· If you don’t have 7-zip, right-click Extract files... and select the location to save the files, then OK[footnoteRef:59] [59:  Note that these instructions are for Windows, if you are on a Mac or Linux computer you will still need to unzip the files, but I don’t have access to one of these to write the instructions.] 

[image: images/svg/warning-black-24dp.png] Warning
Never try to use the contents of a zipped file in QGIS without extracting it first - it won’t work. If you are looking for a file in QGIS and can’t find it, always check via My Computer that the file isn’t inside a zip or 7zip archive.
The contents of the zip file should look something like the following image when they are unzipped, with two further folders, a OSM.gpkg file and a NorthWales.qgz file.
[image: images/introduction/Data_small.png]
The data inside the zip file for this project.
Opening the map project in QGIS
You will be given instructions in the first class on how to open QGIS via Appsanywhere. Alternatively, instructions are available in the software.docx document in Minerva for this module.
· Open QGIS via Appsanywhere (see note above).
· Then Project > Open.
· navigate to where you put the project files and select NorthWales.qgz
· click Open
The image below shows how the project will look in QGIS when you first open it. Note that yours may look different to mine as buttons and toolbars can vary in location. You may also get a notice at the top of the window warning you about the project having being last saved in version 3.11. Just ignore it or close it, this won’t be a problem for you.
[image: images/introduction/QGISOpenProjectAnno.png]
The QGIS window when you open the “NorthWales” project. Your toolbars and buttons may be different to mine.
Navigation in QGIS
Once you have data on a map in QGIS there are various tools which will allow you to zoom in and out and move around the map view.
Zoom to Layer
A lot of the work that you do in GIS will be layer-based. Each file that you add is a layer and will appear in the Layers panel on the left.
Zoom to Layer is an extremely useful command to know and you’ll probably find yourself using it a lot.
· Right-click on the Places layer (sub-heading) in the Layers panel
· Select Zoom to Layer
Your map should zoom out so that you can see a bigger area of the Welsh coast. You’re zoomed well out so this particular map looks a bit messy and may take a bit of time to load, but once it does you should be able to see Harlech and Dolgellau.
The Map Navigation Toolbar
Tools for zooming in and out and for moving around the map are available on the Map Navigation Toolbar.
[image: images/introduction/MapNavigationToolbarAnno.png]
The Map Navigation Toolbar.
If the toolbar isn’t already visible in QGIS go to
· View > Toolbars
· and tick the box next to Map Navigation Toolbar
[image: images/svg/create-black-24dp.png] Trying out the navigation
Try out the following tools in turn on your map so that you are aware of what they do.
Pan - use the hand cursor to “grab” the map and move it around
Zoom in - click on the button, then on the map. You can also use the middle mouse wheel to zoom in and out of your map.
Zoom out - click on the button, then on the map. You can also use the middle mouse wheel to zoom in and out of your map.
Full extent to see the whole map (again be patient while it loads) - then use Zoom to Layer to get back to the extent of the Places layer.
Working with map layers in QGIS
Layers are an essential part of any GIS. As you build up the data for your projects you will be adding layers and carrying out operations on them, either individually or together, so it’s important that you understand how to control them.
[image: images/svg/info-black-24dp.png] Layers are a reference to a particular data source
An important concept to grasp is that each layer is a reference to a particular data source.
In practice the most obvious signs of this are that if you remove a layer from your map, you are not deleting it from your computer, it still exists there, but you are removing the reference to it from your GIS project.
There are other signs, but I’ll point those out as we go along. For now, remember that if you want to move the map project or share it with anyone else, the data sources on your computer need to stay with the map project. For example, if you want me to look at your map, but then just send me the qgz file, I won’t be able to see anything when I open the file. The data will not be present. If you need help from me, it is usually more effective to send a screenshot than try to send the whole project.
The Layers panel on the left hand side of the map window shows the layers that are in your map and how their features look and allows you to control their visibility.
In this project the layers so far include:
· Places
· Line features
· Polygon features
· Tidal water
[image: images/svg/videocam-black-24dp.png] Working with layers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Watch the video clip on “Working with layers in QGIS”. Then get used to working with layers by following the instructions below.
Viewing contents of layers
If you have added vector data, which all the layers so far are, you’ll also be able to refer to the layers panel as a key to your symbols. This is particularly useful if a layer has multiple symbols.
· Click on the little arrow next to the Polygon features layer - assuming it started “closed”, you should now be able to see lots of different symbols and an explanation of what they show.
· Click on the little arrow again to fold the list away and repeat this for the Places and Line features layers.
Making layers visible and invisible
There will be times when you don’t want all the layers to be visible on your map, but you won’t necessarily want to actually remove them completely. It is simple to make layers visible and invisible.
· Click in the little box next to one of the layers - the tick will disappear and so will that layer in your map
· To make the layer visible click in the little box again.
[image: images/introduction/LayersVisibleInvisible_small.png]
The box is unticked, so the Polygon features layer no longer shows on the map. Tick it again to make it visible once more.
You’ll notice in layers with multiple symbols that you can turn each of those off individually too. For example,
· Fold down the Places layer in the contents
· then untick next to Town
The names for Harlech and Dolgellau should disappear, but if you zoom in you will still be able to see the other place names.
· Make sure you tick back in the Town box.
Locating features
The layers in your map at the moment are vector feature classes and are searchable (you’ll find out more about the data types raster and vector later).
[image: images/svg/videocam-black-24dp.png] Locating features in vector layers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click in the Type to locate box at the lower left, or use Ctrl+K on the keyboard
· Have a look at the list of options that pops up - it looks a bit confusing to start with but is simple to use.
[image: images/introduction/TypeToLocateOptions_small.png]
Click in the Type to locate box to get a list of options.
· Type the following in the box - af Harlech. The af shows that you want to search for Features in all layers
· As you type a list of options will appear - double-click on one of the options for Harlech Castle (it doesn’t matter which)
[image: images/introduction/TypeToLocateHarlech_small.png]
Clicking on one of the Type to Locate results should take you to the feature you choose.
This can be a useful way of finding things on your map if you are using vector layers.
Adding data to maps as layers in QGIS
As with many processes in GIS there are more than one way to add data to QGIS.
[image: images/svg/videocam-black-24dp.png] Adding new layers to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Adding layers to QGIS with the Browser
Now have a look at the Browser panel
If you can’t see the Browser which shows you where files are on your file system, go to:
· View > Panels and tick in the box next to Browser
Using the Browser you should be able to navigate to the folder in which you saved your downloads.
If you have saved your data in the same folder as the map you should be able to find everything under the Project Home heading, otherwise you’ll have to browse through your file system.
· Browse to your downloaded files and look for a folder called gb-overview
· have a look in the folder and find a file called GBOverview.tif
· drag and drop that file to the Layers panel
· Right-click on the GBOverview layer in the Layers panel and Zoom to layer
You should now be able to see a map of Great Britain in the main panel.
[image: images/introduction/GBOverview.png]
QGIS once you have added the GBOverview layer to a map.
This is probably the easiest way to add data to your maps.
Adding raster data to a map with the Data Source Manager
As with so many tasks in GIS there is more than one way to add data to QGIS.
· On the menu bar go to Layer > Data Source Manager
· Click on Raster on the left
· then click on the button with three dots next to the Source box
· Navigate to the raster-25k folder and select raster-25k_3706482.tif
· Click on Open
· Then click on Add, and then on Close
[image: images/introduction/DataSourceManager.png]
Adding a layer via the Data Source Manager.
The new layer will be added to your Layers panel, but you probably won’t be able to see it on your map as it only covers a small area.
· Right-click on the raster-25k layer in the Layers panel and Zoom to Layer to be able to see the new map.
It won’t look great at this zoom level, but you can use the Zoom in button, or the middle mouse button, to see it more clearly.
These two new layers are raster data types. Again, you’ll find out more about these later.
Adding vector data to a map
The vector files on this map are all stored in a Geopackage called OSM.gpkg.
This is a form of database which stores and retrieves spatial data efficiently. If you look at this in File Explorer you’ll note that it looks like a single file. If you look at it in the Browser in QGIS you’ll see there is a little arrow next to it - the advantage of using the browser is that it is specifically designed to work with spatial data.
[image: images/introduction/OSMGeopackage_small.png]
The OSM geopackage with the layers that it contains visible in the Browser.
· Drop down the little arrow next to OSM.gpkg
· You should be able to see the layers that are stored in the geopackage - as in the image above
· Select the multilinestrings layer in the Browser and drag and drop it into the Layers panel
You may need to Zoom to layer to see what you have just added. It should be a few lines in a random colour.
You can also add vector layers via the Data Source Manager
· Go to Layer > Data Source Manager
· Click on Vector on the left
· then click on the button with three dots next to the Source box
· Navigate to the OSM.gpkg file and select it
· Click on Open (If you’re using a newer version of QGIS you’ll also need to click on Add)
· You’ll get a choice of vector layers to add - select the points layer
· Then click on OK, and then on Close
[image: images/introduction/DataSourceManagerVector_small.png]
Adding a vector layer via the Data Source Manager.
The new layer will be added to your Layers panel and you should see a lot of randomly coloured point symbols on your map.
[image: images/introduction/InterimMap01_small.png]
Your map with the four new layers. Your colours will probably be different.
Removing layers
Your map is looking rather a mess now, so let’s clear it up a bit.
You won’t need the GBOverview, points and multilinestrings layers for the rest of this exercise so they can be removed.
Note that removing layers from your map does just that. You are not deleting the data from your disk, they still exist, but you are removing the link between the map and your data.
· Right-click on the points layer (it may appear as OSM points)
· Remove layer...
· You’ll be asked to confirm that you want to remove the layer, click on OK
· Repeat the process with the multilinestrings and GBOverview layers. The process is identical for raster and vector layers.
Ordering the layers in the Layers panel
The order of the layers in the Layers panel affects how they appear on the map. Layers at the top of the list appear on top of the layers lower down.
At the moment you probably have the raster-25 layer above the other layers, so you can’t see them at the moment - though the labels still appear.
· Drag and drop the raster-25k layer from the top of the list in the Layers panel to the bottom.
Again, your map will look rather a mess. Just make the following layers invisible for now.
· Places
· Line features
· Polygon features
· Tidal water
You will be working with this map for the rest of the course so go to the correct area by using Type to locate to find Llanbedr Airfield.
Saving your map
Save your map projects at regular intervals. You will be doing a lot of work on them and can lose a lot of time if you have to do your work again because the program has crashed.
· Project > Save or alternatively Ctrl + S (Windows)
· If this is the first time you’ve saved it, make sure you remember where you have saved it to and give the file a name which will help you remember what it is. It is a good idea to save all your files to the same gis folder and make sub folders for each individual project.
It is also a good idea to keep back up copies of your project and of the data files. Particularly once you start editing, problems can corrupt the whole file, so make a copy of your gis folder on a separate disk/drive/usb stick each time you finish a session working on them.
Repairing missing file links
I’ve already said above, that “each layer is a reference to a particular data source on disk”. This has implications for how you manage your data, particularly if you are going to be moving your project from one computer to another or moving files around within your folders.
What happens if you move your data?
If you’ve followed the instructions above, you’ll be able to see several layers in your map and in the Layers panel.
What happens if you move these layers outside of QGIS? Let’s have a look.
· Save your map (Ctrl-S or Project > Save) and close QGIS.
· In your system file explorer navigate to where you have saved the files for this project and go into the folder named NorthWalesQ.
· Create a new folder inside this one and call it Data.
· Move the OSM.gpkg file into the new folder.
· Also move the raster-25k folder into the new folder.
· Now reopen your map in QGIS.
[image: images/svg/help_outline-black-24dp.png] What happens when you open your map?
What’s the first thing that pops up when you try to open your map?
You will probably get a pop-up window titled Handle Unavailable Layers which lists the layers that QGIS can no longer find in their original location. (Don’t worry if you don’t!)
[image: images/introduction/HandleUnavailableLayers_small.png]
The Handle Unavailable Layers pop-up.
It is possible to repair the broken links using this dialog, but I find it easier to do so in the main map.
· Click on Keep Unavailable Layers on the pop-up to close it.
Your map should open but will be blank. Have a look at the Layers panel and you should see small warning triangles on the right next to each missing layer.
[image: images/introduction/MissingLayersWarningTriangles_small.png]
The warning triangles on the right of the layers in the Layers panel. These warn you that the layer is missing.
At this stage, don’t panic! As long as you know where the data files are stored on your computer, you can repair the links from QGIS.
Repairing broken links to data
[image: images/svg/videocam-black-24dp.png] Repairing broken links to data in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To repair the broken links in the Layers panel:
· click on the warning triangle next to the Places layer.
The Repair Data Source window should open.
[image: images/introduction/RepairDataSource1_small.png]
The Repair Data Source window.
· Have a look at the bottom of the window - it shows you the Original source URI: - that’s where QGIS is looking for your layer.
· If you don’t know where your data has gone, use the Original source URI as a starting point to look for it. This will also tell you the name of the data file your are looking for.
Once you do know where your data is located on your computer you can easily repair the link by navigating to the data in the list of locations provided.
· In this case you moved all your data into a folder called “Data”, so navigate to that in the Repair Data Source window and look for the OSM.gpkg file.
· Click on the little arrow next to OSM.gpkg and then click on the correct layer - points.
· Click OK
[image: images/introduction/RepairDataSource2_small.png]
Selecting the correct data source.
Once you click OK you should find that the layer loads as expected and the warning symbol disappears. If you are selecting a layer from a geopackage you may even find that all the layers from the same geopackage load.
In this case, hopefully the Line features, Polygon features and Tidal water should all lose their warning triangles. Tick to show them on your map to check, but untick them again before you do the next instruction.
[image: images/svg/create-black-24dp.png] Repair the link for the final layer
The vector layers in your map should be loaded now. If not, repeat the process to load them.
You also have a raster layer on your map which won’t have loaded along with the vector layers - raster-25k_3706482.tif. That will still have the warning symbol.
Use the same instructions as above to load the raster layer, but this time you’ll need to look in the raster-25k folder for the data, instead of inside the geopackage.
Once you’ve done this your map should be complete again and there should be no warning symbols in the Layers panel.
Avoiding missing file links
If you know where your data files are located, you should be able to fix missing links now, but it would be better to avoid needing to in the first place.
· Check that Save paths are set to Relative
· Go to Project > Properties and make sure you’re on the top tab - General settings.
· In the top section look for Save paths and check that it is set to Relative, not Absolute [footnoteRef:141]. [141:  Setting the save paths to relative instead of absolute means that if the drive letter changes, or you work on a different machine, QGIS still looks for the data in the same relative location compared to the map, rather than expecting them to still be on the original machine.] 

· Click on OK.
· When you download data or set up a new project make sure that you start with a single folder for the project and save everything for that project into that folder. Be disciplined. If you download something, move it to the project folder straight away or you’ll forget and lose it.
· When you download the North Wales project, all the files are stored in the same folder. This means that if you want to move the project, or save it to another drive, all the data is together. You can move the main folder (NorthWalesQ in this case) or zip the whole thing and move that. You don’t need to worry about losing files.
[image: images/svg/warning-black-24dp.png] Warning
Please bear in mind that you need to be aware of where you are saving your files and take responsibility for that yourself. If you lose your files, I probably can’t help you to find them again as I don’t know where they are likely to be.
Checking and setting the coordinate system
The coordinate system is an important property which tells QGIS where data is located on the surface of the Earth and what measurement system is used for your datasets. It is important to have this set correctly or the layers in your map will not display correctly.
If you are working in Great Britain then the coordinate system is most likely to be British National Grid, though you may also have data in the unprojected WGS 1984. For this project we will be working in British National Grid.
QGIS will set the coordinate system of the map to that of the first data layer that is added. In this case it was the Places layer.
[image: images/svg/videocam-black-24dp.png] Checking and setting the crs of your project in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Check whether the coordinate system is set correctly as follows:
· Go to Project > Properties and click on the CRS heading to the left
[image: images/introduction/ProjectPropertiesCRS_small.png]
The CRS dialog of the Project Properties. This is set to British National Grid.
This rather complex-looking dialog controls the CRS or Coordinate Reference System for the whole project.
Look at the box to the left of the map - this shows that the CRS is currently set to British National Grid. The map on the right confirms that this CRS covers the correct area.
It is possible to use the Filter box at the top to search for other coordinate systems, though this isn’t necessary for this project.
· Click OK to close the project properties.
If you look at the bottom right of the map window you should also see that the CRS is shown there, but this time only as a short numerical code - EPSG:27700.
[image: images/introduction/CRS_small.png]
The short form of the CRS shown in the bottom right of the map window. Click on this to get to the CRS properties quickly.
If you click on this, you will be taken to the CRS tab of the project properties.
The final map for this chapter
You should finish this chapter with a map of the Llanbedr Airfield on the Welsh coast. Your map and the rest of the project should look something like the image below, though your map may cover a slightly different area. It isn’t a problem if it does.
[image: images/introduction/FinalMap.png]
The final map for this chapter showing the 1:25 000 raster image covering Llanbedr Airfield.
If you want me to give you feedback on this map, or on any stage of the process, please upload a screenshot to your GIS Portfolio - you’ll be given instructions on how to get access to this in the class. If you upload anything please email me to let me know that you have done so.
Don’t forget to save and backup this project. You’ll be using it for the rest of this course so make sure that you have it with you next week.
Further information and suggested reading
Many of the books in the reading list[footnoteRef:160] have a general introduction to GIS which explain what it is and how it is used. Suggestions include the following: [160:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 1, What is GIS? in Heywood, I., Cornelius, S. and Carver, S. (2011), pp. 2-30
· Chapter 1, Systems, Science and Study in Longley, P.A. et al. (2015), pp. 3-37
What is GIS? and some example applications
· ESRI UK (who publish proprietary GIS software ArcGIS) have a web page which includes an Overview of GIS and a GIS Showcase which includes examples of how GIS can be used.
· The webpage GIS for Science gives a lot more ideas for how GIS can be used by scientists.
Finding spatial data to use in GIS
Last Modified: 08 Dec 23, 12:33:48
The background to finding data will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· find suitable data for GIS projects from a variety of sources.
· acknowledge and cite the data that you use in your maps in a suitable fashion.
Introduction
Being able to find, download and prepare your own data is an essential part of using GIS. While the data will be provided for you for many of the exercises in this module, you will find it useful to have some idea of where the data comes from, and what there is available for you to use for your own maps.
While downloading shouldn’t take too long, don’t leave it until the last minute before you have to produce a map. Websites can become unavailable either permanently or temporarily, or computers can crash.
Digimap
Digimap is a service provided to Higher Education in the U.K. by EDINA at Edinburgh University. Digimap provides a front end to digital maps and data of Great Britain from the Ordnance Survey and British Geological Survey, amongst others. The University of Leeds subscribes to the collections and as a student you have access to maps and data for use as part of your studies.
Logging in to Digimap
If you have not used Digimap before you will need to register and log in using your University ID, that is the username and password that you use to access University systems such as Minerva.
Full instructions for logging in are on the Digimap help pages.
· Go to the Digimap Collections page at https://digimap.edina.ac.uk
[image: ../../shared/docs/images/finding_data/login2023_small.png]
The Digimap initial page - note the “Log in” button at top right.
· Click the Log in button at the top right of the screen.
· type Leeds in the box and select University of Leeds from the list of available institutions.
· You should get the familiar University of Leeds log in page, so type your University username and password into the appropriate boxes and then click the Log in button. If you are already logged in to Minerva, you may find that you don’t have to enter your login details again.
If this is the first time that you’ve logged in to Digimap you’ll be asked to register for each collection separately, though you can do all at one go. You won’t need to use all the collections during this module, but it’s worth registering for all that are available to you so that you can explore them for yourself.
· Go through the list of collections, read and accept the conditions for each one, selecting Academic Works (coursework, projects, dissertations etc.) in the Purpose dropdown for each.
Once you submit all those, you should be taken to the Digimap initial page again, as shown below, but this time you should see your name at top right rather than the log in button.
[image: ../../shared/docs/images/finding_data/ChoosingDataCollection2023_small.png]
The Digimap main page again, this time with your name at the top right. You can now select a collection from the menu across the top.
The list includes options for several collections. In this workbook we’ll only be looking at the collections that are the most relevant for creating the maps you’ll need during your course, but if you are interested in any of the others feel free to explore them. EDINA have worked to make all the tools similar across each collection, so just have a go!
Browsing maps on screen
Digimap has recently changed the interface (Summer 2023) so the previous separate links for browsing (Roam) and downloading are now combined. If you used the previous version of Digimap, the new interface offers all the same functions but in a slightly different way.
· As an example of the Digimap interface, which is similar in all collections, click on Ordnance Survey on the menu at the top of the main screen.
· Then select OS Digimap under View maps and download data on the right.
[image: ../../shared/docs/images/finding_data/OSDigimap02_2023_small.png]
Click on OS Digimap to enter the application.
[image: ../../shared/docs/images/finding_data/OSDigimap01_small.png]
The OS Digimap interface for Ordnance Survey data.
Now try browsing the maps.
· Have a go at zooming in and out and exploring the map at different scales.
· Try searching for a location in the Search places, coords, postcodes... box at the top left, for example type in Leeds and press <Enter>. From the list that appears click on Leeds (Leeds) then use the cross at the top of the list to close it.
In this module we’ll be making most use of the Download functions, but it’s worth knowing how to browse the maps too, so have a quick go with a few of the tools on the left before continuing with the next exercise.
If you want more information about using the browsing interface have a look at the Digimap Help Centre which is linked from Help on the main page.
Downloading data from Digimap
As well as browsing data on screen you can download data from Digimap for use in GIS or CAD software. The format that the data is delivered in will determine whether you will be able to open it directly in a software package or whether you will need to convert it.
We’ll be using data from Digimap in QGIS for various exercises in the rest of this module, so you need to know your way around this section. Instructions for converting, importing and viewing file types that need it will be given later in the workbook.
As an example of the download interface, we’ll download some Ordnance Survey data but all the collections work in a similar way.
· If you’re not already in the OS Digimap interface, start from the Digimap main page (you can get back to it by clicking on the icon at the top left of any of the maps - hover over to see a tool tip).
· click on Ordnance Survey in the menu at the top of the page.
· from the right-hand side of the Ordnance Survey page choose OS Digimap.
[image: ../../shared/docs/images/finding_data/OSDigimap02_2023_small.png]
Click on OS Digimap to enter the application.
You’ll be in the same map as the one in which you were able to browse maps.
· To get to the download options, click on the Download Data option at the bottom of the left-hand menu.
The options will change to those for downloading data.
[image: ../../shared/docs/images/finding_data/OSDigimap03_small.png]
The download interface to download Ordnance Survey data.
Selecting an area
On the left there is a menu panel with options for selecting an area, with a search box above it.
[image: ../../shared/docs/images/finding_data/DownloadSearch2023_small.png]
Digimap Download - search for and select an area.
· Click in the Search places, coords, postcodes... box and type Otley, then press <Enter> or click on the magnifying glass to search.
· When you get the results click on Otley (Leeds) to zoom to the correct area, then close the search results.
· Under Draw click on the rectangle and use the mouse to draw a box around the area shown by an orange box in the image below, clicking once to start and again to finish the box. It doesn’t matter if the box you draw is a bit bigger but try not to make it any smaller.
[image: ../../shared/docs/images/finding_data/DownloadArea.png]
The minimum area to select using the rectangle tool.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Area view
Note that the map you see on the screen only shows the area that you will be downloading data for, not the actual data that you’ll be downloading. You’ll select the data in the next section so don’t worry what it looks like for now.
Selecting data sets
Now that you have selected an area you have to select the data that you need.
· Back in the panel on the left, under Select Data Products, drop down each of the headings, e.g. Backdrop Mapping, in turn by clicking on the arrow next to them.
[image: ../../shared/docs/images/finding_data/DownloadChoices.png]
The list of data products - click the arrow next to each subheading to see the full list.
· There are a lot of different data sets here and most of them won’t mean anything to you. For now select the following data sets when you find them, by putting a tick in the box next to them.
· Backdrop mapping > VectorMap Local Raster
· Land and Height data > OS Terrain 5 Contours
You can get more information about the data sets by clicking on the arrow next to them. This includes information on licences - which you will need to know later.
The number on the right in brackets under Order Size shows how many tiles your selected area uses out of the maximum downloadable number. If you have chosen a slightly different area to me your number may be different, but you should still be well within the limit.
[image: ../../shared/docs/images/finding_data/DownloadDatasetsInfo.png]
Selecting datasets. The image shows the information for the VectorMap Local Raster dataset and that I am going to download one tile out of the maximum limit of 400.
· When you have selected the data you require click on Add to Basket (Don’t worry, despite the Basket and Checkout you won’t be charged. The University has already paid the subscription.)
Your basket should appear with details of your order.
[image: ../../shared/docs/images/finding_data/DownloadBasket2023_small.png]
Details of your order in the Basket. Yellow highlights show choices that you need to make before you can request download.
· Some datasets will give you an option to change the format. In this case click on Select Format next to the OS Terrain 5 Contours. The choices are Shape, GML3 or DWG. Choose Shape in this case.
· You may also need to select a theme. For the VectorMap Local Raster there is a choice of themes - pick Black and white for this exercise, though it is worth downloading the others to have a look at them too.
· Some items will have a Clip option. This means that the data will be sent to you clipped to the area outline that you requested. If you are short of disk space this is very useful as it restricts the amount of data you need to download, but otherwise it doesn’t hurt to have extra data around the outside of your study area. I prefer to untick this box and download full map tiles.
· Give the order a name, e.g. OtleyOS (for Ordnance Survey). This will be part of the file name of the zip file that you download, so try to make it short but helpful!
· Click on Request Download
Downloading your data.
You’ll receive an email confirming your order, then another with a download link. This can sometimes take a while to arrive, depending on how busy the service is.
Make sure that you are still logged in to Digimap before you click on the download link.
[image: ../../shared/docs/images/finding_data/DownloadLink.png]
The download link in the email - click on this to download your data, not on any of the other links in your email!
Once you have clicked on the link a browser window should open telling you that your order is ready to download.
[image: ../../shared/docs/images/finding_data/DownloadDownload2023_small.png]
Order ready to download, showing the name and size. Click on the Download button.
· Click on Download
You’ll download a zip file. Make sure you save it to your computer.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
• Make sure that you remember where you have saved the zip file.
• Don’t run or open the file directly from your browser, and make sure that you DON’T save your zip file to a temp folder where you will probably be unable to unzip it.
Now open File Explorer (in Windows) and navigate to the location where you saved the zip file.
· Right-click on the compressed map data file that downloaded and choose to Extract files... - or 7-zip > Extract files... if you have 7-zip available.
· Select where you want to save the extracted files, and make a note of where you save them to
You should end up with a folder for each dataset that you requested plus text files showing citations and contents. The folders will also have the order number as part of their name.
[image: ../../shared/docs/images/finding_data/DownloadUnzipped.png]
The unzipped Ordnance Survey data showing the folder for each dataset and text files containing citations and contents lists.
Viewing your data
In this case the files that you have downloaded are either tiff graphics files or shapefiles.
· Navigate to the data that you downloaded in the file explorer and find the folder called something like vml-raster_bwr_3612556 (your order number will be different).
· You may also need to go into a folder with the OS grid letters - in this case for Otley it will be se
· Open one of the .tif files by double-clicking on it - the file should open in a graphics program, but that depends what you have set up on your computer. Don’t worry if it doesn’t!
You should be able to see that this is basically a “picture” of a map.
· Try opening one of the .shp files from the terrain-5_3612555 folder too. It’s unlikely that you’ll be able to. Just cancel that and don’t try finding software that will open it!
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Both folders will contain files that have similar names to the .shp and .tif files, but different file extensions. These are known as “side-car files”.
They won’t open in any programme but are essential for using the data in GIS programs such as QGIS, so make sure that you always keep these files together.
Both of these formats will open in QGIS in the same way that you added data to your map in the Introduction to GIS.
This time you don’t need to keep the files that you have just downloaded, just remember how you downloaded data from Digimap. You’ll get used to doing that for future exercises.
Copyright acknowledgements for Digimap data
Copyright is important. Remember that most data providers ask you to sign up to conditions that include an obligation to add a copyright acknowledgement to your map. Check what that copyright statement is and add it.
When you signed up to use the Digimap collections you agreed to add copyright acknowledgements whenever you created a map with the data. The wording does change from time to time so it’s worth knowing how to check it for yourself.
To find these copyright acknowledgements:
· go back to the main Digimap home page
· go to the Digimap Help Centre (Help at the top of the main Digimap page)
· Click on the link to Copyright and Licensing from the Help page.
· In the list on the left click on the Educational User Licence for the data that you’ve used - in this case the Ordnance Survey Educational User Licence.
· then look for the information under In return, you must: - that gives you the acknowledgement text.
For example, as of September 2023, when you use Ordnance Survey data obtained from Digimap you are expected to add the following text to your maps.
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
This changes from time-to-time, so it’s worth checking when you’re using it for maps for coursework etc.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Adding the copyright symbol to your text
To add the copyright symbol - © - to your text (on a Windows computer)
• check that the Num lock is on on the keyboard
• hold down the Alt key on the keyboard
• then use the number pad to type 0169
• release the Alt key
Remember that you do have to acknowledge each different dataset that you use and will have signed up to that when you registered.
If you are not using U.K. Ordnance Survey data, this is not the correct copyright acknowledgement to use. For example, if you are using data for Spain or the United States, or indeed UK data that you haven’t downloaded from Digimap. You’ll need to find the correct copyright acknowledgement for yourself.
Citing maps and data from Digimap
Advice on citing Digimap data, as opposed to the copyright acknowledgement is given in the Copyright and Licensing section of Digimap Help.
The Digimap page says the following about when you should cite your data using the citations from the text file included in any download:
The citations in this document should be used to reference the maps and data when they have been included in any essays, dissertations or other academic works. You should cite the data even if it doesn’t appear as an image or map in your work if it has been used to generate findings or a new dataset that is used. (Citing Digimap Collections. Last accessed: 19th September 2023.)
The GIS Lounge page on How to cite GIS materials gives some information about citing the software as well as the data. Have a look at that and follow the suggestions to cite non-Digimap data.
Other Digimap collections
In addition to Ordnance Survey Digimap you will also find that you’ll make use of some of the other collections, in particular Geology Digimap and Aerial Digimap. The Roam and Download interfaces work in a very similar way to the Ordnance Survey collection so you should find that you already know how to use them.
You have access to all these collections so feel free to have a look at what is available and to make use of any of the data or maps in your work in the future.
Try exploring the suggested collections to answer the following questions:
[image: images/svg/help_outline-black-24dp.png] What was on the site of the University of Leeds back in the 1890s?
• Go into the Historic Digimap Collection to look up the University of Leeds (search for the postcode LS2 9JT) using old maps.
• Try the 2 up view to see how you can compare old and new mapping of the same area.

[image: images/svg/help_outline-black-24dp.png] What is the bedrock geology under the Student Union Building at the University of Leeds?
• Go into the Geology Digimap collection to find the Student Union (search for coordinates 429306,434578 to get a marker on the map.)
• Click on the feature information button at the top of the map, then on the marked building on the map.
A Feature information window should pop up. What Rock Unit does it give?
Digimap Collections online help
Digimap help is available from each of the collection pages. Click on the Question mark button at the top of the map to go directly to the Help pages.
You may find the Learning Materials particularly useful if you want to know more about how to download and use different formats of data. This section includes some case studies and webinars.
Data from the web
EDINA Digimap provides a wide range of useful data covering the UK, but you are also likely to need data from outwith the UK, or UK data that isn’t provided by Digimap. It isn’t possible to cover everything in this session, but I will show you a couple of sources which you should find useful. You’ll discover others as you go through the rest of this course.
Natural Earth Data
Natural Earth is a free, public domain dataset consisting of raster and vector data that will allow you to make maps at general scales. If you want a map of the World, or a general map of a particular country, this is a good starting point.
· Start by going to Natural Earth in your browser.
[image: ../../shared/docs/images/finding_data/NaturalEarth01.png]
The Natural Earth front page. Free vector and raster map data at three general scales.
The front page gives an overview of the principles behind the data and an idea of the scales at which it is available. You can find more information under the Features tab, including the file formats and the coordinate system - both important for using the data within GIS.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Natural Earth data
Go to the Features page and make a note of the file types of both the raster and vector data provided by Natural Earth and of the coordinate system that the data comes in.
To download data either
· Click the Get the Data green button on the front page.
· or click on the Downloads tab at the top of the site.
· Choose the scale that you want to download and the type of data that you want, e.g. cultural, physical or raster.
For this exercise download the following data:
· Medium scale data, 1:50m > Cultural > Admin 0 - Countries - click on the Download countries button to download a zip file. Make a note of where this file is saved to on your disk.
· Medium scale data, 1:50m > Raster > Natural Earth 1 - click the Download small size button under Natural Earth 1 with Shaded Relief and Water. Again, make a note of where the zip file is saved.
Keep these data layers for later exercises. Make sure you put the zip files into your GIS folder.
Have a look at the summary of the data on the Features page. If you wish, try downloading other datasets. You can try adding them to a blank map in QGIS in the same way that you added data in the Introduction to GIS.
Natural Earth data copyright
Finding and acknowledging the copyright of data is very important.
· Return to the Natural Earth front page
· Look at the text in the box next to the Get the Data button. One of the links there is to the Terms of Use page. Click on that now.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Acknowledging Natural Earth data
Read the Terms of Use of Natural Earth data
How should you acknowledge the Natural Earth data if you use it in one of your maps?
The terms of use do say that “Crediting the authors is unnecessary”, however, it is still a good idea to add the data acknowledgement to your map to avoid any possibility of plagiarism. You can choose whether to use the short or long text listed on the page. Adding the url of the data can also be a very good idea.
XYZ Tile maps in QGIS
If all you need is background map and you don’t need to be able to make changes to it then QGIS XYZ Tile maps are probably the easiest solution. They make use of OpenStreetMap (OSM) data - be aware that this is crowd-sourced, and quality and coverage vary.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding an XYZ Tile Layer to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open QGIS - you can leave it on the welcome screen or open a new blank map by clicking on the New Project button on the toolbar or pressing Ctrl-N on your keyboard.
· In the Browser panel look for the XYZ tiles heading.
· Double-click on the OpenStreetMap layer to add it to the new map.
You should find that you have a World map and can now zoom in to wherever you want and pan around. Try that now to see the level of detail that you can get. Note that the level of mapping does depend on how actively particular areas have been mapped.
Adding XYZ tile layers with an API key - Thunderforest API
By default the XYZ Tile choices include OpenStreetMap and maybe a couple of others (don’t worry if it doesn’t!). OpenStreetMap doesn’t need an API key and won’t have a watermark across it, others may do.
By signing up for an API key (API = Application Programming Interface, but don’t worry, we won’t be doing any programming!) you can extend the number of possible background layers you can use.
To add an API key:
· Sign up for one on Thunderforest website. You can do so for free as Hobby Project (free), but get a limited quota of views. This shouldn’t be a problem if you are just using it as a map background on your desktop.
· Once you have an API key you can see list of urls at bottom of page. Select and copy one of these, e.g. Outdoors. There is a gallery of the map styles you can check.
· In QGIS look for the XYZ Tiles subheading in the Browser panel.
· Right-click on XYZ Tiles and select New connection...
· Give the new layer a Name, e.g. Outdoors (API).
· Next to URL paste in the url that you copied, which should include your personal api key, then click OK.
[image: ../../shared/docs/images/finding_data/XYZConnection_small.png]
Setting up the XYZ tiles connection using the link from Thunderforest.
· Now you should be able to find the layer in the list of XYZ Tiles and drag and drop it into the Layers panel as you would any other layer to add it to your map.
· If you wish to edit the settings for any of the XYZ Tile layers right-click on them in the Browser and select Edit....
[image: ../../shared/docs/images/finding_data/XYZTiles_small.png]
Loading XYZ tiles - the Thunderforest Outdoors layer is displaying in the map window.
[image: images/svg/create-black-24dp.png] Add the Thunderforest Atlas layer to QGIS
Now that you have signed up for a Thunderforest api key, look for the URL for the Thunderforest Atlas layer. This is a nice clear layer that you should find useful as a background map.
Adding a Bing Aerial layer
Tile layers are becoming more widespread, and you may be able to find other data to add to the list. If you do, there should be a URL which you can add in the same way as the Thunderforest urls above.
For example, it is possible to add a Bing aerial layer as XYZ tiles. I found this URL by searching for Bing satellite tile maps qgis then browsing some help pages.
· Try adding the following URL to the same map as the OpenStreetMap layer you added above.
       http://ecn.t3.tiles.virtualearth.net/tiles/a{q}.jpeg?g=1
If you need to change an entry later simply right-click on it in the Browser panel and click on Edit.
Once you’ve added a layer it should stay in the list in your Browser panel for you to use again in future.
Finding other data online
These are just a few examples of finding useful data for GIS. Throughout the rest of the workbook you’ll be downloading your own data from Digimap. If you need data from elsewhere, I’ll either give full instructions or provide the data for you, but tell you where I got it from.
If you are looking for data for a particular project it is well worth searching online using your favourite search engine (e.g. Google). Put the words “gis” and “data” into your searches and it should help you to find relevant data.
I have put together a short list of possible data sources which you are welcome to use to find data and maps.
Optional section: ArcGIS Living Atlas of the World
This section is optional. You can work through it to find out about some more layers you can add to your maps in QGIS.
If you don’t have time to do this section now, you can come back to it later if you wish to.
The ArcGIS Living Atlas of the World is an extensive collection of map layers and maps curated by a company called ESRI. ESRI produce commercial GIS software, ArcGIS, which is similar to QGIS but is not Open Source. Some of the data is only available if you subscribe to ArcGIS Online, but even without subscribing there are a lot of datasets available to use as background layers. This section will give you an idea of what is available and how you can use the layers in your maps in QGIS.
Finding ArcGIS Living Atlas layers
The ArcGIS Living Atlas is online at https://livingatlas.arcgis.com/en/home/
The first page gives you an overview of the atlas. It’s worth having a look at this to see what new layers and maps have been added.
Once you’ve done that:
· Click on the Browse tab at the top of the page.
[image: ../../shared/docs/images/finding_data/LivingAtlasBrowse_small.png]
The Browse page for the Living Atlas. Note the search box at the top, and the filters below that. The main part of the page is the full list of maps and layers.
The Browse page allows you to use filters to limit the data, as well as to search.
I’ll start by showing you how to find and add layers to QGIS, then you can do some searches for yourself and see what you can find.
We’ll start by finding a background map of the Oceans and adding it to QGIS. This could be useful if you need to produce a map for a report showing a particular area of the ocean floor with some of your own data on top of it.
· Type World Ocean Base into the search box on the Browse page.
The list of results will appear below the filters. Have a look at the options you are given.
Make sure the option to view the List is selected from the three buttons above the list. You’re given more information in a clearer format if you select this.
[image: ../../shared/docs/images/finding_data/LivingAtlasResults_small.png]
Viewing the results of your search in List format.
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] What types of layers are available?
Look at the information next to each of your results. You’ll get a summary of what the layer or map shows, but you’ll also be shown the Type and the Contributor.
What types of layers do you have available to you?
Not all the layer types are suitable for use in QGIS. You will be able to use layers which have the type:
· Feature Layer
· Tile Layer
· Map Image Layer
You should also see the word Authoritative next to some of the layers. This indicates that ESRI have checked the data and consider it to be reliable. Even so, remember that it’s always a good idea to check who is the creator of any data, and which organisation it comes from.
Seeing full information about ESRI Living Atlas Layers
There should be in your list of results, a Tile Layer called World Ocean Base, for which the contributor is ESRI.
· Click on the title for this Tile Layer.
You’ll be taken to a full page of information about the layer. It’s worth looking at this information as it will give you a better idea of whether this is a good layer to use.
· If you want to check what the layer looks like, click the Open in Map Viewer button at top right. Zoom in and out and pan around to check the map.
· Once you are happy that this is the layer you want to use, return to the page containing the information about the layer.
· Look for the URL field, which is usually at the bottom right of the page.
· Hover over the right-hand side of the URL box and click to copy the URL.
Now you are ready to add the layer to QGIS.
Adding an ArcGIS Living Atlas layer to QGIS
Start by opening QGIS. You can add ArcGIS Living Atlas layers to existing maps, but in this case we’ll start with a blank map.
As usual, there are multiple ways to add the layer to QGIS. You can use either of the following:
Via the Browser panel
In the Browser panel, scroll down to find ArcGIS REST Servers heading. Right-click on the heading and choose New Connection....
This will open a dialog box.
· Fill in the Name as World Ocean Base (or something which will remind you what the connection is in future).
· In the URL box paste the URL you copied from the Living Atlas web page.
· You don’t need to fill in any further information.
· Click on OK to add the server connection to QGIS.
[image: ../../shared/docs/images/finding_data/LivingAtlasNewConnection_small.png]
Creating a new ArcGIS REST Server Connection to add a layer from the ESRI Living Atlas.
The new connection should appear under the heading in the Browser panel.
· Drop down the small black arrow next to your new connection. This will show any layers available on the server. For the World Ocean Base there is only one available.
· Double-click on the layer you want to add to your map.
Be patient, some layers can take a while to load, particularly if you have a slow internet connection.
Zoom in and out and have a look at the data you have added.
Via the Data Source Manager
· Alternatively, go to Layer > Data Source Manager.
This will open the Data Source Manager.
· Find the ArcGIS REST Server tab on the left and click on it.
· Click on New under the box at the top.
This opens the same form as the method above, so refer to the image under those instructions.
· Fill in the Name as World Ocean Base (or something which will remind you what the connection is in future).
· In the URL box paste the URL you copied from the Living Atlas web page.
· You don’t need to fill in any further information.
· Click on OK to add the server connection to QGIS.
· The name of your new connection should appear on the dropdown at the top.
· Now click on Connect to actually connect to the server.
· Drop down the small black arrow next to your new connection. This will show any layers available on the server. For the World Ocean Base there is only one available.
· Select the layer you want, then click the Add button at the bottom of the window.
You can also Close the Data Source Manager if you wish.
Be patient, some layers can take a while to load, particularly if you have a slow internet connection.
Zoom in and out and have a look at the data you have added.
Trying out other ESRI Living Atlas layers
Once you have added a layer, you can combine it with other data from other sources to produce your own maps.
· Return to the Living Atlas browse page.
Look for another layer to add to your map. Is there a country you are particularly interested in, or a subject you’d like to see on a map?
· Use the Filters at the top of the page to select the country.
· Search for the subject you want to investigate.
Example searches could include:
· Earthquakes
· Land use or Land cover
· Hurricanes
· Traffic
· Imagery (for aerial photography)
You’ll need to look for layers which don’t say Subscriber or Premium, and which are one of the following types:
· Feature Layer
· Tile Layer
· Map Image Layer
In addition, some layers which look as if they will be OK, may not work. This can be because a server somewhere isn’t working and there isn’t much you can do about it, unfortunately.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Find a layer and add it to your map in QGIS
Find a layer showing something you are interested in and add it to the same map as the World Ocean Base.
Zoom in to an area you are interested in, and export the map using the instructions below. Upload your map to your OneNote Class Portfolio to get feedback on it.
Exporting your map
It is possible to set up a layout and export that, but I’m not expecting you to spend extra time on this exercise.
Instead, so you have something I can give you feedback on in OneNote:
· Make sure your map looks as you want it to in the map window in QGIS.
· Go to Project > Import/Export > Export Map to Image.
· In the form which appears, click on Map Canvas Extent.
· Untick Append georeference information
· The other settings will be fine for now, so click on Save.
· Give your export a name and choose where to save it.
[image: ../../shared/docs/images/finding_data/SaveMapAsImage_small.png]
Saving a map as an image directly from map view.
QGIS will export a .png image which you can open in a photo editor, or upload to OneNote.
I’d be interested to know what you think of the ESRI Living Atlas layers, so if you want to add any comments or questions in your portfolio, that is absolutely fine.
Collecting point data with GPS
Last Modified: 05 Jan 23, 12:03:08
The background to creating point data with gps will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Explain what a geopackage consists of and why it is used to store GIS data
· Collect your own spatial data for use in GIS
· Symbolise data on a map so that it displays clearly and informatively to your audience
Introduction
The previous chapter should have given you some idea of the variety of data that is available for you to use, but there is nothing to replace going out and collecting your own data and it is very likely that you will be using GPS when you’re doing fieldwork at some point.
When you are collecting your own data you may well find yourself using a GPS receiver, or collecting GPS data on a mobile device. If you do, you are likely to need to know how to add data from gpx files to QGIS. This section covers the things you need to be aware of when collecting data, and how to import the data into QGIS for use on your maps.
If you are new to GPS and would like to find out more about the background and technology there is a beginners guide at:
· Garmin
Considerations when collecting data with GPS
Setting up the GPS
It is possible to collect data via GPS with a dedicated GPS receiver, or by using an app on a smartphone.
Given the possible variety, I can’t give instructions for downloading data. You’ll need to look at the instructions for your own device.
There are however, a few things you should check before you start collecting data.
· Check the coordinate reference system (CRS) or projection. If you are using GPS as a supplement to a paper map (which you should be…), set the CRS to the same as the map. In the UK that is usually British National Grid or OSGB 1936/OSGB36. For other countries, look at the maps you are using. This will then allow you to check location on the GPS against location on the map.
· GPS units usually store data as WGS 1984 (EPSG:4326), and this will be the CRS of the data you download. If you are using an app on a smartphone, check the CRS of the output.
Data accuracy
The general advice is to turn on your GPS well in advance of starting to work, and leave it on for the whole of the working day. This gives it a chance to find and track the maximum number of satellites. Even under ideal conditions, when your receiver has found several satellites, due to the nature of the system, accuracy still won’t be 100%. Your device should allow you to see the current level of accuracy, usually a measurement in metres. Be aware of this when using the readings and keep a note of it.
It is particularly worth noting that GPS can give an illusion of extreme accuracy. The readings tend to show figures with lots of decimal places, which could lead you to assume that a reading is accurate to 1 m or less. This is extremely unlikely to be the case!
For this reason, it is still important to know how to locate yourself accurately on a paper map without the use of GPS, and most navigation experts will say that with practice you can be far more reliable and accurate than a GPS unit. Not least, you should have the intelligence to recognise when the point you are standing at is at the top of a cliff, not off it!
Elevation
Don’t use elevation measurements from your GPS. For various reasons, obtaining accurate height readings with GPS is much more difficult than obtaining accurate horizontal readings. The Ordnance Survey web site has an explanation of how best to do this, but it involves specific equipment and readings taken over at least 24 hours.
Data to download
· Download the file CreateData.zip from this weeks folder in Minerva.
· Save the file to your disk and unzip it.
The zip file should contain the following items
· A GeoPackage called StudyArea.gpkg.
· A folder called getmapping_rgb_25cm which contains an aerial photograph of the University. You’ll need this for the chapter on creating data.
· Waypoints_26-FEB-14.gpx - waypoints which I collected back in 2014 and luckily still have. This is the file downloaded from the gps unit I collected the data with. If you are able to collect your own data you won’t need to use this.
· Waypoints_type_26-FEB-14_map.pdf - a map showing the location and type of all the waypoints that I collected.
Starting a new project in QGIS
You can just open QGIS and start adding data, but it will help you later if you take more care at this stage.
· Open QGIS
· Go to Project > Save and navigate to the folder in which you would like to save your project. This could be a folder called gis with a subfolder called ChancellorsCourt - note that there should not be any spaces in the folder name.
· Give your project a name, e.g. ChanCourt - short and no spaces.
· Save
Having done that you should have a file in your folder called ChanCourt.qgz.
· Go to Project > Properties in the menu in QGIS and click on the General heading on the left
· The Project file should already be filled in
· Set Project home to the folder in which you saved the qgz file
· Set the Project title to something like Chancellors Court, University of Leeds - basically a description of what your map is going to show.
· Check that Save paths is set to relative
· Click OK
[image: ../../shared/docs/images/gps/ProjectProperties_small.png]
The general tab of the Project Properties showing the settings you should fill in.
Save paths is probably the most important project setting as it can save you from having data go missing if you move your project to another computer. By setting this to relative, as long as you move the whole folder, your data and your map will stay linked.
Using the Browser to find information about a layer
Now that you have the Project home set it is possible to use that heading in the Browser to find everything associated with this project (assuming all your files are in that folder).
· Go to the Browser (if it isn’t already open go to View > Panels and put a tick next to Browser).
· Click on the little arrow next to Project Home to see the contents of the folder. You should see all the files that you unzipped earlier.
[image: ../../shared/docs/images/gps/Browser_small.png]
The Browser panel showing the files and folders for this project listed under Project Home.
One of the benefits of the browser is being able to have a look at the details of your data before you add it to a map.
· click on the little arrow next to Waypoints_26-FEB-14.gpx
You should see that the file includes several layers. For this exercise the only one we want is waypoints
[image: ../../shared/docs/images/gps/GPXcontents_small.png]
The layers within the gpx file as seen in version 3.16 of QGIS.
· Right-click on the waypoints layer and go to Layer Properties
· Use the three tabs at the top of the layer properties - Metadata[footnoteRef:321], Preview and Attributes - to have a look at your file. [321:  Metadata can be described as “data about data”. A commonly quoted example is a library catalogue, which holds data about books.] 

[image: ../../shared/docs/images/gps/LayerProperties_small.png]
The layer properties showing metadata about the layer you right-clicked on.
The Metadata tab tells you quite a lot, but the Preview tab can confirm that your data looks correct, and the Attributes tab will let you see the table of data that you have.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Make a note of the CRS
One particularly important piece of information is the CRS, or Coordinate Reference System. You’ll need to know this later.
Make a note of the text next to the CRS subheading in the Metadata then close the Layer Properties.
Adding a gpx layer to a map
[image: images/svg/videocam-black-24dp.png] Adding a gpx layer to a map in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Drag and drop the waypoints layer from the Browser to the Layers panel.
You should now have a map showing small circles for each of the waypoints which looks something like the image below. (Your colours may be different.)
[image: ../../shared/docs/images/gps/WaypointsAdded.png]
The map once you have added the Waypoints. Your colours may be different to these.
Exporting gpx layer to a geopackage
As the layer is stored at the moment this is not a proper GIS layer, it is still the gpx file. If you are going to use these points for further analysis or measurements you need to export them to a GIS format, such as a layer in a Geopackage.
[image: images/svg/info-black-24dp.png] Geopackage format
A geopackage is a form of database designed to store spatial data. It has been relatively recently developed but it’s use as a GIS format has spread very quickly. QGIS encourages the use of geopackages and it is increasingly possible to use them in other GIS software.
You will store vector data in a geopackage as multiple layers.
If you want more information about the format there is a lot on the GeoPackage website.
To export the waypoints to a geopackage layer:
· In the Layers panel right-click on the waypoints layer
· Export > Save Features As...
· Fill in the panel that opens as follows:
· Format = GeoPackage
· Click on the ... button at the end of the File name box, navigate to the folder in which you want to store your geopackage - preferably the same folder as your .qgz file, then give your geopackage a name, e.g. University.gpkg. The location tends to be a good idea here.
· Save
· In the Layer name box give your layer a name such as Waypoints - it needs to be a name that will tell you what data this layer contains.
· Check that the CRS field is the same as the CRS you made a note of earlier - in this case that should be EPSG:4326 - WGS 84
· Check the bottom of the form to make sure that Add saved file to map is ticked.
· Click OK to create the geopackage and add the new layer to your map.
[image: ../../shared/docs/images/gps/SaveVectorLayerAs_small.png]
Filling in the form to save your waypoints as a vector layer in a geopackage.
Your map won’t look much different, though the dots may have changed colour.
The new GeoPackage should have appeared in the Browser in the folder you saved it to. Have a look at that now and drop down the arrow next to the .gpkg file to check that the Waypoints layer is there.
Refresh the browser
If you can’t see the new geopackage in the browser, or it doesn’t appear to have any contents, you may just need to refresh the Browser.
· Select the Project Home heading
· In the row of buttons at the top of the browser click on the second button from the left - the tool tip should show you that this is the Refresh button.
[image: images/svg/info-black-24dp.png] Components of a GeoPackage
If you have a look at the same .gpkg file in your file explorer outside of QGIS you’ll probably see three files with the same name but slightly different extensions - .gpkg, .gpkg-shm and .gpkg-wal. The last two are temporary files which appear when the geopackage is open in QGIS. Once you close QGIS you’ll only see the .gpkg file.
The geopackage itself is a single file and without appropriate software, such as QGIS, you can’t open it and see the contents.
[image: ../../shared/docs/images/gps/GeopackageExplorer_small.png]
The components of a geopackage viewed in a file explorer when the file is open in QGIS.
To keep the Layers panel tidy right click on the original waypoints layer and Remove layer... but don’t delete the .gpx file or it’s contents from the Browser - you may need them again later.
Adding a background map to your data
In the section on XYZ Tile maps in QGIS you added some useful background maps to QGIS. Now is a good time to use one of them.
I suggested you added the Thunderforest Atlas layer to QGIS. You could also use the default OpenStreetMap layer.
· Find either of those under the XYZ Tiles heading in your Browser panel and double-click on it to add it to your map.
· The new layer will probably be added at the top of the Layers panel list - move it down so you can see your other layers above it.
[image: images/svg/warning-black-24dp.png] Warning: do not try to reproject XYZ layers
Please note that you should not try to reproject, crop or otherwise edit the XYZ layers. These are being loaded over the web (like streaming) and you are not able to alter them. You will only be using them as background maps, not for analysis, so not being able to reproject them is not a problem. QGIS will use on-the-fly transformation to display them correctly.
We have found that some people who have tried to reproject these layers have then had problems with the CRS of the other layers in their project.
Adding extra data to feature classes
The layer that you have saved to a Geopackage is known in GIS terms as a feature class. This contains your features and data for each one which are called attributes.
[image: images/svg/videocam-black-24dp.png] Working with attribute tables in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the Layers panel right-click on your waypoints layer and select Open Attribute Table.
The attribute table is the GIS equivalent of a spreadsheet and contains features and their attributes.
[image: ../../shared/docs/images/gps/AttributeTable_anno.png]
The attribute table annotated with some of the terminology.
Amongst many other attributes there should be one for name which should include the label or name of each waypoint as stored by the GPS unit. In this case the name field holds a number which matches the numbers of the points on the Waypoints_type_26-FEB-14_map.pdf file which you downloaded from Minerva.
· Open the file Waypoints_type_26-FEB-14_map.pdf from the downloaded data and have a look at the information there
Labels on the map show the name field followed by a description of the type of feature, e.g. Rock, Sign post, Planter.
Somehow we need to get that extra information in to the attribute table and unfortunately that has to be done manually!
· Have another look at the waypoints attribute table. There is a field there called desc for description. This seems to be a sensible field in which to put the new information.
To start adding attributes to a table you need to start editing the feature class.
· On the attribute table window click on the Toggle Editing Mode button at top left (see the annotated picture of the attribute table above, and remember that tool tips are visible if you hover over buttons). If you’re not sure whether a layer is editable have a look at the Layers panel - any layer toggled for editing will have a little pencil symbol on the left.
· Click in the space under desc for the point with the name 001 - the word NULL should be selected
· Look at the pdf map and find point 001 (it’s at the top left of Chancellors Court) - what is the description of it?
· If you have trouble finding it try selecting the feature in the attribute table by clicking on the number in the grey space on the left. The point will then be highlighted on your map in QGIS
· The description for point 001 should be Sign post so type that in to the attribute table.
· Click on the Save edits button on the attribute table toolbar to write your edits to the feature class in the geopackage.
Continue doing this for some more of the points. Don’t worry if you can’t find some of them on the map - just leave those blank (NULL).
[image: images/svg/create-black-24dp.png] You don’t need to add information for all the points
Try to do a minimum of about 20 of the points. There are rather a lot there and you don’t need to do all of them on this occasion! You just need to do enough to be able to understand what you’re doing.
[image: ../../shared/docs/images/gps/AttributeTableDesc.png]
The attribute table in edit mode with the desc fields filled in. Note some are still NULL.
· Once you’ve input the descriptions (and saved your edits) click on the Toggle Editing Mode button again to stop editing
· then close the attribute table by clicking on the cross in the top right.
Sorting the attribute table
Sometimes the table doesn’t open in the order you expect it to. Before you start entering data check that the numbers in the name field run from 001 upwards. If they don’t you can Sort the table correctly by doing the following:
· Right-click on the column heading in the attribute table and select Sort...
· This opens the Configure Attribute Table Sort Order dialog
· Put a tick next to Defined sort order in attribute table
· The name field should already be added to the box on the left, if it isn’t delete anything that is in that box, then go to Fields and Values in the central box and double-click on name
· Check that Sort ascending is ticked Then click on OK
[image: ../../shared/docs/images/gps/ConfigureAttributeTableSortOrder_small.png]
Configuring the sort order of the waypoints table - setting the sort field to name.
Styling the point layer
Now that you have the description in your attribute table you can style your point layer, initially as a single symbol but then with different symbols for different types of feature.
Styling a layer as a single symbol
The default styling is for single symbols.
[image: images/svg/videocam-black-24dp.png] Styling a layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the waypoints layer in the Layers panel and click on the Open the Layer Styling panel button - at the top of the Layers panel on the left or use the F7 keyboard short cut.
· The layer styling panel should open on the right of the map window and gives you choices for the way your layer looks.
[image: ../../shared/docs/images/gps/Symbols_small.png]
The Layer Styling panel showing single symbols.
In this view you can click on any of the symbols in the gallery and the symbols on your map will change to match them. Try this now by picking any symbol from the gallery.
The section at the top allows you to change the size, opacity and colour of the symbols. Again, try changing the choices there and see what they do. You get more choices if you click on the Simple marker symbol layer.
Styling a layer as categories
So far you have a single coloured symbol representing every point. Your map would be much more informative if each type of feature had it’s own symbol.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Styling a layer as categories in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· At the top of the Layer Styling panel click on the dropdown that says Single symbol and change it to Categorized
· Now drop down the list next to Value and select the field that you want to categorize your symbols on - in this case desc
· Lower down the panel click on the button that says Classify
Your descriptions should appear as a list and the symbols on your map should change to a variety of random colours.
[image: ../../shared/docs/images/gps/SymbolsCategories_small.png]
The Layer Styling on the right is set to Categorized and the desc field has been added as the Value. The different types of item have been added to the list by clicking on Classify. Note the different colours on the map.
Note that the attributes that you left as NULL in the attribute table have all been styled as a symbol listed as all other.... It would be good to get rid of that as it isn’t adding any useful information to the map.
· In the Layer Styling panel untick the box on the left of the all other... category. Alternatively you can click on this and then on the Delete button at the bottom of the panel to get rid of the symbol completely.
The NULL symbols should all disappear from the map.
Note that the Layers panel on the left now acts as a key to your waypoints layer.
Changing to svg markers
You can change the symbols by double-clicking on each symbol in turn and selecting different ones from the Gallery.
At the moment all your symbols are Simple markers. It is easy to change them to SVG markers and have a wider range of symbols to choose from.
[image: images/svg/videocam-black-24dp.png] Styling points with svg markers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Double click on the first symbol in your list in the Layer Styling panel (in my example it is Bike shelter)
· In the box at the top click where it says Simple marker
· Below that change the Symbol layer type to SVG marker
SVG stands for Scaleable Vector Graphics and is basically what it says. In the context of QGIS it gives you a much greater range of pictorial symbols with which to style your map.
· Have a look at the SVG Image gallery at the bottom of the panel and select an appropriate symbol.
· You can use the settings above the change the size, colour, rotation etc.
· The symbols should appear on your map automatically, but if they don’t click on Apply
· When you’ve finished click on the back arrow at the top of the panel to get back to the list.
[image: ../../shared/docs/images/gps/SVGMarkers_small.png]
Choosing SVG markers to style your points.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Choose symbols for your points
Continue in the same way to select appropriate symbols for the rest of the categories of point.
[image: ../../shared/docs/images/gps/SymbolsOnMap_small.png]
Symbols on the map - yours will probably look different as you’ll have made different choices.
Once you’ve finished setting the symbols for the waypoints, save your map and close it.
Changing the coordinate system (CRS) of data
The GPS data that you have collected is in the WGS 84 geographic coordinate system. Remember that you checked this earlier. QGIS sets the project CRS to that of the first layer that you add to the map. So, in this case the map CRS is also WGS 84.
Often you will need to use data in a local projected coordinate system. The obvious example is if you are using Ordnance Survey maps from Digimap in the same project. This is the example we will use now, but the same situation can arise if you are, for example, creating a map of Spain or Eire[footnoteRef:389]. [389:  If you want to find out more about coordinate systems and projections have a look at Heywood (2011) pp. 44-51 for a general introduction.] 

[image: images/svg/videocam-black-24dp.png] Checking and setting the crs of your project in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
We’ll set up a map project in British National Grid and add the gps data to that.
· If QGIS is not already open, open it from the start menu, but don’t open a map. If you already have a map open click on the New Project button, or use the keyboard shortcut Ctrl+N to open a new blank map.
· Use the browser panel to look at the contents of the StudyArea.gpkg geopackage that you will have downloaded from Minerva and drag the ChancellorsCourtBNG layer to the Layers panel. It should appear in your map area. Remember that the first layer that you add to a map automatically sets the coordinate system.
· You may get a window like the one below asking about Transforms, just click OK on this for now. This is to do with ways of “transforming” data from one CRS to another.
[image: ../../shared/docs/images/gps/TransformSelection_small.png]
The Transform selection window. Just click OK for now.
You should find that you have a map with a polygon covering Chancellors Court. If you look at the bottom right of the map window you should be able to see the text EPSG:27700. This is the code for British National Grid and confirms that your map is in the correct CRS.
[image: ../../shared/docs/images/gps/LocationBNG_small.png]
The Chancellors Court polygon on your map and the EPSG code - 27700.
· Save your map to the same folder as the previous map. Call it something like UniversityBNG.qgz - BNG = British National Grid.
· Add the Thunderforest Atlas XYZ tile layer to your map. You should already have it in the list, but may need to follow the instructions in the link to add it, if it isn’t there.
· If you need to, style the ChancellorsCourtBNG polygon layer so that it has an outline but no fill. You should be able to see the base map through it. Styling a polygon layer is very similar to styling points so you should be able to use the previous instructions again.
· Zoom in to the Chancellors Court polygon using zoom to layer.
· Now add the Waypoints layer from your geopackage (not from the original gpx file) to the Layers panel from the Browser.
The waypoints should appear in the correct place, i.e. in Chancellors Court, even though they have a CRS of WGS 84 and the map is in British National Grid. You can check this in the layer properties if you want to.
QGIS is projecting the layer “on the fly” using a transformation. This is very convenient, and if you are just going to look at the map that is fine. But if you need to do any analysis or measure anything then you really need to get this layer projected in to British National Grid as well.
[image: images/svg/videocam-black-24dp.png] Reprojecting a feature class in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To project the layer permanently
· Right click on the Waypoints layer in the Layers panel or in the Browser
· Export > Save features as...
· Fill in the Save Vector Layer as... dialog as follows
· The Format should be GeoPackage
· Click on the three dots button next to File name and browse to your existing Geopackage.
· Give the output a Layer name which will remind you what it contains, e.g. WaypointsBNG
· Drop down the CRS and select Project CRS: EPSG:27700 - OSGB 1936 / British National Grid.
· Finish by clicking OK
[image: ../../shared/docs/images/gps/ChangeCRS_small.png]
Filling in the Save Vector Layer as… dialog to save your waypoints as a new feature class with a projected CRS of British National Grid.
Your map probably won’t look much different but the new layer should have been added to the Layers panel. If it hasn’t drag it over from the Browser.
[image: images/svg/videocam-black-24dp.png] Checking the layer CRS in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Check the new CRS by right-clicking on the new layer and going to Properties
· Look at the Information tab.
· The CRS heading should say EPSG:27700 - OSGB 1936 / British National Grid - Projected. If it doesn’t you may have to try again and check everything carefully as you go along.
· Remove the original waypoints layer from your Layers panel and Save your map.
Now you have a map in British National Grid which shows your waypoints and which, because all layers match the map CRS, can be used for analysis.
· Make sure you have both of your maps of Chancellors Court open in QGIS - you should find that it is possible to have QGIS open twice.
· If you compare your two maps you should be able to see that the different CRS gives a very different idea of the “shape” of Chancellors Court.
[image: ../../shared/docs/images/gps/CompareCRS_small.png]
Comparing British National Grid (left) and WGS 84 (right).
This is because the projected CRS, British National Grid, is designed to be best to display maps of Britain on a cartesian grid whereas the geographic CRS, WGS 84, is designed to display maps of the whole world in latitude and longitude. This means that the mathematics behind each CRS is rather different.
Copying styles
If you want to style the point symbols on your BNG map so that they are the same as the WGS 84 map try the following short cut:
· This will be easier if you have both the original map, and the British National Grid maps open, though you can start in the first, then move into the other after you’ve copied the style.
· In the WGS 84 map right-click on the waypoints layer and select Styles > Copy Style > All style categories
· In the British National Grid map right-click on the waypoints layer and select Styles > Paste style > All style categories
Your styles should be copied across and your map is ready to go!
The final map
Set the symbols on your map so that you are happy with them and zoom out so that a bit more of the University is visible.
Set up a basic layout, export it as an image and upload it to your GIS Portfolio. If you upload it within a week of the class I will give you feedback on your work.
Alternatively just export your map as an image without creating a layout:
· When you are happy with your map go to Project > Import / Export > Export Map to Image
· In the Save Map as Image dialog set the extent by clicking on the Map Canvas Extent button
· Click on Save
[image: ../../shared/docs/images/gps/SaveMapAsImage.png]
Saving your map as an image.
In a later chapter you’ll find out how to create a full map layout with a key, scale bar, measured grid etc and print or export that properly, but for now this is fine.
[image: ../../shared/docs/images/gps/ChanCourtBNG_small.png]
The final map exported as an image. Yours will probably look different to this as you’ll have made your own decisions about symbols and colours.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Keep this project for the next chapter
In the next chapter you will be creating data in QGIS by digitising. We will use the area of Chancellors Court again, so keep this project for that.
Further information and suggested reading
Some of the books in the reading list[footnoteRef:420] have information GPS and its use for collecting data. Suggestions include the following: [420:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 2, Spatial data in Heywood, I., Cornelius, S. and Carver, S. (2011), pp.65-67 cover GPS.
· Chapter 2, Collecting Field data more efficiently with GIS and GPS technologies in Tian, Bai (2016), pp. 57-90 looks in detail at how GPS can be used for collecting data and includes a few case studies.
The QGIS Documentation has a chapter on Working with GPS data which covers much more than we have been able to cover here.
· Working with GPS data for v. 3.22 of QGIS
Creating data by digitising
Last Modified: 08 Jan 24, 17:18:27
The background to creating data for GIS will be covered in the lecture segment this week, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Set up storage for GIS data
· Use the tools in GIS to draw (digitise) your own data
· discuss the problems that can affect data for GIS
· suggest ways in which to minimize error and uncertainty in spatial data
Introduction
Digitising or tracing data manually in GIS involves having a background map which shows the locations that you wish to digitise, and then using the editing tools to draw vector polygons, lines and points. In this set of exercises, you will produce a map of Chancellors Court in the University showing the outlines of the buildings, the paths, and the trees. You will already have a layer from the previous chapter which contains features such as sign posts, benches and rocks.
Even if you don’t actually need to digitise a whole map it is extremely useful to know how to set up your own feature classes and how to add features by editing. Sometimes you just need to outline your study area or add a point to show where something specific is, or as input to one of the tools provided in GIS.
This is a very brief overview of the tools for digitising in QGIS as we are limited for time.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png]Vector and raster
If you feel that you are not clear about the difference between raster and vector GIS data it would be worth having a look at the video “Learn more about raster and vector map data” by the Ordnance Survey.
As you deal with more GIS data you’ll start to find it easier to spot which formats are raster and which are vector, but you need to be thinking about it already.
Obtaining the data
If you have already followed the GPS chapter and have a British National Grid version of the map of Chancellors Court then you can use that map again. This chapter will use features in the same area. You will already have downloaded CreateData.zip and unzipped that to use the data.
If you no longer have this project, or if you have not followed the GPS chapter, you can start a new project from scratch instead. You won’t have the gps points on the map when you have finished, but that doesn’t matter.
If you haven’t already downloaded CreateData.zip for the previous chapter you need to do so now.
· Download the CreateData.zip file from Minerva
· Unzip the data to a new folder within your GIS folder.
You should end up with a folder called getmapping_rgb_25cm which contains aerial imagery of the University[footnoteRef:429]. The jpg file within that folder contains the image and the other files with it, which have a similar name, contain information that will locate it correctly within GIS. [429:  This data was downloaded from Aerial Digimap.] 

You should also have a GeoPackage called StudyArea.gpkg which contains an outline for the area of Chancellors Court in the layer ChancellorsCourtBNG.
Open the map project
· Start by opening either your existing Chancellors Court map or a new blank map.
· From the files you downloaded and unzipped add se2934_rgb_250_01.jpg to your map using the Browser. (You may need to look in sub folders to find the file.) Remember if you can’t find the folder or the file that you’ve just added you can refresh the Browse panel.
· If you need help to find Chancellors Court, add the ChancellorsCourtBNG feature class from the StudyArea.gpkg GeoPackage to your map and Zoom to Layer.
· If necessary turn off the waypoints, location and any background layers so they don’t get in the way.
· Save your map. Saving your map regularly is a good habit to get into. In addition, if this is a new map, once you’ve saved your map you’ll have the Project Home heading in the browser.
You should have an aerial view of Chancellors Court on your map. You will use this as a basis to digitise the buildings, paths and trees.
[image: ../../shared/docs/images/creating_data/AerialMap_small.png]
The aerial image open in QGIS showing the area of Chancellors Court.
Setting up GeoPackage feature classes to store your data
The first thing you need to do is set up the storage for the data that you are about to create. You should already have a GeoPackage in your project, and if you do, you can use that to store this new data too.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating feature classes in a GeoPackage
This video clip can be found in the module area of Minerva or in the full list of video clips.
Creating a new GeoPackage and adding a feature class
[image: images/svg/warning-black-24dp.png] Warning
Your browser will show a heading titled GeoPackage. Don’t use that at this stage. Instead, you need to browse to the folder where you want to save your GeoPackage, and that should be the same folder as your map and data.
If you are going to use an existing GeoPackage, go straight to the next section - Adding a new feature class to an existing GeoPackage.
If you don’t already have a GeoPackage or want to create a new one:
· In the Browser, right-click on the folder in which you want to store the new GeoPackage or GeoPackage layer. It’s a good idea to use the Project Home folder if you have already saved your map but at least put it in the same folder as the rest of your project data.
· New > GeoPackage
QGIS will create a new GeoPackage called New GeoPackage.gpkg and add it to your folder.
· To rename the GeoPackage, right-click on it and go to Manage > Rename "New GeoPackage.gpkg...".
· Name your GeoPackage something that will remind you what it contains. In this case something like University.gpkg would be good, because it will be containing data about the University.
· Click OK.
[image: images/svg/warning-black-24dp.png] Warning
You may find that you get an error message at this stage, telling you QGIS can’t rename the GeoPackage. If you get that, don’t worry, just carry on with the New GeoPackage.gpkg. It’s not ideal, but still works and you could change the name later if you wanted to.
Alternatively, you can close QGIS, rename the GeoPackage in your computer file manager, then reopen QGIS.
You should now have an empty GeoPackage ready for you to fill with data.
Adding a new feature class to an existing GeoPackage
Once you have a GeoPackage, or if you already have one, you need to add feature classes, or tables, to be able to store your data.
· Right-click on your GeoPackage in the Browser panel
· Select New Table
· If you get an error message saying Cannot Create New Tables:
· click OK to get rid of it,
· then right-click on the GeoPackage again and this time select Add Connection.
· You won’t see any difference at this point, but now right-click and select New Table again.
· The New Table dialog should open.
· Give your new table a name, in this case call it Paths.
· Click on Add field and give it the name Label, Type should be Text (string) (choose from the dropdown box) and Length = 250 - that’s the maximum length of text you’ll be able to type into the table for that field.
· Set the Geometry Type to LineString. This is where you’re setting your data to be either points, lines or polygons. Note that it’s important to set this correctly as it can’t be changed later.
· Under CRS select the required coordinate system - in this case British National Grid.
· Tick to Create spatial index - this makes the storage and retrieval of your data more efficient.
· Click on OK to create the new table.
[image: ../../shared/docs/images/creating_data/NewGPKGTable_small.png]
The window to create a new table in an existing GeoPackage.
If the table isn’t added to your map automatically, drag it to the Layers panel from the Browser now.
If you can’t see the new layer in the GeoPackage you may need to select the top-level folder and then click on the Refresh button at the top of the Browser.
Setting up further feature classes
For this exercise you will need a polygon feature class, a point feature class and a line feature class.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Feature classes to create
Use the instructions above to create a total of three feature classes in the same GeoPackage. Note that the Geometry type is different each time and remember that you must set this correctly or you have to create the feature classes again.
• Create a Line feature class called Paths. If you followed the instructions in the section above, you’ll already have this feature class/table.
• Create a Polygon feature class called Buildings. This should have a new text field called Label with a length of 250.
• Create a Point feature class called Trees. Again, this doesn’t need any new fields.
Have a look at the new layers in your GeoPackage using the Browser. Note that the icons next to the layers show you what the Geometry type is.
[image: ../../shared/docs/images/creating_data/GeopackageLayers_small.png]
This is how your new GeoPackage layers should look in the browser. Note that the icons show the Geometry type of each layer. The GeoPackage example here also includes the waypoint layers from the GPS chapter don’t worry if you don’t have those.
Digitising in QGIS
You should already have an aerial view as a background for your map. For these exercises you will be digitising polygons, lines and points by tracing over features on this view.
Before starting to digitise check that you have the Digitising Toolbar open.
· View > Toolbars
· Check that there is a tick next to Digitising Toolbar
The toolbar should look something like this image at the moment. The only button available is Toggle Editing.
[image: ../../shared/docs/images/creating_data/DigitisingToolbarOff.png]
The Digitising Toolbar before you start digitising.
Digitising polygons
The Buildings feature class has a geometry type of Polygon, so this will hold closed shapes. We’ll start by digitising polygons, but lines and points are actually very similar.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Digitising in QGIS Part 1: Starting and finishing, and creating polygon features.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Start by selecting the Buildings layer in the Layers panel
· Either right-click on the layer and click on Toggle Editing or click the Toggle Editing button on the Digitising toolbar.
You should have more buttons available on the Digitising toolbar now.
[image: ../../shared/docs/images/creating_data/DigitisingToolbarOn_small.png]
The Digitising Toolbar once you have toggled editing with more buttons available.
· The button that I’ve highlighted is Add Polygon Feature. Click on this so that you are ready to start tracing.
We’ll digitise the School of Earth and Environment (SEE) building by drawing around the outline on the aerial photograph. SEE is the building to the north of Chancellors Court[footnoteRef:461]. [461:  If you’ve lost Chancellors Court in your map remember that you have the ChancellorsCourtBNG layer in your map from the downloaded data. You can Zoom to Layer on that to get back to the right area.] 

· Left-click on one corner of the SEE building, then on the next. Keep left-clicking until you have outlined the building. You can zoom in and out and pan as necessary (to pan easily hold down the mouse wheel and drag the map).
· As you progress around the shape you should see it as a transparent red with a stronger outline.
[image: ../../shared/docs/images/creating_data/DigitisingInProgress_small.png]
Starting to digitise the School of Earth and Environment. Note the transparent red area outlined in stronger red, this shows where you have already digitised.
· Each click creates a vertex or node.
· If you want to delete the previous vertex that you placed, because it’s not right, just press the Delete or Backspace keys on your keyboard.
· If you’re not happy with the whole shape clicking on Esc will get rid of it completely.
· When you have placed a vertex on each corner of the building right-click to finish editing.
Depending on the settings in your installation of QGIS you should find that a Features Attributes window opens. This gives you an opportunity to add attributes to your table.
If the window doesn’t appear you can still open the attribute table for the layer (right-click on the layer in the Layers panel) and add attributes that way.
· The buildings feature class has a Label attribute. Fill that in now with the name of the building - School of Earth and Environment.
· The fid (or Feature ID) is generated automatically so don’t touch that.
· Click OK.
· To save your new feature to the GeoPackage make sure that you click on the Save Layer Edits button on the Digitising toolbar
[image: ../../shared/docs/images/creating_data/EditingFeatureAttributes_small.png]
Adding attributes to your new feature. fid is generated automatically so don’t touch that!
Your new feature should appear as a solid colour on your map.
Continue on to digitise the buildings to the east, west and south of Chancellors Court. The map below shows the names of the buildings for you to add.
[image: ../../shared/docs/images/creating_data/BuildingNames_small.png]
Buildings around Chancellors Court and their names.
· When you have finished digitising and have saved your edits click on the Toggle Editing button again to finish.
Styling your layer
At the moment the buildings are a solid, random colour. Let’s change the colour to something that’s more usual for showing buildings on a map.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the Layer Styling panel by selecting the buildings layer then either clicking F7 on your keyboard, or clicking on the button at the top left of the Layers panel - the tool tip is “Open the Layer Styling Panel”.
· You can select a style from the Gallery that opens - one is called “Topo Building”, or click on the bar next to Color and select your own colour.
· Check Live update is ticked at the bottom of the panel so that your styles are automatically applied to your map.
· You can also click on Simple Fill at the top and experiment with the settings there.
Transparency
It can be useful to make your layers transparent. As you draw your building polygons you’ll gradually be covering up the layers underneath and it can be useful to see through the top layers.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Making vector layers transparent in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the Buildings layer in the Layers pane
· Then click on the button at top left of the Layers pane to Open the Layer Styling Panel or press F7 on your keyboard.
· The layer styling panel should open to the right of your map.
· Click on the Symbology tab in the icons on the left of the panel
· Make sure that the Fill is selected
· Use the Opacity slider to change the opacity or transparency of your layer. For example, slide it to about 70%
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
It is also possible to change the transparency by using the Opacity setting in the Layer Rendering section, but if you do that the features may not remain transparent when you export your map to pdf.
Set the opacity so that you can see through your building polgons to the aerial imagery below.
[image: ../../shared/docs/images/creating_data/SEEOpacity_small.png]
The SEE building with 70% opacity set.
Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality issues
Stop and think about the digitising you have just done. Can you think of any potential issues with the data that you have created in this way?
What scale did you digitise at? What effect will this have on the amount of detail that you included? What recommendation would you make about viewing the data on the map?
How accurate were you when you were placing the vertices on the corners of the buildings?
How clear were the edges of the building that you were digitising? What did you do when the edges were unclear, e.g. because of overlapping trees. What about shadows?
Editing features
If you want to edit a polygon, line or point to change it once you have created it you can.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Editing features in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the buildings layer and click Toggle Edit on the toolbar (if you aren’t already editing)
· Click on the Vertex tool on the digitising toolbar.
· Then right-click on the feature that you want to edit. The feature’s vertices will become visible as small red circles or squares.
· Left-click on one of the vertices and you will be able to move it around.
· When the vertex is in the position that you want it just left-click again.
· When you’ve finished editing right-click on the feature again to stop using the vertex tool. Your feature should appear as transparent red again.
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
Moving vertices by typing coordinates
Alternatively you can type coordinates into the Vertex editor to ensure that a particular vertex is in the correct location.
This is most useful if you have surveyed a feature and know exactly where the vertices should be placed.
· Click Toggle Edit on the toolbar (if you aren’t already editing)
· Click on the Vertex tool on the digitising toolbar.
· Then right-click on the feature that you want to edit. The feature’s vertices will become visible as small red circles or squares.
· The Vertex Editor should open on the left of the map window. This will show the x and y coordinates for each vertex on the selected feature.
[image: ../../shared/docs/images/creating_data/VertexEditor_small.png]
The vertex editor. It is now possible to type in new x and y coordinates for each vertex of the selected feature.
· To edit the coordinates just double-click on the coordinate that you wish to change.
· When you’ve finished editing right-click on the feature again to stop using the vertex tool.
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
Deleting features
If you want to delete a feature completely you can.
· Click Toggle Edit on the toolbar (if you aren’t already editing)
· Look for Select Features by area or single click button on the toolbars (highlighted on the image of the Attributes toolbar below)
[image: ../../shared/docs/images/creating_data/AttributesToolbar_small.png]
The Attributes toolbar with Select Features by area or single click highlighted.
· Click on the feature that you want to delete - it should become highlighted in bright yellow
· Press Delete on your keyboard
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
Labelling features
As you added features to your buildings feature class you also added the Label attribute. You can now use this to label the building features on your map.
This section shows you how to label polygon features. The same techniques apply to labelling lines and points.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Labelling features in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the Buildings layer in the Layers pane
· Then click on the button at top left of the Layers pane to Open the Layer Styling Panel or press F7 if it isn’t already open.
· The layer styling panel should open to the right of your map.
· Click on the Label tab on the left of the panel. At the moment it will just say No labels.
· Drop down where it says No labels and select Single labels
At this stage QGIS usually just labels your features with the first field in the feature class, which at the moment is fid. This isn’t very useful so the first thing you need to do is select the correct field.
· Next to Value drop down the choices and select the Label field.
Immediately the building names that you added should appear on your map on top of the correct buildings.
The default fonts, colours and placements are not always what you want. In fact, usually just accepting the defaults is not a good idea.
· Use the settings on the first of the tabs (Text) to change the font, font size and colour
[image: ../../shared/docs/images/creating_data/LayerStylingText_small.png]
The text panel of the Layer Styling panel. Change fonts properties here.
· Click on the Placement tab and select Horizontal from the Mode dropdown list. This should move your labels to within the polygon shapes as far as possible.
[image: ../../shared/docs/images/creating_data/LayerStylingPlacement_small.png]
The Placement panel of the Layer Styling panel. Change placement properties here.
Feel free to try out the properties in the other tabs too. There are lots of choices to help you make your labels clear and informative.
One useful one is on the Formatting tab where it is possible to set a maximum number of characters to wrap the labels onto multiple lines.
[image: ../../shared/docs/images/creating_data/LabelledBuildings_small.png]
The labelled buildings. Yours will look different as you will have made your own choices.
More information about labelling
Labelling is a big area and I’ve only shown you the basics here. If you want to find out more try some of the following suggestions.
The books in the Principles of Cartography section of the module reading list will all have sections on labelling, but try the following in particular.
· The QGIS User Guide includes a section on Setting a label which includes all the basic settings.
· Darkes and Spence (2017) has a section on Text on maps (pages 56-59) which includes information on type sizes and styles and text placement.
· Peterson (2021). Chapter 4 (p. 79 onwards) goes into more detail and is a readable guide.
Digitising Line features
Digitising line features is very similar to digitising polygons, except that you don’t have to finish where you started.
You should already have a Paths layer in your Layer panel. If you haven’t then drag it across from the GeoPackage.
Some of the paths on this map are curved rather than straight. The easiest way of drawing curved lines in QGIS is to click more often. On tight curves you do have to click a lot to make the line look curved. There are more advanced editing tools which would help, but this is only a quick overview so you can explore them if you want to, but this way of drawing is fine for now.
· Select the Paths layer, toggle editing and click on the Add line feature button
· Add lines for the paths across Chancellors Court. You don’t need to add any labels for this layer.
· Save your edits and toggle editing off.
· Style your paths in a similar way to how you styled the buildings - this time the gallery will have some suggested line styles and you can choose colours and line widths from the other panels.
Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality
Again, think about the problems that you encounter as you edit. Do you draw the edges of the paths, or just the centre line? How can you be sure of what happens underneath trees? How easy is it to be accurate with the drawing tools? Think about the implications for future use of the map at different scales.
Digitising Point features
Digitising point features is very similar to digitising polygons, except that you only have to click once for each point.
You should already have a Trees layer in your Layer panel. If you haven’t then drag it across from the GeoPackage.
· Select the Trees layer, toggle editing and click on the Add point feature button
· Add a point for each tree in Chancellors Court. You don’t need to add any labels for this layer.
· Save your edits and toggle editing off.
· Style your trees in a similar way to how you styled the buildings - this time the gallery will have some suggested point styles and you can choose colours and shapes from the other panels.
Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality
Again, think about the problems that you encounter as you edit. How easy is it to decide where you should add a point to represent a tree? How easy is it to be accurate with the drawing tools? Think about the implications for future use of the map at different scales.
Finally
Finish digitising the buildings around Chancellors Court, the paths across it, and the trees. Check that all the layers that you have created - the points, lines and polygons, have been symbolised appropriately and are labelled where necessary.
· Turn off the Aerial image by unticking the box next to it in the Layers panel
· If you have them, turn the symbolised waypoints layer back on
· Make sure that all the features on your digitised layers are visible in the map window.
Try creating a layout which shows your map of Chancellors Court.
In a later chapter you’ll find out how to create a full map layout with a key, scale bar, measured grid etc and print or export that properly, but for now just experiment and see what you have come up with.
When you have created a map export it to either an image or pdf and upload it to your GIS Portfolio in the Class Notebook. If you upload it within a week of the class I will provide brief feedback on your work.
[image: ../../shared/docs/images/creating_data/FinalMap_small.png]
The final map exported as an image. Yours will probably look different to this as you’ll have made your own decisions about symbols and colours, and about which features to include. You may also have included the features from GPS if you have done that exercise.
Further information and suggested reading
Many of the books in the reading list[footnoteRef:525] have a general introduction to inputting data to GIS. Suggestions include the following: [525:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 5, Data input and editing in Heywood, I., Cornelius, S. and Carver, S. (2011), pp.135-173 covers the background to a variety of ways of inputting data to GIS and discusses data quality issues.
· Chapter 8, Data Collection in Longley, P.A. et al. (2015), pp.173 onwards. Again this chapter covers the background to a variety of ways of collecting data and inputting it to GIS. Section 8.3.2 from page 183 covers Vector Data Capture, or digitising.
The QGIS Documentation has a chapter on the techniques of Editing which covers much more than we have been able to cover here.
The information about Digitising an existing layer covers the topics in this chapter, but there is plenty more there.
· Digitising an existing layer for v. 3.22 of QGIS
There are a lot of videos on YouTube which may help you. Try searching for Digitising QGIS.
Importing point data from xyz files
The background to importing point data from xyz files will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate how to set up and format xyz files ready to be imported into QGIS
· Import a csv file into QGIS so that it appears in the correct location and display the data on a map
Introduction
The data that was collected using GPS and that you imported in to QGIS shows you one way of adding point data to GIS. You will almost certainly also come across point data as an Excel/spreadsheet file or as a text file. If these contain x and y coordinates they can easily be added to GIS.
Access to software
Note that where the following instructions talk about Excel files, these can also be created and opened using OpenOffice Calc and LibreOffice Calc. Excel is available as part of the Office365 suite and you have access to that via the University. Note that the online version of Excel won’t save spreadsheets to csv format, only the Desktop version will do that.
Csv files are a form of text file and can be opened in any text editor as well as Excel, OpenOffice or LibreOffice. On Windows one recommendation is Notepad++ which has more functionality than the basic Notepad, but there are plenty of options on all operating systems.
Data to download
You will be using the North Wales project that you created in the Introduction chapter. If you no longer have that project then you can download another copy from the Week 7 folder in Minerva.
· The data that you downloaded in Week 7 should contain a folder called GP_data
· That folder should contain an Excel spreadsheet called LlanbedrGravity.xls. If you can no longer find that file you can download another copy from the Week 9 folder in Minerva.
Creating xyz files
Xyz files can be either comma separated value text files (often with an extension of .csv) or Excel or OpenOffice/LibreOffice spreadsheets. They contain point data which includes coordinates for a geographic location either in two dimensions (x and y) or three (x,y and z).
· Open the LlanbedrGravity.xls in a spreadsheet program now and have a look at the data it contains.
[image: images/import_xyz/LlanbedrGravitySpreadsheet_small.png]
The first few rows of the spreadsheet containing the gravity data for this exercise.
[image: images/svg/warning-black-24dp.png] Warning
Note that column headings for import into GIS need to be short and contain no spaces or non-standard characters - so text and numbers only. Also note that the column heading mustn’t start with a number.
In particular note the Eastings and Northings columns - these are in effect the x and y columns. These are in British National Grid 1 m coordinates (The grid numbers such as SH or SJ have been replaced with numbers - 22 and 23). Other numerical columns can be used for the z values, or the data. In this case we’ll be using the CorrBA (Corrected Bouguer Anomaly in mGal) as the z values.
It is possible to convert a spreadsheet to a csv (comma-separated value) format to import it into QGIS. Alternatively, we can install a plugin which allows us to import the spreadsheet without converting it to csv first. The plugin will also allow you to import csv data.
Installing a QGIS plugin
One of the strengths of QGIS is that it has a wide variety of plugins that you can install to carry out extra tasks. It’s worth having a look at the list of plugins available to you in the plugin manager.
[image: images/svg/videocam-black-24dp.png] Installing plugins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu bar go to Plugins > Manage And Install Plugins...
· When it opens click on the Installed heading on the left to see the plugins that are already installed.
· If you click on a plugin you’ll be able to see a bit about it in the panel on the right.
[image: images/import_xyz/PluginsInstalled_small.png]
The plugin manager showing the core plugins that are installed when you install QGIS. Your list will probably be different to mine.
To install a new plugin:
· Click on Not installed on the left
· Type Spreadsheet into the search box at the top
· From the list that appears click on Spreadsheet Layers and have a look at the description
· This plugin will do what you want it to do so click on Install Plugin
[image: images/import_xyz/PluginsSpreadsheetLayers_small.png]
Installing the Spreadsheet Layers plugin.
Once it has installed you should get a message at the top telling you it has been successful, and Spreadsheet Layers should now be in the list of Installed plugins.
· You can Close the plugin manager now.
· If you can’t see the Manage Layers toolbar (see image below) make it visible by going to View > Toolbars and putting a tick in the box next to Manage Layers toolbar. It will probably open vertically to the left of your Layers and Browser panels.
· You should gain a new button in the Manage Layers toolbar - hover over it to see the tooltip which should say “Add spreadsheet layer”.
[image: images/import_xyz/ManageLayersToolbarSpreadsheet_small.png]
The Manage Layers toolbar showing the new button for Add spreadsheet layer.
Converting the spreadsheet for use in QGIS
Start by opening your map of Llanbedr in North Wales in QGIS. You should have a view of the 1:25 000 raster map from Ordnance Survey. If not, turn layers on and off as required, and add the 1:25 000 raster map from the Browser if necessary.
If you add the xyz file to your map directly it won’t appear. QGIS will view it as a table without spatial information. You need to tell QGIS which fields contain the x and y data before it can display it.
[image: images/svg/videocam-black-24dp.png] Importing points from csv or spreadsheet to QGIS with the Spreadsheet Layers plugin
This video clip can be found in the module area of Minerva or in the full list of video clips.
To convert the spreadsheet so that you can use it in QGIS:
· Click on the Add spreadsheet layer button to open the dialog. Start filling it in by browsing for your spreadsheet file using the button to the right of File Name.
· Make sure that there is a tick in the box next to Geometry and select the x and y fields as appropriate - in this case x = Easting and y = Northing.
· Set the Reference system to the correct CRS. This time it will be the same as the current project - EPSG:27700 - OSGB36 / British National Grid.
· Check the data types in the preview pane. The important one here is under the CorrBA column and that should be set to Real, which means a decimal number.
· Check that the table previewed below looks correct - the data should look the same as it did in the spreadsheet you are importing.
· Then click OK.
[image: images/import_xyz/CreateLayerFromSpreadsheet_small.png]
Creating a layer from a spreadsheet. Check that the CorrBA column is set to Real.
You should find that you have a series of dots spread across your map. If you can’t see them make sure that the new layer is above the background map in the Layers panel.
[image: images/import_xyz/LlanbedrGravityLocations_small.png]
The locations of the gravity points in the new layer.
Exporting a layer to a geopackage
If you have a look in your folder in the Browser you’ll see that the new layer has been created with an extension of .vrt. This means that it is a virtual GIS format which references the original file. For our purposes it is a good idea to convert this to a geopackage feature class, i.e. a more permanent file format. This is so that we can use it in analysis [footnoteRef:566]. [566:  I’ve used a geopackage here, but it could be exported to any GIS format such as a shapefile instead.] 

· Right-click on the layer in the Layers panel
· Export > Save Features As...
· The Format should be GeoPackage
· Using the button on the right of the File name field navigate to the GP_data folder then type Llanbedr as the name of your new GeoPackage
· The Layer name should be something which tells you what the layer contains, e.g. LlanbedrGravity
· The CRS should already be set to EPSG:27700 - OSGB 1936 / British National Grid. If it isn’t, set that now.
· Check that Add saved file to map is ticked
· Click OK to export the layer to the geopackage.
[image: images/import_xyz/SaveVectorLayerAs_small.png]
Filling in the form to save the spreadsheet as a geopackage layer.
· Remove the original .vrt gravity point layer from the Layers panel to keep your map tidy.
· Save your map.
· Zoom to layer to check that your new layer is in the correct location. Your map should still look something like the map above - the locations won’t have moved. Note that I’ve changed the symbology so that the points are more visible.
· Right-click on the LlanbedrGravity layer in the Layers panel and open the Attribute table
· Have a look at the table - it should basically look the same as the original spreadsheet except that is has gained a field called fid for Feature ID.
You should finish this chapter with a project containing the points imported from the original spreadsheet with the 1:25 000 raster background from Ordnance Survey providing a background map.
In the next chapter we’ll look at how we can analyse the points and display the data in different ways.
Make sure you have this project saved and move on to the next chapter.
Analysing and viewing point data
The background to analysing and viewing point data will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· use styles and labels appropriately to analyse and display data on a map.
· select the correct tools to carry out geoprocessing tasks in GIS in order to answer specific questions.
Opening QGIS for analysis
[image: images/svg/warning-black-24dp.png] Warning
For the analysis in this chapter you will need QGIS with GRASS if possible.
If you are using QGIS from AppsAnywhere, once you have launched QGIS close it again.
For QGIS from AppsAnywhere or installed on your computer, now search for QGIS in the task bar. You should find something like QGIS Desktop 16.11.5 with GRASS 7.0.4 - see the image below. Open that version.
Versions of QGIS newer than 3.20 seem to open with GRASS available anyway.
[image: images/analysis/QGISwithGRASS_small.png]
Opening QGIS with GRASS from the task bar so you can run full suite of processing tools.
Introduction
This chapter continues working with the Llanbedr, North Wales map project, so open that in QGIS now if it isn’t already open.
Now that you have the point data in QGIS you can start to analyse it and display it to answer questions.
[image: images/svg/videocam-black-24dp.png] Raster and vector
If you feel that you are still not clear about the difference between raster and vector GIS data it would be worth watching the video “Learn more about raster and vector map data” by the Ordnance Survey before you start on this chapter.
Using symbols and labels to analyse data
We’ll start by seeing what we can do to analyse the data by displaying it on a map. In this way you can sometimes pick up patterns in the data.
Styling the point layer
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as graduated points in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the Layer Styling panel for the LlanbedrGravity layer (View > Panels and tick next to Layer Styling or the button at the top left of the Layers panel - remember that tool tips will show if you hover over a button.)
· Make sure you are on the Symbology tab.
· At the top drop down where it says Single Symbol and select Graduated
· Set the Value to CorrBA
· At the bottom of the panel select Classify
Your points should now have a range of colours - the key in the Layers panel shows the range of values that these indicate.
[image: images/analysis/LayerStylingGraduatedClasses_small.png]
The Layer Styling panel set up for graduated colours. Note the values in the classes list these can be changed using the Mode or manually.
· There are a lot of settings in the Layer styling panel. For example you can change the colour ramp
· or you can change the intervals by changing Mode and number of Classes.

· You can change the class values manually by double-clicking in the Values column and filling in new Lower or Upper values.
· It is also possible to change the Method to show graduated size instead of graduated colour.
· Try clicking on Load Values in the Histogram tab and have a look at how your data values are distributed.
[image: images/analysis/LayerStylingGraduatedHistogram_small.png]
The histogram tab showing the spread of your data.
[image: images/svg/create-black-24dp.png] Displaying your point data
Try out some of the settings in the Layer styling panel and see how they can help you to display and interpret your data.
How well do you think this works for this data set?
Use your knowledge as a scientist to display this data in a suitable manner using these tools.
Sometimes turning off the background layer can help you to see the styles and labels. Don’t forget to turn it back on again later, though.
If you’re not happy with your symbology remember that it is always possible to remove the layer from your map then add it back in again and start from scratch.
Labelling the point layer
Another way of displaying the data is to add labels to the points which show the actual values.
· In the Layer Styling panel go to the Labels tab (remember to hover over buttons or tabs to use tool tips)
· Drop down No Labels and choose Single Labels instead
· Set the Value to CorrBA and the labels should appear on your map.
Again, play with the settings. You have already tried out labelling polygons in the chapter on Creating data, now you have a chance to find out more about labelling points.
· Change the font and the font size on the Text tab. You don’t want these labels to be too large - they need to be visible but shouldn’t dominate the map.
· How do the Placement settings (one of the tabs at the top of the panel - use the tooltips to find it again) affect the labels? Try setting the Mode to Cartographic then increase the Distance of the label from the feature.
[image: images/analysis/LabelledPoints_small.png]
The labelled and symbolised points. Your points will almost certainly look different to mine as you will have made your own decisions about symbology, colours and labels.
When you are happy with the symbols and the labels save your map and continue.
Creating a raster surface from your point data
At the moment you have data in point format. That gives measurements for particular locations, but what happens if you want to know the measurement at a location between the samples? This is where GIS analysis becomes essential.
[image: images/svg/create-black-24dp.png] Highest and lowest values
Before you start have a look at the LlanbedrGravity layer and make a note of the highest and lowest values in the CorrBA field. You can do this either from the labels, or from the attribute table.
QGIS can create a surface in raster format which is derived from point data. This will show z values for the spaces between the observed points which QGIS processing tools will have worked out from available data - a process known as interpolation. Inevitably the accuracy of the surface will increase if you have more data points in a particular area, but it still works if your points are widely spaced.
There are a couple of different methods of interpolation available in QGIS. The instructions below use IDW (Inverse Distance Weighted) as an example, but you’ll get a chance to have a look at an alternative. Different methods work best for different data.
ESRI, who make the ArcGIS software that we’re not using, have an article entitled Interpolating Surfaces in ArcGIS Spatial Analyst. Whilst that refers to their software not to QGIS, the principles are the same. Have a look at the article and their discussion of IDW and Spline amongst others.
The analysis tools in QGIS are available in the Processing Toolbox.
· Open the toolbox by going to Processing > Toolbox
The Processing Toolbox should open to the right of your map.
[image: images/analysis/ProcessingToolbox_small.png]
The Processing Toolbox when you first open it showing the main tool providers.
There are a choice of tool providers in the toolbox. Depending on your settings you should see a series of QGIS logos denoting native QGIS tools, but there may also be GDAL, GRASS and SAGA. SAGA probably won’t be activated. You will have access to GDAL and you may have access to GRASS. We’ll be using a GRASS tool in the first set of instructions below. If it doesn’t work, don’t worry, just move on to the second set of instructions instead.
Using the GRASS toolbox IDW tool
[image: images/svg/videocam-black-24dp.png] Interpolating surfaces from point data in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To use the tools:
· Start by searching for IDW in the box at the top of the toolbox
· Several options should appear, double-click on the one under the QGIS Interpolation heading called IDW interpolation
· Fill in the dialog as follows
· The Vector layer input is your LlanbedrGravity layer - you should be able to find it by dropping down the list of layers
· The Interpolation attribute is the field holding the data - in this case it’s CorrBA, again use the dropdown to find it
· Click on the plus button underneath to add your input to the list.
· Click on the button next to the Extent field and select Use Layer Extent... then select the LlanbedrGravity layer as the extent
· Set the Pixel size x and y to 5.0. You can set it lower, e.g. to 2, but the size of the output file will be larger, and it will take longer for the tool to run.
· at the bottom choose where to save the output - I usually create a subfolder of the project folder called output then save all the raster data there
· Give your output a short name which will tell you what it contains, e.g. IDWgrav
· Click on Run and wait for the process to finish - it can take a while
· The Close the window.
[image: images/analysis/InterpolationIDW_small.png]
The IDW Interpolation form.
Your new layer should be automatically added to your map. If it isn’t, drag it there from the Browser now.
The tool will have interpolated the surface from your data points. You should end up with something similar, but probably not identical, to the picture below.
If your point labels are showing through feel free to turn off the LlanbedrGravity layer for now. It will make it easier to work with the surface.
[image: images/analysis/IDWoutput_small.png]
The output of the IDW processing tool.
Using the QGIS native tool
There is an alternative tool for running IDW interpolation which you can use if the GRASS tool above doesn’t produce output for any reason. Even if the tool above does work, it’s worth trying this one too and comparing the results.
· In the menu bar click on Processing > Toolbox to open the toolbox, or use Ctrl-Alt-T on your keyboard. You’ll get a list of the tools available to you.
· In the search box at the top search for IDW. This should give you a few options.
· Look for the Interpolation subheading, and find the tool called IDW interpolation and double-click on it to open the dialog.
[image: images/analysis/IDW_search_small.png]
Selecting the IDW interpolation tool from the QGIS toolbox.
Fill in the form for the tool:
· The input Vector layer will be the Llanbedr gravity point layer - in my case it is called LlanbedrGravity.
· Select CorrBA as the Interpolation attribute.
· Underneath that box click on the green plus button on the right to add the vector layer and attribute to the box - check that both are correct and Type is set to Points.
· Next to Extent click on the three dots button (ellipsis) and select Calculate from Layer > LlanbedrGravity to set the extent of processing. That is, the layer containing the point data. You can digitise a study area outline and use that instead if you wish.
· Under Output raster size change Pixel size X to 5. The other three boxes should update automatically. If you leave this on the default, which could be 0.01, it will take absolutely ages to run, and may well crash your computer.
· Under Interpolated click on the three dots button (ellipsis) to navigate to where you want to save the output, and give the output a name, e.g. idw.tif. The name should be something that will make sense to you if you come back to this project later.
· Check that Open output file after running algorithm is ticked.
· Then click Run.
[image: images/analysis/IDW_tool_small.png]
Filling in the dialog for the IDW interpolation tool.
The output from the above settings will have a horizontal resolution of 5 metres. If your computer is powerful enough, try changing the Pixel size X to 1 instead of 5. You’ll get a more detailed result, but it’s not worth it if it loads very slowly or even crashes your computer.
[image: images/analysis/idw_layer_small.png]
The IDW layer when it is first added to your map. Yours may look slightly different to mine - that isn’t a problem.
At this stage the output will be a greyscale layer that covers the other layers on your map. We’ll look at how to make it more informative in the next section.
Looking at the results
If you were able to run the GRASS IDW tool then use the output from that to carry out the rest of the exercises. Remove the other layer from your map to prevent confusion. If you were only able to run the QGIS native IDW tool then you are fine to continue with that output.
[image: images/svg/help_outline-black-24dp.png] Looking at your data
If you look at the Layers panel you’ll be able to see the low and high measurements for the surface that you’ve just generated. Do these measurements make sense in terms of the low and high of your original data?
If you look at the ESRI article on interpolation does that help you to understand why the surface may or may not vary from your data?
Change the symbology of the raster surface
QGIS has used a default black to white colour ramp to display the gravity surface but it should be possible to find a more informative symbology for this raster layer.
[image: images/svg/videocam-black-24dp.png] Styling a continuous raster in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select your new IDW layer in the Layers panel and open the Layer Styling panel if it isn’t already open.
· Use the dropdown to change Singleband gray to Singleband pseudocolor. Your layer will disappear.
· Drop down the Min / Max Value Settings and check that Min/max is ticked.
· Interpolation should be set to Linear
· Drop down the Color ramp and go to All Color Ramps > RdBu - this should be Red to Blue.
· Click on the Color ramp again, and this time select Invert Color Ramp - in general blue is seen as low and red as high so that fits this data better.
QGIS will display your gravity surface again.
· Add mGal as the Label unit suffix - you will probably want to put a space before it.
· Change Label precision to 2
· Then click Apply to apply those settings to the entry in the Layers panel.
[image: images/analysis/RasterSymbology_small.png]
Setting the styling for the raster gravity surface.
Using blending mode to show multiple layers
At the moment your surface is fine for the colours, but it is covering up the background map. You need to make that visible so that it is possible to see where measurements are located.
[image: images/svg/videocam-black-24dp.png] Setting blending modes for a raster layer in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure that your interpolated gravity layer is selected and go to the Layer styling panel.
· Have a look at the Layer Rendering section of the Layer styling panel. The top setting is for Blending mode and the default setting is Normal.
· Drop this down and have a look at the alternatives.
[image: images/analysis/LayerRenderingOptions_small.png]
The options for Blending mode under Layer Rendering.
· Try out some of the settings. They work by adding or subtracting the colour of the selected layer from the underlying layer(s).
· The most useful setting is Multiply. Select this now then zoom in and have a look at your map. You should be able to see the background layer through the interpolated gravity layer.
[image: images/analysis/BlendingModeIDW_small.png]
The blending mode settings set to Multiply and the effect on the layers on the map.
Setting transparency for a raster layer
Another useful way of balancing how different layers on your map display together is to make some layers transparent. Sometimes, even when you have the blending mode set, adding transparency can help.
[image: images/svg/videocam-black-24dp.png] Setting transparency for a raster layer in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the Layer Styling panel click on the second tab down on the left - Transparency
· Use the Global Opacity slider to make the layer transparent. Try setting it to something like 80%
[image: images/analysis/RasterTransparency_small.png]
Setting transparency for a raster layer.
Play with the slider until you are happy that your layer is suitably transparent so that the background layer shows through but the raster surface is still clear.
[image: images/analysis/SymbolisedSurface_small.png]
The symbolised, blended and transparent raster surface showing Corrected Bouguer Gravity Anomaly.
Trying out a different method of interpolation
There are multiple methods of interpolation but QGIS has a relatively limited choice. Kriging is only available under the SAGA library in QGIS and that doesn’t appear to be installed by default so I don’t cover it here.
For spline the only option I can find is part of the GRASS toolbox. If you had problems running the first tool for the IDW then you probably won’t be able to run this one either. If this happens, download the spline version of the surface from Minerva (rst.tif) and add it to your map then continue with the instructions on styling the surface. I am looking into how to solve the problem with GRASS but it isn’t obvious at the moment.
· If the toolbox isn’t already open go to Processing > Toolbox
· search for v.surf.rst - this will generate an interpolated map by splines (rst = Regularised splines with tension)
The form for this does look rather complex but you don’t need to fill in most of the choices.
· Set the Input points layer to LlanbedrGravity
· The Name of the attribute column... is CorrBA
[image: images/analysis/InterpolationRST_top_small.png]
The top of the Interpolation RST form showing the input and attribute column fields.
· Then go down to the Advanced parameters and set GRASS GIS 7 region cellsize to 5 (the cellsize is basically the resolution of the resulting raster layer)
· Then go down again to Interpolated RST [optional] - this is the output file.
· Click on the three dots button to the right and Save to file...
· Choose where to save the file and give it a name, e.g. RSTgrav.tif then Save
· Check that there is a tick in the box next to Open output file after running algorithm
· Then change all of the dropdown boxes below to [Skip output] to prevent those being created
· Then click on Run
I haven’t put an image for the whole of this form as it won’t fit on one page, but the image below shows the output section and the setting to save the Interpolated RST output, but none of the other layers.
[image: images/analysis/InterpolationRST_output_small.png]
Setting the output for Interpolated RST.
You may get quite a few red error messages while it runs - partly because we don’t have a large number of points to base the interpolation on. But QGIS should then add a new layer to your map.
· Follow the same instructions to style this output as you did the IDW output and make it transparent
[image: images/analysis/SymbolisedSurfaceRST_small.png]
The styled and transparent Interpolated RST layer.
[image: images/svg/help_outline-black-24dp.png] Looking at your data
If you look at the Layers panel you’ll be able to see the low and high measurements for the RST surface that you’ve just generated. Do these measurements make sense in terms of the low and high of your original data?
If you look at the ESRI article on interpolation does that help you to understand why the surface may or may not vary from your data?
Comparing the raster surfaces
You can compare the values of each surface at various points by using the Identify Features tool from the Attributes toolbar.
· Make sure that the IDW and RST layers are both visible, and turn off all of the other layers in the map
· Check that the Attributes toolbar is visible by going to View > Toolbars and checking that there is a tick next to it.
[image: images/analysis/AttributesToolbar_small.png]
The Attributes Toolbar. The Identify Features button is highlighted.
· Click on the Identify features button (highlighted in the image above)
· Then click somewhere on your map and select Identify All (2)
· The Identify Results window should pop up showing a tree view of the value of the two layers at that point as Band 1.
· Click in a few places and see how the values compare
[image: images/analysis/IdentifyResults_small.png]
The Identify Results window showing the values for each layer.
[image: images/svg/help_outline-black-24dp.png] Which surface do you think is the most appropriate for this data?
Have another look at the ESRI article on Interpolating Surfaces in ArcGIS Spatial Analyst.
Think about which surface you think is most appropriate for the data you have here and use that surface for the rest of the exercises in this workbook.
Keep a note of why you have chosen the surface that you have as you’ll need to include this explanation in the layout for the assessment at the end of this workbook.
Once you have decided which layer to use remove the other from your map and turn the raster-25k_3706482 layer back on so that it is visible.
Deriving contours from a surface
Once you have created a surface it is easy to derive contours to display the surface in 2D. This can make patterns in the data more obvious.
[image: images/svg/videocam-black-24dp.png] Creating contours from a raster surface in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· If the toolbox isn’t already open go to Processing > Toolbox
· Search for Contour
· You should find the correct tool under GDAL > Raster extraction > Contour. Double-click on it to open.
· Fill in the form as follows:
· The Input layer is the raster surface that you’ve chosen to use, e.g. I’ve used IDWgrav in the example.
· The Interval between contour lines depends on your data. Look at the highest and lowest values and think what might be a reasonable interval. If it doesn’t look good first time it’s easy to run the tool again. I’ve chosen to enter 1.
· Under Contours click on the three dots button on the right
· Click on Save to file...
· Navigate to the folder in which you want to save your data.
· Choose GPKG files (*.gpkg) as the Save as type: and give your output a name, such as Contours1.gpkg (the “1” will show the contour interval) and Save. Note that unfortunately this tool won’t add the output to an existing geopackage.
· Click on Run
[image: images/analysis/ContoursForm_small.png]
Filling in the form to generate contours from a raster surface.
QGIS should then generate contours and add them as a layer to your map.
[image: images/analysis/ContoursGenerated_small.png]
The contours generated from the IDW gravity surface. Yours may look different to these.
Use the Layer styling panel to set the contours to a suitable colour and thickness. They should be visible on your map, but not stand out too much. This is a map people will be looking at in close up, not a poster.
[image: images/svg/create-black-24dp.png] Sizing symbols to the output scale
Try setting the scale of the map to 1:25000 (the scale you’ll be using for the output) then in the layer styling panel set the Unit to Map Units, which in this case are metres. You’ll then be able to control how the Width of the line appears at that scale as that unit “on the ground”.
If the Unit is set to a measurement, such as pixels, then the lines stay the same width on the screen whatever your zoom level. Try it out and see.
Adding labels to contours
Contours for any surface don’t help much if you don’t know the value of each of them. QGIS is able to label features in a map with any field from the attribute table, as you saw in the exercises on digitising data.
[image: images/svg/videocam-black-24dp.png] Labelling features in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Right-click on your contours layer in the contents pane and select to Open Attribute Table.
[image: images/svg/help_outline-black-24dp.png] What is the name of the field that shows the height of each contour?
The attribute table will show the information, or attributes, about the features in this layer and should enable you to see which field holds the height, or elevation, data.
To add labels to your contours do the following:
· In the Layer styling panel click on the Labels tab on the left.
· Check that you have your contours layer selected at the top
· Drop down the list where it currently says No Labels and select Single Labels instead
· In the Value field select the field you made a note of above. The one which contains your heights. In my case this field is ELEV
The labels will appear on your map, but they are too big, too black and not on top of the lines! Use the settings in the various tabs of the Layer styling panel to
· make the labels smaller - they need to be readable, but not to dominate the map. Again, you can change the units to Map Units to have more control over the size when printed.
· change the font if you think a different font would be clearer
· make the labels a paler colour
· use the Placement tab to move the labels On line
[image: images/analysis/ContoursLabelled_small.png]
The contours symbolised and labelled more appropriately.
You could also try labelling your data points, if you think that it would be useful to someone else looking at your map.
Output from this chapter
The example below shows the possible output from this chapter. Your layout should look different. You will have made your own decisions about what to include and how to symbolise and label your data. You’ll learn more about layouts in a future chapter and will get a chance to apply those techniques to this map to produce a professional-looking map layout.
[image: images/analysis/FinalMap_small.png]
The final output from this chapter. Yours may not look the same as mine as you’ll have made your own decisions about some of the processing output and about colours and labels.
[image: images/svg/create-black-24dp.png] Save your map project for next week
Keep this North Wales map project safely as you’ll need it for future chapters and for the module assessment.
More information: Analysis in GIS
There is more about data analysis in GIS in the module reading list[footnoteRef:701]. In particular have a look at the following: [701:  Reading list available from Minerva and from the module catalogue.] 

Heywood, Cornelius and Carver (2011) chapter 6 on page 174 and following.
Longley et al. (2015) Part III is all about analysis, but in particular have a look at chapter 13 on page 290 and following.
More information on techniques in QGIS
The QGIS Training Manual includes a lot of information on both vector analysis and raster analysis in QGIS. If you are looking for ideas of how to use QGIS with your data in future this is a key resource.
If you prefer to learn from videos then Hans van der Kwast from the IHE Delft Institute for Water Education has a very good range on YouTube. His main interest is hydrology but the techniques he uses will work for other data too. He also has GIS OpenCourseWare for Hydrological Applications online which provide a lot of resources for learning GIS with QGIS.
Using BGS data from Digimap
The background to using BGS data from Digimap will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Demonstrate how to find BGS data in Digimap and download data for a particular area.
· Explain how to add BGS geological data to GIS and symbolise the data using BGS standard symbols/colours imported from an external style file.
Introduction
It is possible to download shapefiles containing British Geological Survey (BGS) data at various scales from the Digimap service. These can be added to GIS in the usual way. Once data has been added to a map, symbolising the data can be an issue. This chapter gives you some suggestions for how to display the data.
Please refer to the Digimap chapter of these exercises for more information about how to use the Digimap download services.
Data to download
Log in to Digimap and download tiles of geological data in shapefile format for the area below from the Geology Data Download section.
You should download 1:50 000 Geology from the Onshore Geology section of the menu. Unfortunately 1:25 000 or 1:10 000 data is not available for this area but a 1:50 000 map will be sufficient for our purposes.
[image: ../../shared/docs/images/bgs_data/GeologyDownload_small.png]
The area to download data for in Geology Data Download. You need to select to download 1:50 000 Geology.
Once you have downloaded the zip file containing your data save it to the folder with the rest of the data for this map then unzip it. Remember you can’t use data in QGIS until it has been unzipped.
Adding BGS data to your map
The geological data from Digimap is provided in shapefile format in tiles which match the printed map sheets. Luckily the area we are working on is covered by a single sheet - sheet 135 for Harlech.
· If your North Wales map isn’t already open in QGIS, open it now.
· Find the unzipped bgs-50k folder in your Browser panel and have a look at the contents of the ew135 folder. The name refers to the map sheet number and England and Wales.
[image: ../../shared/docs/images/bgs_data/GeologyContents_small.png]
The contents of the bgs-50k folder seen in the Browser panel in QGIS. Note that there are three shapefiles for the Harlech area.
You should see that the Harlech area has three shapefiles containing data. These cover bedrock geology, linear geology and superficial geology. Some sheets also have other layers.
Note that these layers will cover a larger area than the rest of your map layers - this doesn’t matter. When you create a layout you will set the view so that you only see the area you actually want and anything outside of that just won’t be seen.
· Add all three of these layers to your map by dragging them into the Layers panel
· Group the geology layers by selecting all three and right-clicking
· Select to Group Selected then give the group a name like Geology.
Once the layers are grouped you’ll be able to move them around together, or turn them on and off just by clicking next to the group heading.
· Drag and drop the layers as necessary in the Layers panel so that they are in the order shown in the image below
[image: ../../shared/docs/images/bgs_data/GeologyLayers_small.png]
Order the geology layers within the Geology group as shown here - linear above superficial, superficial above bedrock.
· Have a look at the attribute table for the ew135_harlech_bedrock layer
The attribute table has a lot of columns and looks rather confusing. If you want to know more about the data the user guide is available as part of your download from Digimap - look in the bgs-50k > docs folder for the User_Guide_BGS_Geology...pdf file.
[image: ../../shared/docs/images/bgs_data/BGSAttributeTable_small.png]
Part of the attribute table for the bedrock layer.
By default the data will be symbolised as single symbols and in random colours. You’ve seen previously how to set up categories for colours and symbology, but having seen the attribute table you’ll realise that doing that for these datasets would be time consuming and probably not very satisfactory.
Don’t worry - there is an easy way!
Using style files in QGIS
When you downloaded the geological data from Digimap, you will also have downloaded the style files to make the data look like a proper geological map using BGS styles.
At this stage you can’t see the style files in QGIS because you need to start by installing a plugin.
Installing the SLYR (Community Edition) plugin
You need to install the SLYR (Community Edition) plugin to be able to add the styles to your map.
[image: images/svg/videocam-black-24dp.png] Installing plugins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu go to Plugins > Manage and Install Plugins...
· When it opens, click on the Not installed heading on the left.
· Type SLYR into the search box at the top.
· From the list that appears click on SLYR (Community Edition) and have a look at the description.
· Finally, to install the plugin click on Install Plugin.
[image: ../../shared/docs/images/bgs_data/InstallingSLYRplugin_small.png]
Finding and installing the SLYR Community Edition plugin in the Plugin Manager.
Once it has been installed you should get a message at the top telling you it has been successful, and SLYR (Community Edition) should now be in the list of Installed Plugins.
· You can Close the plugin manager now.
Styling the geology with .lyr files
Now you can style the geology layers on your map.
· Return to the browser panel in QGIS. Select Project Home and click on the Refresh button at the top of the Browser.
Your ew135 folder should now look like the figure below. It should show .lyr files to match the .shp files.
[image: ../../shared/docs/images/bgs_data/BrowserSLYR_small.png]
The .lyr files should now be visible in the same folder as the shape files.
· Remove all the geology layers from your Layers panel. These will just get in the way when you add the .lyr files.
· Now drag and drop the ew135_harlech_bedrock.lyr file from the Browser panel to your map. Make sure you pick the .lyr, not the .shp file this time.
The bedrock geology should appear on your map. You may need to move it upwards in the Layers panel to be able to see it.
The layer should appear correctly styled as in the image below.
[image: images/svg/warning-black-24dp.png] Warning
If the layer doesn’t appear on your map and has a warning triangle next to it in the Layers panel, click on the warning triangle and navigate to the .shp layer.
A .lyr file contains the style information, but only links to the data, which is in the .shp file. If the link is broken, as it sometimes is when you download data (through no fault of yours), you need to repair the link.
[image: ../../shared/docs/images/bgs_data/BedrockGeology_small.png]
The styled bedrock geology layer.
[image: images/svg/create-black-24dp.png] Add linear and superficial geology to your map
Repeat the drag and drop with the linear and superficial .lyr files to add the linear and superficial geology to your map.
Move the layers in the Layers panel so that they are in a single group called Geology and show in the order below:
· Linear
· Superficial
· Bedrock.
[image: ../../shared/docs/images/bgs_data/GeologyMap_small.png]
The symbolised geological map showing the bedrock, superficial and linear geology.
Adding a background map to the geology
This looks a lot better, but a geological map needs a background map showing places and other features of the location.
· Zoom in to 1:50 000 using the scale dropdown below the map
· Superficial geology isn’t necessary on this map so turn off that layer or remove it from your map
· Turn off the raster_25k_3706482 layer - this is too detailed for a geological map at this scale
· Instead turn back on the Places, Line features, Polygon features and Tidal water layers.
· Make the ew135_harlech_bedrock layer transparent or apply a multiply blending mode so that you can see the background layer through it.
[image: ../../shared/docs/images/bgs_data/GeologyWithBackground_small.png]
The geology map with a background map visible.
Copyright notice
All maps produced from BGS data downloaded from Digimap must carry a copyright acknowledgement. You signed up to this when you agreed to the licence conditions.
You can check the Help page in Digimap to find the current required acknowledgement. As of November 2021 the text was the following:
Geological Map Data BGS © UKRI 20yy
Where yy is replaced by the current year.
Maps that also include OS data must in addition carry the OS copyright acknowledgment. This is currently:
© Crown copyright and database rights 2023. Ordnance Survey (AC0000851941)
The Places, Line features, Polygon features and Tidal water layers are all sourced from OpenStreetMap and should be acknowledged as follows:
© OpenStreetMap Contributors
Identifying the features on the map
Because there are so many categories for the bedrock on this map (all UK rock formations!) it is difficult to create a key, or to use the list in the Layers panel to identify the bedrock geology.
Instead you can use the Identify tool. You saw how to use the identify tool to compare the raster surfaces in the Analysis chapter but I’ll put the instructions here too to show you the tool in use for a vector layer.
[image: images/svg/videocam-black-24dp.png] Using the Identify Features tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the ew135_harlech_bedrock layer in the Layers panel
· Check that the Attributes toolbar is visible by going to View > Toolbars and checking that there is a tick next to it.
[image: ../../shared/docs/images/bgs_data/AttributesToolbar_small.png]
The Attributes Toolbar. The Identify Features button is highlighted.
· Click on the Identify features button (highlighted in the image above)
· Then click somewhere on your map and select ew135_harlech_bedrock (50000)
· The Identify Results window should pop up showing a tree view of the value of the bedrock geology layer.
[image: ../../shared/docs/images/bgs_data/IdentifyResultsBedrock_small.png]
The Identify Results window showing results for one of the Bedrock features.
There is a lot of information here. Have a look down the list - this matches the attribute table that you looked at earlier in the chapter.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Finding out the rock types
Have a look at the information for several of the rock features on the map. Make a note of the age, formation name and age for some of them. This will be relevant to your description and explanation of the relationship between the gravity and the geology for the assessment. It’s worth having a look at the linear features too.
If you just close the window when you finish you’ll find that you’re left with one of the features coloured red on the map. To return it to normal view:
· Click on the Clear Results button on the Identify Results window toolbar.
· Then close the Identify Results window.
Final map
When you’ve finished symbolising your map and are happy with it, export it as an image and upload it to your GIS portfolio notebook for feedback.
The image below shows a suggested final version of your map. Your map may not look identical to this and that is not a problem as you will have made some of your own decisions about colours and symbology.
[image: ../../shared/docs/images/bgs_data/GeologyMapFinal_small.png]
The symbolised geological map with transparency and a background layer.
Keep your Llanbedr, North Wales project for the next set of exercises.
Layout and presentation
Last Modified: 08 Jan 24, 17:13:47
The background to layout and presentation will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Layout your maps in such a way that they effectively communicate the content and purpose of your work to a user
· Select relevant map elements to include in a layout and set their properties to match the requirements of your map
· print or export your map layout to show your work to it’s best advantage
Introduction to layout and presentation
Once you’ve put in all the hard work to produce a map of your field area or project, it is worth making the extra effort to ensure that you lay it out clearly and print or export it in a professional fashion. Make sure that you allow the time to do this. Care and patience can make the difference between a scruffy, unimpressive map that loses you marks, and a clear, professional map that gives a good first impression and causes your audience to take your work seriously.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Don’t underestimate the time that the final details can take and don’t leave this part of the preparation until the last hour before a deadline!
You won’t need to use all the elements and features outlined here for every map. Equally this is not an exhaustive list of possible elements. You should already have some idea of what elements are useful, and should be able to make a decision for each case based on your existing knowledge of maps. If you think that you need to add something that is not listed here, e.g. a report based on a table, then use the extra information available at the end of the chapter and search on-line to find out how to add it.
This chapter isn’t necessarily for working through in order. Make sure that you are aware of the contents and of what QGIS is able to do, and then make your own decisions about what you need to include based on the principles that will be covered in class.
Note that the examples in the images use a general map which isn’t the same as the one you will be working on. The techniques and the buttons in QGIS are still the same, though.
The data for this chapter
You should use a map that you have been creating in previous chapters as instructed below [footnoteRef:781]. Try out all the techniques listed below and then decide which you need to include on this layout before you export it. [781:  If you no longer have a copy of the map that you have been instructed to use it doesn’t really matter. Either use a different map that you have created, or download the map from the week 1 class and use that instead. It isn’t the map itself that is important for these exercises, but having a layout with data on it so that you can try things out.] 

· Level 1 geologists use the Cononish map from the previous chapter.
· Level 2 and above geologists. You should be working on your own maps.
· Level 2 environment students use the Lake District map.
· Level 1 geophysicists continue working with the Llanbedr map.
Creating and saving layouts
In QGIS a print layout allows you to control the format and scale at which you print and export your map, and to lay out additional elements to complete the final product.
Creating a print layout
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating a print layout in QGIS and adding a map view.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To create a new print layout
· Open your map project in QGIS if it isn’t already open
· Add a print layout by going to Project > New Print Layout...
· You’ll be asked to Enter a unique print layout title - call it something that will tell you what this layout is intended for. For example, enter A3 for printing. You can leave this blank if you wish.
· Click OK
QGIS will open your new blank layout in a new window. It should look something like the image below - though your toolbars may be in different places.
[image: ../../shared/docs/images/layout/NewPrintLayout_anno.png]
Your new print layout showing a blank page.
In this view you will see your map laid out as it will be when it is finally printed or exported. You’ll see the page outlined on screen and, once you have started adding elements you will see the content as it will look on the page.
Opening existing print layouts
Once you have created a print layout you can close it and open it again without losing it.
· Close the window containing the print layout (Layout > Close)
· To reopen it go to Project > Layouts and select your layout from the list - there is only one there at the moment so click on that.
Saving layouts
A layout is saved as part of the project so whenever you click on Save in your project it will save the layout too.
For now:
· Click on the Save button in the layout window.
· Or Layout > Save Project
Adding a map to a layout
At the moment all you have is a blank page. To add a map to a layout:
· Click on the Add Map button on the Toolbox
· Or Add Item > Add Map
· Then use the mouse cursor to drag a box across the page. It doesn’t matter about the size at the moment you can change it later.
You should now be able to see a section of the map from your main project window. The Item Properties on the right will now give options for the map. You’ll explore these in more detail later.
Size and scale of pages and maps
The size of the page and of the map “window” will affect the scale and extent of the map. These are all linked so if you change one remember to check that your map is either still at the correct scale, or still covers the correct area.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Setting the size and scale of a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Page size and orientation
The page that you see in the layout window shows how the page will look when you export or print your map. Remember to check the paper size and set it correctly before you spend time arranging your layout.
To change the paper size and orientation:
· Right-click somewhere on the “page” and go to Page Properties
The page properties should open in the Item Properties on the right.
· The Size setting allows you to choose from a wide range of standard sizes, e.g. A4, A3 etc.
· The Orientation setting allows you to choose between portrait and landscape orientation.
· You can also set the page measurements manually by changing the Width and Height in the boxes below.
· The page in the main view should change automatically when you change a setting.
[image: ../../shared/docs/images/layout/PaperProperties_small.png]
The page properties set to an A3 Portrait page.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Changing paper size and orientation
Change your page size and orientation to A3 Landscape. This will give you more space to experiment with adding other elements to your page.
Once you have changed the paper size you may find that you can no longer see the whole page in the layout view. To zoom in or out use the buttons on the toolbar at the top. In particular use the Zoom full button.
Setting up a multi-page layout
It is possible to create layouts with multiple pages in QGIS.
· On the menu bar go to Layout > Add pages...
· In the box which opens select the number of pages to create and whereabouts you want them to be added.
· Set the size and orientation of your new page(s)
· Then click on OK to add them to your layout.
[image: ../../shared/docs/images/layout/InsertPages_small.png]
Inserting two new pages at the end of the layout.
If you decide you don’t need any of the pages you can delete them:
· Right-click on the page you wish to delete and select Remove page.
Resizing the map in a layout
When you first set up a layout the size of the map may not be the size that you want it to be eventually. Changing the size of the frame is easy, but can take a little experimentation. You will also need to look at this in conjunction with the instructions on changing paper size in the previous section.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Resizing the map frame in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure that the map frame is selected in the layout by clicking on it.
· When the map frame is selected you should be able to see that there are small boxes at the corners and on each side.
[image: ../../shared/docs/images/layout/ResizeMapFrame_small.png]
Using the handles on each corner and side of a map to resize a map frame in a layout.
· Use the boxes as “handles” to resize the map frame by dragging them
· Keep an eye on the scale in the map Item Properties. If you need to make a map at a particular scale you may need to keep putting this back to the correct scale each time you resize the map.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
This process can take patience to get the map frame the correct size for the scale and area. There don’t appear to be any short cuts so just stick with it and keep repeating the process!
Moving the map within a map frame
If you need to move the map itself within the frame, e.g. so that you see a different part of it:
· Click on the Move Item Content button on the Toolbox
· You’ll be able to use the mouse cursor to move the map around within the frame.
· You’ll also be able to zoom in and out on the map.
· Remember to click back onto the Select/Move Item button to be able to select items again. It’s frustrating when you forget and find that you can’t move any elements around!
Controlling the map with the Item Properties
If the map is selected on the layout you will see its properties in the Item Properties panel on the right. You can use these to control various settings for the map. The ones you need to know now are:
· The most obvious is Scale. Use this box to type the scale that you want your map to print at.
· Extents is useful if you don’t need to worry about the scale but do need to show a map covering a particular area. You can type the east, south, west and north coordinates and the map frame will change accordingly.
· The Frame setting allows you to put an outline around the outside of your map. This can make the map look more professional.
Adding items to a layout
The information below includes details on adding many different items to a layout. Not all these will be appropriate to every layout, but it is up to you to decide which items to use depending on the purpose and audience of your map and any guidelines specified for assessments or reports. Some of the references on the reading list, particularly Darkes and Spence (2017), should help you with this.
Remember that the QGIS Documentation will provide you with plenty of extra information on how to add items to a layout.
Most items are added to a layout in a similar way to each other using the buttons on the Toolbox. In most cases you’ll then be able to use the Item Properties to make changes to the item.
Selecting items on a layout
There are a couple of ways of selecting items on a layout.
· Click the Select/Move Item button on the Toolbox then click on the item you wish to select
· Alternatively, use the Items panel. As you add more items to your map they will be added to this panel. All you need to do then is click on them in this list to select them on the map.
You can also use the items panel to lock items in place and make them invisible.
[image: ../../shared/docs/images/layout/ItemsPanel_small.png]
The Items panel showing that Map 1 is select and locked, while the attribute table frame is invisible.
Once an item is selected it will have the little “handles” visible for resizing.
A legend or key
You will have added various data to your map, and it is necessary for you to explain to anyone looking at your map what those layers and symbols show. To do this you’ll need to add a legend or key. Note that this can be a relatively complex procedure and there are a lot of instructions in this section. It’s worth having a quick look at the whole section to get an overview before you start trying to add a legend.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a key or legend to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Start by using the default options to create a legend. Once you have the basic legend it is possible to make alterations later.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Save your map and take a backup copy of your project folder before you start doing this.
While it is usually fine, if you have a lot of big layers on your map QGIS can crash when you first add a key and you don’t want to lose the work you’ve already done.
There are ways to get around this problem with the legend crashing QGIS.
To add a legend / key:
· Click on the Add Legend button on the Toolbox
· Click on your layout in roughly the location that you want your legend to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a legend which includes all the items from all the layers on your map. This is likely to be rather a lot! The first thing to do is to remove any that you don’t need.
As usual, while the legend is selected, the Item Properties will show the specific properties for this element.
· In the Item Properties start by checking that the legend is referring to the correct map on your layout - use the dropdown box next to Map to select the correct one if you have more than one.
· You can give your legend / key a title if you wish, but note that this isn’t always necessary.
· Then move down to the Legend Items heading
· If you don’t want all your layers to appear then untick Auto update - you can always click on the Update All button later if you change symbols etc on your map.
· Now you can select layers and then click on the red minus button under the list to remove them.
· To only show elements which appear on your map tick next to Only show items inside linked map - this can be a great help to remove surplus symbols.
[image: ../../shared/docs/images/layout/LegendPropertiesLayers_small.png]
Setting the legend properties to control the layers and symbols on the key.
Once you have just the layers that you want on your key you can then use the rest of the properties to set fonts, backgrounds etc.
· It is possible to drag and drop the layers in the Items list and rearrange them.
· The Columns section allows you to split your legend into two or more columns.
· The Symbol section will let you change the size of symbol, or patch, on the legend - sometimes it is useful to be able to enlarge the “patch”.
· To change layer names in the legend without changing them on your map you can select the item in the list and click on the pencil icon below.
· Alternatively, you can change the names in the Layers panel in map view then click on the Refresh button in layout view to refresh the map and all associated items.
Changing the order of items within a categorized layer
If you have a layer styled by categories, the initial legend entries will usually be in alphabetical order starting from the top.
If you are creating a legend for a layer for which the order is important, for example, a geology bedrock layer where the younger rocks should be at the top and the older at the bottom, you will probably need to rearrange the legend entries.
There are two ways of doing this.
In the Layer Styling panel:
· Open the Layer styling panel and check the correct layer is selected.
· In the categories list drag and drop each entry to change the order.
This also changes the order in which categories are drawn on the map, so you may also need to check that your map still appears correct.
In the Layout legend options
· Select the legend and untick Auto update under Legend Items, if it isn’t already unticked.
· Select one of the categories you want to move and use the blue up and down arrows below the list to move it up or down.
This method only changes the order in the legend and doesn’t affect the order in which your categories are drawn on the map.
Changing the size of the legend patch
Sometimes the patches are too small to see clearly. This can be a particular problem for continuous colour ramps, but vector patches can be resized the same way.
To change the size of a legend patch:
· With Auto-update off…
· In the legend properties double-click on the layer to change or click on Edit selected item properties below the list of items.
· In this dialog you can also change the text next to the legend item.
· Use the Width and Height settings to make the patch larger - it should update automatically as you type numbers.
[image: ../../shared/docs/images/layout/LegendPatchSize_small.png]
Changing the size of a legend patch in the item properties.
Creating a legend for a continuous raster
Version 3.20 and above of QGIS will automatically create a continuous patch. So if you are using version 3.20 or above you don’t need to worry about the rest of this section.
[image: ../../shared/docs/images/layout/ContinuousAuto_small.png]
A legend for a continuous raster which was produced automatically by version 3.20 of QGIS.
Unfortunately, the tools in version 3.16 and below of QGIS don’t make it easy to create a patch for a continuous raster. The quantities will appear as separate boxes. There are ways around this.
[image: ../../shared/docs/images/layout/ContinuousNo_small.png]
A legend for a continuous raster which isn’t showing a continuous scale.
If you look at the article by EcoDiv entitled Legend for continuous raster in QGIS composer you’ll find a way to generate a continuous legend patch [footnoteRef:842]. [842:  Page last visited: 30th March 2022.] 

[image: ../../shared/docs/images/layout/ContinuousYes_small.png]
A continuous legend scale produced using the method at the web page above.
Manually editing the legend
There is a limit to what you can do with the automatic functions and properties but do as much as you can as that will save some time. It’s particularly important to play around with the spacing settings as there isn’t a way to change that manually.
Once you have finalised as much as possible on your legend using the item properties, the instructions below show how to manually add and edit elements manually.
Alternatively, it is possible to export the map as pdf or svg format then edit the legend in a vector graphics editing program such as Inkscape, CorelDraw or Adobe Illustrator.
[image: images/svg/videocam-black-24dp.png] Manually editing a legend in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Adding or editing items not created automatically
As an example, this could be a way to add a patch for a combined colour on the layout which isn’t actually part of a layer so doesn’t appear in the legend.
To do this, you add the shape you want using the menu items listed below, “draw” it on the layout, then style it using the item properties.
· To add a rectangle or circle go to Add Item > Add shape > Add Rectangle or Add Ellipse.
· To add a marker symbol, e.g. for a point, go to Add Item > Add marker, then choose a marker from the properties as you would for marker symbols in Layer styling.
· To add a line go to Add Item > Add Note Item > Add polyline. Click each node to draw the line, then left-click to finish.
Matching a colour on the map using the color picker
Legend items need to accurately reflect the colour of the equivalent feature on the map, so it’s important to be able to set this. QGIS provides a colour picker feature which is ideal.
· Make sure that the item you want to colour is selected on the layout.
· In Item properties click on the button next to Style. The Symbol Settings dialog should appear. This works in the same way as the Symbol Settings when you’re styling map features.
· click on the colour you need to change.
· Choose the Color picker tab (as usual, hover over the buttons to see the tips).
[image: ../../shared/docs/images/layout/ColorPickerTab_small.png]
The color picker tab.
· Click on the Sample color button to get the color picker cursor, then hover the cursor over the correct colour on the map.
· To select the colour, press the spacebar on your keyboard.
The colour should be applied automatically to your element.
Covering unwanted text or elements
This is an example of lateral thinking, but the easiest way to get rid of unwanted text or elements that can’t be removed using the legend properties, is the following:
· Go to Add Item > Add Shape > Add Rectangle and draw a rectangle over the text or elements you want to remove.
· Set the fill of the rectangle to the same colour as the background (using the color picker as above if necessary).
· Set the stroke style to No pen.
You can then add any new elements on top of the “invisible” rectangle.
Adding new or extra text
Adding new or extra text is really just a case of adding a label in the usual way.
· Add Item > Add Label
· Change the font, font size, colour, etc, to match any other text on the legend.
Preventing the legend from crashing QGIS
If you have a problem with QGIS crashing when you add a legend, try the following. It is probably crashing because you have a lot of layers on your map and, because Auto update is selected, it is struggling to add all the details.
· Open a new, empty project in QGIS
· Create a new blank layout as you did above.
· Add a legend to the layout. It won’t have any content, but that’s fine.
· Untick the box in the legend properties that says auto-update
· It’s a good idea to add a title and a frame to the legend so that you can find it again!
· Save the layout as a template (Save as template button on the toolbar)
· Close the blank project and reopen your real project
· Create a new layout use the template that you saved by doing the following:
· Project > Layout Manager
· Under New from Template select Specific from the dropdown
· then click on the three dots button next to the blank field
· Select the template that you just created and Open
· Click on the Create... button and you’ll be asked for a name for your layout
Once you have the layout open add a map frame. You’ll then need to associate the map frame with the legend by selecting the legend and setting the Map to the correct map.
Now use the + (plus) button below the Legend Items to add the layers that you do want to be included. Ticking Only show items inside linked map will also help.
This is a fiddle and not ideal, but if it stops your QGIS project from crashing hopefully it is worth it!
Scale bar and scale text
Some indication of scale should always be added to both printed and screen maps. A scale bar is a useful convention for both. Scale text (e.g. 1:50,000 or 1 cm = 1 km) is only relevant for printed maps, not for maps on screen where someone can zoom to any scale. If you add scale text you must also ensure that you print or export the map at the correct scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a scale bar and scale text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add a scale bar
· Double-check first that you have the correct map selected on your layout. Particularly important if you are including multiple maps at different scales.
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale bar (you can always move it later)
· Select OK on the New Item Properties box that pops up
The scale bar should appear on your layout. You can now go to the Item Properties to change various parameters.
· The Map dropdown is where you check that the scale bar is set for the correct map
· Use the Style dropdown to select how you want the scale bar to appear - try a few of these and see what effect they have
· The Scalebar units should be set to something appropriate for your map
· You can use the settings under Segments to change the length and intervals of your scale bar. Try these out and see what happens.
[image: ../../shared/docs/images/layout/ScaleBarProperties_small.png]
The most important settings for the scale bar.
There are a lot more settings so just explore these and see what they do. In particular you may want to change the Font under the Display settings. You can always remove the scale bar and start again!
To add scale text
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale text (you can always move it later)
· Select OK on the New Item Properties box that pops up
A scale bar should appear on your layout. You can now go to the Item Properties to change this to numbers.
· The Map dropdown is where you check that the scale text is set for the correct map
· Use the Style dropdown to select Numeric
The text should appear and automatically match the scale of your map. There are far fewer options for this - mainly just the Font settings.
Text or labels
Text is an essential part of any map layout. Maps need an informative title to show the audience what the map is about. You should include your name (or for an assessment your student ID) as creator of the map. Copyright statements are essential if you have used data from other sources and you may also want to include acknowledgements and further explanations of your maps and data.
There are two main ways to add text, static text and dynamic text. The instructions for static text are shown below. Dynamic is more complex and won’t be covered here. If you are interested in using it you can look at the tutorial on Creating a Dynamic Print Layout in the QGIS Training Manual.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Static text
Static text is text that you type into the box on the Item Properties. This stays the same once you have added it. Most of the text that you add to your layout will be of this type. For example, a title or subtitles to individual maps, your name or ID as the creator of the map, copyright text etc.
To add static text:
· Click on the Add Label button on the Toolbox
· Click on your layout in roughly the location that you want your text to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
· A new label item should appear on your layout. By default the text will be “Lorem Ipsum” (placeholder text).
· Type your text in the box on the Item Properties panel
· The options on the panel will also allow you to change the font, font size and colour, the alignment, and add a frame.
[image: ../../shared/docs/images/layout/TextProperties_small.png]
Item Properties for text. Note the large box to type your text and the options in the Appearance section below.
Copyright acknowledgements
Copyright is important. Remember that most data providers ask you to sign up to conditions that include an obligation to add a copyright acknowledgement to your map. Check what that copyright statement is and make sure that you add it.
For example, when you signed up to use the Digimap collections you agreed to add copyright acknowledgements whenever you created a map with the data. These acknowledgements do change from time to time so it’s worth knowing how to check what they are for yourself.
· To find the Digimap copyright acknowledgements go to the Digimap Help (Help at the top of the main Digimap page)
· Look for a link to Copyright and Licensing and click on it.
· Individual licences are in a list on the left, click on the one for the data you are using. There is more general information in the main body of the page.
· Then look for the information under In return, you must: - that gives you the acknowledgement text.
For example, from April 2019, when you use Ordnance Survey data obtained from Digimap you are expected to add the following text to your map.
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
Remember that you do have to acknowledge each different dataset that you use and will have signed up to that when your registered.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Adding the copyright symbol to your text
• To add the © symbol (on Windows), you can copy the symbol from this document and paste it into the box in the text properties panel.
• Alternatively, put the number lock on the keypad, hold down the Alt key, type 0 1 6 9 then let go of the Alt key.
• If you are on a Windows laptop and don’t have a number pad, put the text [%char(169)%] in the text box.
• If you are on Mac, either copy and paste, or use the shortcut Option + G.
If you are not using U.K. Ordnance Survey data this is not the correct copyright acknowledgement to use. For example, if you are using data for Spain or the United States, or indeed UK data that you haven’t downloaded from Digimap. You’ll need to find the correct copyright acknowledgement for yourself. You can often find this sort of information on files that come with the data or on the webpage you downloaded it from.
Digimap also give advice on citing Digimap data as opposed to the copyright acknowledgement.
GIS Lounge have an article about How to Cite GIS Materials which includes the software as well as the data and the maps.
A measured grid
Measured grids add labelled grid lines to a map. If you are using Ordnance Survey or other UK data projected in British National Grid then you can easily add National Grid lines and numbers to your map. The O.S. Raster tiff files already have grid lines marked, but adding a measured grid allows you to include coordinates around the edge of your map - making it possible to read grid references.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a measured grid to a map in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the map to which you want to add grid lines.
· In the Item Properties scroll down until you reach the Grids heading and click on the little arrow next to it.
· Click on the + (plus) button below the Grids heading to add a Grid to the list below.
· Select the Grid in the list and click on Modify Grid...
The Item Properties will change to show the properties for the grid.
· Under Interval set the X and Y boxes to the interval that you want between the lines. This depends on the scale of your map and you can experiment to see what looks best and would be most useful. For now try 1000 - this is in map units which for British National Grid will be metres.
· The lines are often too bold, so click on the Line style dropdown and select a paler shade of grey. You could also make the lines thinner.
[image: ../../shared/docs/images/layout/MapGridProperties1_small.png]
The top of the Map Grid Properties showing the interval and the paler line style.
· Scroll down and tick next to Draw Coordinates - this adds the numbers.
· I usually change the Left and Right coordinates from Horizontal to Vertical so that they follow the edge of the frame.
· Alter the Font as you wish - don’t make the coordinates large. They need to be visible, but not intrusive.
· Change the Coordinate precision to 0
[image: ../../shared/docs/images/layout/MapGridProperties2_small.png]
The Draw Coordinates part of the Map Grid properties showing the Vertical setting for Left and Right and Coordinate Precision set to 0.
Note that the grid that QGIS adds is fully numeric, you may be more used to seeing grid letters for 100 km grid squares, e.g. the University grid reference is similar to SE 2934 3444, the University grid coordinates are similar to 42934 43444. It is the latter that will appear on a measured grid generated by QGIS.
[image: ../../shared/docs/images/layout/MapGrid_small.png]
A map with a measured grid that shows British National Grid coordinates on a 1000 m grid.
North arrows
Before adding a north arrow to your layout stop and think about how you need to indicate north on your map. If you look at the technical information on an Ordnance Survey Landranger (1:50 000) map you’ll see a diagram showing Grid north, True north and Magnetic North. The information given there shows how to plot the difference of magnetic north from grid north. Adding this to your own maps can be useful, particularly if you, or anyone else, are going to be using the map in the field.
If you are taking strike and dip measurements in the field you should have corrected your compass-clino for declination (the horizontal angular difference between true north and magnetic north) anyway. When you plot the measurements on your map it isn’t worth worrying too much about whether you are plotting against grid or true north as the difference on any grid, not just the British National Grid, is unlikely to be that big. See the image below for the different types of north and the declination.
[image: ../../shared/docs/images/layout/LONorthVersions.png]
The different types of North that you will find on a map set to a projected coordinate system, such as British National Grid.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Labelling north arrows
If you add any north arrows to your layout do remember to label them in some way which shows which version of north each one is showing.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding north arrows to a layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
North arrow: Grid north / Map north
If a map is in a projected coordinate system QGIS will automatically lay it out aligned with the grid. So for example, any map set to British National Grid will be aligned to grid north.
In this case it isn’t strictly necessary to add a north arrow to show grid north if you also include a measured grid on your map, but it doesn’t hurt.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation the North alignment should be set to Grid North by default - if it isn’t set that now.
[image: ../../shared/docs/images/layout/NorthArrowGrid_small.png]
The Item Properties for a north arrow showing Grid North.
If you check this against your measured grid lines you should find that it matches exactly.
North arrow: True north
True north is the direction from the area of your map to the North Pole. In the east/west centre of a grid, such as that set for the British National Grid, it may well be the same as grid north, e.g. in Leeds the difference is extremely slight. As you go further east or west towards the edges of an area covered by a grid the difference becomes more noticeable, e.g. at Lands End in Cornwall, or in Norfolk.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north
You should see the rotation in the box above change to a slightly different number.
If you check this north arrow against your measured grid lines you may well find that the north arrow is slightly tilted.
North arrow: Magnetic north calculated by declination
Magnetic north is the direction from the area of your map to the magnetic north pole. This is the number that is given on the corner of Ordnance Survey maps and the one geologists need for setting their compass-clinos in the field, so it is worth making a note of this on your map too.
Finding the magnetic declination
First you need to find the magnetic declination.
· Go to the World Magnetic Model 2020 Calculator on the BGS Geomagnetism Group web pages
· Use the map to navigate to your location and click to drop a point.
· A small results box will appear. The number you want is the Magnetic declination, which is in in the D column and MF row. There is a key to the results below the map and you are looking for degrees east.
· Make a note of the declination, including any minus sign.
To set magnetic north on a layout
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north as declination is the angle from True north to Magnetic north.
· In the Offset field enter the angle that you obtained from the BGS website.
[image: ../../shared/docs/images/layout/MagNorthImageRotation_small.png]
Setting the image rotation for a magnetic north arrow. The declination from the website is -0.35 degrees.
Don’t forget to add text to your map showing the date of the reading. It changes with time.
For more about how the magnetic north pole is moving see the BGS blog.
Multiple maps on one page
It can be very useful to be able to place more than one map or map view on a single page, either so that you can show a different area, or a different zoom level for the same area. You can also use this to set up an automatic extent indicator which marks your study area on a map of a country.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding multiple maps to one layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Different areas of the same map
You can add multiple maps to your layout using the Add Map command in the same way you added a single map earlier.
If you add them directly both maps will show the same data and styling. You can then change the scale and extent on each one individually using the Item Properties and the Move Item Content button.
Maps showing different content
If you want to add further maps to your layout but have them showing different content you can do that too.
· Select the initial map frame on the layout
· Make sure that it shows the content that you want it to show and it is all styled correctly
· In the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
Now go back in to the map view and set up the map and layers so that they are as you want them for the second map.
· Back in layout view add a new map frame as before. This should reflect the map that you have open in the map view now.
· Once you are happy with this view in the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
As both of your maps are locked you will have to remember to unlock them if you need to make any changes to the styles or combinations of layers.
[image: ../../shared/docs/images/layout/MultipleMaps_small.png]
Two views from the same map with layers locked.
Extent indicator or locator map
For some maps, particularly large scale (detailed) maps of very small areas, it is useful to show a small scale map of the general area with the area of the main map marked, as in the figure below.
[image: ../../shared/docs/images/layout/ExtentIndicator_small.png]
A map of a small area with an extent indicator or locator map to give context.
To do this you need to obtain small scale data and add it to your map. You really only need a general map, even just an outline of a whole country.
Natural Earth data
It is possible to do this using data from Natural Earth. Download the Countries data from Medium scale data, 1:50m > Cultural > Admin 0 - Countries - click on the Download countries button to download a zip file containing a shapefile.
Quick World map
There is also a little trick hidden in QGIS which makes adding a World map with country outlines really easy.
· In your QGIS project click in the Coordinate box at the bottom of your map then delete the existing contents.
· Type world (all lower-case) and press enter.
A map of the world with country outlines should appear on your map and in your Layers panel. When you zoom to layer the result might be a bit odd if you have a projection such as British National Grid set for your map, but try it out and see whether the area you need looks right.
You can style the map as usual, e.g. if you just want outlines.
[image: images/svg/warning-black-24dp.png] Warning
Using a screenshot from Google Earth or Google Maps (or similar) with a marker on it doesn’t look professional and should be avoided. Not least it is surprisingly easy to end up with the marker in the wrong place.
Adding the extent indicator to your layout
Note that the extent indicator does not need to be large, but should be a small map which doesn’t take up too much space on the layout.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding an extent indicator to a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your main map and lock the layers on the layout.
· Add the Countries outline to your map and turn off the other layers
· Symbolise the countries as a thin black outline and zoom in to the country containing your study area
· Add a new map to your layout and resize it as appropriate so that it shows the country as a small map.
· Make sure that the small map is selected then go to the Item Properties panel
· Scroll down to the Overviews section and click on the little arrow next to it to open it out
· Click on the + (plus) button then select the new Overview title that appears
· Check that Draw "Overview 1" overview (or whatever your new Overview is called) is ticked.
The properties to change how the overview looks are below.
· Under Map frame select your main map - the one of the smaller area.
[image: ../../shared/docs/images/layout/OverviewsProperties_small.png]
The Overview properties in the Item Properties for the small map.
· Set the Frame style as you wish. If you can’t see the frame on the indicator map because it is too small
· I found that setting the Simple fill Stroke style to Solid Line in the Symbol Settings
· then giving it a thicker Stroke width and setting the Join style to Round gave the effect of a dot on the map.
[image: ../../shared/docs/images/layout/OverviewDot_small.png]
Using the Symbol Settings to make the overview frame look like a dot.
You should now have a map with a marker showing the location covered by your main map. If you move the main map the “frame” on the smaller map will automatically update to reflect the new location.
Inserting photographs and images
You may want to include photographs and diagrams on your map layouts. Geological cross-sections will come under this category too.
[image: images/svg/videocam-black-24dp.png] Inserting photographs and images in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add a raster image
This includes photographs or any image in a format such as jpg, png, tiff, gif.
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a Raster Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
To add an SVG image
SVG stands for Scaleable Vector Graphics. It is the native editing format for the vector graphics program Inkscape. If you have used Inkscape to draw your diagrams you can import them as follows:
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a SVG Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Unfortunately, svg images with gradient fills don’t seem to work well in QGIS. In many cases it will be better to export your diagram from Inkscape as a png file then import that to QGIS as a raster image.
Alternatively, you can export the layout from QGIS when you have finished adding all the map elements and then open it in Inkscape and add your diagrams there. This is usually a better option and instructions will be given for exporting from QGIS later in this chapter.
Checking your map
Checking your map is a very important stage but one that can easily be forgotten if you are in a hurry.
In addition to the points below have a look at Darkes (2017) which gives a lot of quick tips on map layout and presentation. On pages 92 and 93 Darkes includes a section with quick wins for improving your map before publication if you have 5, 15 or 50 minutes.
Suggestions for things to check
· Check that you have included everything you need to include. If this is an assignment reread the instructions and check that you haven’t forgotten to do anything.
· Check that you have left space for margins on the page. This is particularly important if you are printing your map - you don’t want to lose any of the content - but leaving some white space around the outside of your layout looks better even if you’re not printing.
· Check spelling. It’s easy to miss something obvious so if possible, print your map out, or put it on screen and stand back a bit then have a look at it. In particular check geological and geographical names and any technical terms.
· Check that your map doesn’t include anything that you don’t want to include! Did you add some experimental polygons when you were editing, then forgot to delete them? Have you added text boxes and then not removed any that you don’t need?
· Look at the article on Using a mapmaking checklist for map design on the ESRI blog. Read about what makes a map great, then click on the link to the checklist and use the questions there to evaluate your own map. Have you included everything you need to include, or do you have a good reason if something is not on your map? Have you taken care with your presentation?
Checking the colours of your map and layout
In the lectures on styles and labelling, and on presentation, we will have discussed the use of colour on maps. It’s a good idea to check your colours before exporting or printing your map, though you should have been thinking about them as you created and laid out the map too.
In Layout view there is a setting which allows you to simulate different forms of colour blindness.
The idea is to check that all the information on your map is accessible to all your potential audience.
[image: ../../shared/docs/images/layout/PreviewNormal_small.png]
The original, normal view of the map - no preview applied.
· In Layout view go to View > Preview then choose one of the forms of colour deficiency.
The whole layout should change to give you a preview.
[image: ../../shared/docs/images/layout/PreviewProtanopia_small.png]
A preview of the same map as it could be seen by someone with protanopia - no red.
· Check all the colours on your map are distinct. Do any look too similar? Have a look at the key as well to check the colours.
· Do all the layout elements show up clearly? If you’ve put anything on a background, is it still easy to see?
· Try different settings and check the colours carefully for each one.
· Looking at a layout in the greyscale preview setting can give you a good idea of the amount of contrast you have between your colours.
[image: ../../shared/docs/images/layout/PreviewGreyscale_small.png]
A greyscale preview of your map. Note how you can see the amount of contrast between your colours. Try to aim for good contrast to make your map clear to all your audience.
Printing a copy to pdf to check
Almost inevitably you’ll notice something not quite right with your map after you have printed it. To minimize the chances of this happening if you are printing an expensive A0 copy it is a good idea to print your map at A3 and have a close look at it. This isn’t such an issue if your map is only A3 or A4 when full size.
If you don’t have access to a printer then you’ll need to export as pdf and then zoom in and out on your screen.
· Export your layout as a pdf file following the instructions below.
· Open your pdf map file in your usual pdf reader (instructions below are for Adobe Acrobat but you should be able to find similar commands in other programs)
· File > Print
· Choose your printer and use the printer properties to set the paper size to A3 then choose to print in colour.
· In the Page Handling section set Page Scaling to Fit to Printable Area. In Acrobat this should show you a small preview of how your file will print.
· When you are happy with the settings send your file to the printer.
Printing and exporting map layouts
When you have finished creating your map layout in QGIS, you will often need to export it to pdf for printing. The following instructions should help to ensure that your map is the correct size and scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Printing a map layout from QGIS
The best quality output is probably obtained by printing directly from QGIS, though this isn’t always possible. If it is, print as follows:
· Start by checking that the page size and the map scale are correct.
· Go to Layout > Page Setup and check that the paper size matches the size you set in the layout properties.
· Then Layout > Print to actually print your map.
You’ll need to set up the printer as you usually would. This is system and printer specific so I can’t include fuller instructions here.
Exporting a map layout from QGIS
Exporting to pdf
These instructions show you how to export the map to pdf - the format that is usually required if you are having the map professionally printed.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as PDF... or click the button on the toolbar.
· Select where you want to save your output and give it a name
· Then click on Save
· The PDF Export Options should open. The defaults are fine, so stick with those
· Click Save to export the pdf.
You should get a message saying that your layout was successfully exported.
At this stage open the pdf and make sure it looks as you expect it to.
Important note on printing a map layout from pdf
If you are printing your final copy from pdf double-check in the pdf reader you use that the Page Scaling or Zoom is set to Actual size... or None. The actual terminology depends on which pdf application you are using.
This is important to ensure that your map is printed at the scale at which you intend it to be printed. This is particularly important if you are printing maps to be used as field slips. Major problems with measurements can be caused if your map is reduced by even a tiny amount.
Importing a pdf map layout in to Inkscape
[image: ../../shared/docs/images/svg/info-black-24dp.png] Export pdf and import to Inkscape
It is possible to export a map layout to svg which would work in Inkscape, but at the moment the export is rather unreliable. If you want to open your map layout in Inkscape to finish it off it is better to export pdf and import that to Inkscape.
I have experimented a bit with using the output from QGIS in Inkscape for a large map, and have found that, unless you are going to actually want to edit some aspects of the actual map, Inkscape is more stable if you import the map as an image, e.g. png format, and then add other elements around it. The next section below shows how to export your map as a png image.
If you need to make changes to a single element of your map, e.g. the legend, try creating the legend on a separate, smaller layout, export that as pdf and then add that to the main layout in Inkscape.
If you are importing the pdf in to Inkscape and if your map is going to be part of a bigger presentation where scale is important, such as the Geology degree final dissertation map, be very careful to import it without changing scale, size or proportions. The Interactive Inkscape exercises[footnoteRef:969] have a section on how to import a map layout. [969:  If you are not a Geology student but would like to learn how to use Inkscape for drawing and for finishing maps please contact Clare Gordon or go to Clare’s downloads to obtain a copy of the exercises as interactive worksheets.] 

Exporting a map to import to Word and PowerPoint
You can also export the layout to include in programs such as Word or PowerPoint if you are intending it to accompany a report.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as image or click the button on the toolbar.
· The Image Export Options will open. This gives you another chance to check the resolution.
· It’s usually worth ticking Enable antialiasing - but if your map looks very blurred it will be worth trying again with this unticked.
· If you are likely to want to open your output in GIS again click to Generate world file
· Click Save and wait for your file to be exported. You’ll get a message when it finishes.
Be aware that it is a good idea to create your layout at the correct size in QGIS before you export it. You can resize jpg or png files in Word and PowerPoint but you’ll lose some of the quality.
Setting up to print multiple map pages
Sometimes, once you have a map set up, you need to print it across multiple pages. The most likely example of this is for Geology students, where you set up your field slip ready for mapping, but it will need more than one page to print it at 1:10,000. Other students probably won’t need to do this, but the instructions are here anyway.
[image: images/svg/warning-black-24dp.png] Warning
Unless you need to set up a map as a series of field slips, or atlas pages, don’t follow these instructions now. It will be better to spend your time on other aspects of your map.
There are a couple of different ways you can do this and instructions are below.
· For all the options, start by setting up a layout with a map frame and any other elements you need to include, e.g. a scale bar, copyright text, date etc.
· It can be useful to have an outline of your area of interest so you can keep track of the area you need. If you don’t already have one in your map, create it as a polygon and roughly digitise the outline of your area.
Moving the map around within the layout
This method is probably the simplest, but it can be easy to miss bits, and if you do, it isn’t always easy to repeat the process.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages by moving the map around in the layout
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your map layout, then move the map so you are looking at the north-west corner of your area of interest.
· Check the scale is correct.
· Print or export your map. If you export, you’ll be able to print further copies if you need them.
· Now carefully, using the Move item content tool, click and hold on the north-east corner of your map, and drag the map content across so that the bit you are dragging from is in the north-west corner of the layout. It’s usually a good idea to have an overlap.
· Once again, print or export your map.
· Continue doing this, dragging the map upwards from one of the southerly corners when necessary, so you have complete coverage of your study area.
Using the QGIS atlas function
This seems more complex, but if you make the effort, it is more reliable and if you need to generate maps for the same area again, it will be much simpler to do so than with the method above.
Once you have set up an atlas, QGIS will automatically export the pages based on your settings.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages with the QGIS atlas tool
This video clip can be found in the module area of Minerva or in the full list of video clips.
Creating a grid to control your atlas
You need to start by creating a coverage layout to control the area of each page of your atlas and the most reliable way to do this for field slips is to set up a vector grid to cover your area of interest.
To generate your vector grid:
· Search for Create Grid in the Processing toolbox and open the tool from under Vector Creation.
· Set Grid type to Rectangle (Polygon).
· If you have a layer covering the whole of your area of interest on your map, click on the three dots button at the end of the Grid Extent line and select Calculate from Layer, then select your area of interest layer.
· If you don’t have a layer covering the whole of your area of interest, select either Use map canvas extent or Draw on Canvas. If you select the latter, you’ll have a chance to draw your area on the map.
· Use the table below to select your Horizontal spacing and Vertical spacing based on the scale of your maps, and the size of your paper.
· Set the Grid CRS to the correct CRS for your map.
· Either create a temporary layer, or choose where to save your vector grid.
· Run the tool.
Note that the values in the table allow for a bit of an overlap. For landscape orientation instead of portrait, swap horizontal and vertical spacings.
This is a process which is likely to involve a bit of experimentation and changes in spacing to get the coverage you want.
	Paper size and orientation
	Scale of map
	Horizontal spacing (metres)
	Vertical spacing (metres)

	A4 landscape
	1:2,500
	600
	400

	A4 landscape
	1:5,000
	1250
	850

	A4 landscape
	1:10,000
	2700
	1800

	A4 landscape
	1:25,000
	6500
	4400

	A4 landscape
	1:50,000
	12000
	9000


[image: ../../shared/docs/images/layout/CreateGrid_small.png]
Creating a grid on which to base an atlas.
The result should be a regular grid, shown as the blue, dashed lines in the image below. (The thin, solid blue line is my area of interest.) The grid starts from the top left, so you may find you have too much space on the right and bottom of the grid. The main way to deal with this is to change the grid spacing, or use a slightly different area. If any of your grid rectangles have very little or none of your area of interest in them, as in the right-hand rectangles in the example below, you can delete them.
[image: ../../shared/docs/images/layout/VectorGrid_small.png]
The resulting vector grid shown as a blue, dashed line. The rectangles on the right contain very little of the area of interest, and I will delete them.
Setting up the atlas
Once you are happy with your coverage layer, you can start setting up the atlas.
· Enter Layout view and check your layout is set up correctly, e.g. with titles, scale bar, copyright, etc as required.
· Go to Atlas > Atlas Settings - the settings should open to the right of your layout.
· Tick the box labelled Generate an atlas.
· Set the Coverage layer to your vector grid layer.
· For now leave the Hidden coverage layer box unticked - being able to see the coverage layer while you are setting up, helps to get the correct areas on each page.
· For now you can leave the other settings as they are. You can come back to the settings and change those later if you need to.
[image: ../../shared/docs/images/layout/AtlasSettings_small.png]
The basic settings for an Atlas. Note that there has to be a Coverage layer, which in this case is my vector grid layer.
The next options are in the map properties:
· Click on the map frame that will control your atlas.
· Click on the Item Properties tab on the right.
· Scroll down and tick the box next to Controlled by Atlas.
If you are setting up a field slip you will need your maps to be at a fixed scale, usually 1:10,000. To set that fixed scale:
· Check next to Fixed scale.
· At the top of the Map Properties, check the Scale is set correctly - in my case to 10000.000 for 1:10,000.
[image: ../../shared/docs/images/layout/ControlledByAtlas_small.png]
Controlling the Atlas as a Fixed Scale in the Map frame properties.
· Now go up to the Atlas toolbar - if it isn’t visible go to View > Toolbars > Atlas toolbar.
[image: ../../shared/docs/images/layout/AtlasToolbar_small.png]
The Atlas toolbar with the Preview Atlas button clicked.
· Click the button on the left of the toolbar - the tooltip should say Preview Atlas.
Your map frame should jump to the first atlas page for your map. As you’ve left the coverage layer visible, you should be able to check whether you have the coverage you need.
· To preview your atlas, use the arrows on the toolbar. The numbers show which page you are on.
[image: images/svg/create-black-24dp.png] Changing the coverage
If you need to change the coverage, you’ll need to regenerate the vector grid, add it to your map, and change the coverage in the Atlas settings.
Preview your atlas again, and check whether it looks right.
Printing or exporting an atlas
Once you are happy with the coverage of your atlas pages:
· If you want to, make the coverage layer invisible by going to the Atlas settings and putting a tick next to Hidden coverage layer.
· Also in Atlas settings, you can choose whether to export multiple files, or tick next to Single file export when possible to generate a single file with multiple pages. This will work for pdf, but not most image formats.
· Double-check the scale is still correct.
· Go back to the Atlas toolbar and either click on the button to print your atlas, or choose one of the export buttons.
· If you are printing later, then choose pdf. This will also work best if you are going to make changes to your maps in Inkscape.
· If exporting, choose the folder you want to save your output(s) into, then click Select Folder.
· The defaults are usually fine, so stick with those for now, and press Save.
Depending on the number of pages you may have to wait for a bit, but once QGIS tells you it has finished, your file(s) should be available in the folder you selected.
Check the output, and make any changes to your coverage or layout as necessary.
There are other settings you can try, including using Expressions to add a page number or a different title for each page. The sources of help suggested below include more on this.
If you have a vector grid, it is also possible to create a final, less detailed map, which shows the coverage of each individual page - a map index.
[image: ../../shared/docs/images/layout/MapIndex_small.png]
A map index created from the coverage layer with the grid rectangles labelled with the map number.
Other sources of help for creating an atlas
There is a lot online about creating atlases in QGIS. Try any of the following:
· Training manual lesson on using the Atlas Tool - this uses a vector grid to control the pages of the atlas and this is what you are most likely to need for field slips.
· QGIS manual page for Generating an Atlas
· Klas Karlsson YouTube video on creating an atlas
Recommended reading: layout and presentation
The following references from the reading list[footnoteRef:1013] will give you information on the principles behind producing a professional layout. [1013:  Available in Minerva and via the University Library reading list page - just search for the module number.] 

· Darkes and Spence (2017) - large parts of this book are particularly relevant but it is formatted as a quick reference guide so it’s easy to get quick information about what ever you are looking for. Unfortunately, this book isn’t available online, but is worth buying if you want to buy one book for this module.
Particularly useful in the Darkes and Spence book are the pages at the end titled “Better mapping in 5, 15 and 50 minutes”.
· The article by Frye (2001) gives you quick information about communicating with maps.
Technical information
· The QGIS User Guide includes a chapter on Laying out the maps which covers a lot of the techniques from this chapter plus a few other things such as generating an atlas.
· QGIS Tutorials has a tutorial on Making a map in QGIS 3.
Further information and inspiration
· University of Delft publishes GIS OpenCourseware. Their tutorial on Cartography for map figures in academic journals and books is a clear look at how to include maps in other publications. This is well worth going through.
· For examples and ideas look at the ESRI Map Book Gallery.
· The British Geological Survey printed maps are available online via the BGS Maps Portal and it’s worth having a look at the layout of some of the more modern sheets, such as the Glossop sheet or the Bath sheet.
Viewing your data in 3D
The background to viewing your data in 3D will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate how to import height data in to GIS
· display a map in 3D to aid the interpretation of your data
· extrude vector data for 3D display based on a value from the attribute table
Introduction
Once you have created features and data in GIS you can view the map in 3D and see how your data relates to other features. You’ll be able to export 3D views from QGIS to include in other reports and layouts.
Data to download
Borehole data
Download the Boreholes.csv file from Minerva and load into QGIS using the instructions you used to load the gravity data points.
Download DTM files from Digimap
You’ll need to obtain height data from Digimap and merge the tiles for use in QGIS.
DTM stands for Digital Terrain Model. You may also come across DEM which stands for Digital Elevation Model. There are differences in the data but both can be treated in the same way.
Use Digimap O.S. Data Download
· Search for Llanbedr - it’s the one in Gwynedd - and download data for at least the area shown below (a bit more than this doesn’t matter, but don’t download too much or the processing will take ages):
[image: images/analysis/DigimapDownloadDTM.png]
The area for which to download data - OS Terrain 5 DTM.
· When selecting data products go to Land and Height Data and select OS Terrain 5 DTM - make sure you select the DTM not the contours.
· Once you have the data in the basket select the download format as ASC
Save the resulting download to your disk and unzip it.
Producing “seamless” datasets from more than one tile of dtm data
If you are using more than one tile of dtm data (which you should be for this exercise) follow the instructions below to combine the multiple files into one single one. This will make it possible to use the files as a continuous surface in maps and 3D scenes. During this process we will also convert the multiple asc or tif files into one single tiff file.
· If QGIS isn’t already open, open it now.
· Use the Browser panel to find the dtm files that you downloaded from Digimap and check the Layer Properties of one of the .asc files.
· In particular look for theCRS and the Data type and make a note of both then close the layer properties.
[image: images/three_d/DTMLayerProperties_small.png]
The layer properties for one of the .asc dtm files. Note particularly the CRS and the Data type - you’ll need these later.
[image: images/svg/videocam-black-24dp.png] Creating a seamless raster from multiple DTM tiles in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Go to Raster > Miscellaneous > Merge...
This opens one of the QGIS tools.
· In the Merge dialog click on the three dots button next to the Input Layers
· Click on Add File(s)... and navigate to the folder containing your dtm data
· Use the dropdown next to File name: to select Arc/Info ASCII Grid (*.asc *.ASC) - this will restrict the files that you’ll see to just that extension
· Add all of the files with an extension of .asc by selecting them and clicking on Open. They should appear on a list and each of them should be ticked.
· Click on OK to add them to the tool.
The Input layers field of the Merge dialog should now tell you the number of input layers that you have added.
· For the Output data type select the data type that you found in the Layer Properties above. In my case this is Float64
· Go down to the Merged field which currently says [Save to temporary file] and use the button at the end of the field to select Save to file...
· Browse to the folder in which you want to store the file and give it a name, such as MergedDTM
· The file will automatically be given the extension of tif
· Click Save
· Then click to Run
[image: images/three_d/MergeDTM_small.png]
The Merge dialog for raster tiles.
The tool should run and add a new layer to your map. You can Close the dialog when it runs successfully.
[image: images/three_d/MergedDTM_small.png]
Part of the merged DTM - it should look like a single continuous greyscale file.
Check that the file looks OK, and also check that the coordinate reference system is set correctly
· Right-click on the layer and go to Properties
· Look at the Information tab and check that the CRS is correct.
If it isn’t you will need to reproject the file to the same CRS as your map.
You don’t need this layer to be visible in this map, just present, so move it to the bottom of the list in the Layers panel and turn it off.
Creating profile graphs
QGIS enables you to draw a profile graph, or cross-section, across your map using z values in your raster surface files or heights above sea-level. You have the elevation and gravity surface layers on your map and can use profile graphs to compare those. Note that this is for purposes of the exercise - the gravity data is already adjusted for elevation so any correlation you may notice is down to something other than elevation.
There is a plugin called the Profile Tool which is very simple to use, but which has limitations. If you would like to try that then you’ll probably find it pretty easy to use. Instead, for these exercises, I’ll take you through how to use a plugin called qProf. This allows us to have control over the x and y axes, and to export the graph in such a way that it is possible to display it properly on a layout.
Using the qprof plugin
· You’ll need to install the qProf tool plugin by going to Plugins > Plugin Manager.
The description of this tool talks about plotting geological data, but for the purpose of this exercise we won’t need to use that functionality.
· To open qProf go to Plugins > qProf > qProf.
The qProf window should open as a panel to the right of your map area.
[image: images/three_d/qProfPanel_small.png]
The qProf window.
[image: images/svg/videocam-black-24dp.png] Creating a profile graph in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
The first thing you need to do is select the layer that contains your z or height data.
· Check that the Topography tab is selected at the top of the qProf panel.
· Click on the button to Define source DEMs
· From the list tick the box next to MergedDTM, or your height layer and click OK.
Next you need to define the input line, i.e. the line of your profile. We’ll start by using a temporary, or Digitized line.
· Check that the interpolated gravity layer is visible on your map - this shows the extent of your gravity data.
· Make sure that Digitized line is checked on the qProf dialog, then click on the Digitize line button.
· You are given brief instructions. Click OK when you’ve read them, then on your map:
· left-click at the centre left of the gravity layer
· then left-click at the centre right of the gravity layer, ensuring that your line goes from one side to the other of the gravity layer.
· right-click somewhere on the map to stop drawing the line.
You should end up with a red line across your map. Now you can generate the profile.
· First make sure that DEM input is checked in the GPX input section at the bottom of the panel, then click on the Read source data button. Hopefully you’ll get a message saying Data profile read. Click OK to dismiss the message.
· Next click on Calculate profile statistics. You should get a small window full of numbers. Close this, it shows that qProf has successfully created points at regular intervals along the line and assigned a height to them from the DEM.
· Then click the Create topographic profile button. You’ll get a Topographic plot parameters window at this stage.
· Set vertical exaggeration to 1 - you can set it higher if you particularly want to show the shape of the land, but for scientific purposes you will usually need to set it to the real-world exaggeration, which is 1.
· Leave the Plot z max value as whatever qProf has calculated.
· Have a look at the range of heights in your merged DTM and set the Plot z min value to something just below the lowest value. In my case I’m going to set it to -5.
· If you want to change the colour of your line you can click on Elevation line visibility and colours, then on the colour patch. Change the colour if required, then click on OK.
[image: images/three_d/qProfTopoParameters_small.png]
Filling in the Topographic Plot Parameters. Particularly note the vertical exaggeration.
· Now click on OK to generate the profile.
A simple profile window should open. You can resize this to make the plot larger or smaller.
Have a look at your output and compare it to your line on the map then close the window with the cross at the top right.
[image: images/three_d/qProfProfileWindow_small.png]
The generated profile. You can enlarge the window to make the profile larger.
· The x axis shows the distance in map units, which in this case will be metres. You can check this in the project properties if you need to.
· The y axis shows the values of your chosen “surface”. In this case the height data, which is also measured in metres.
· Note that if you have set the vertical exaggeration to anything except 1 the x and the y axes will not be in proportion to one another. Also note that if you follow the instructions further on for adding a profile to a layout, this won’t make any difference as it will end up to scale anyway.
[image: images/svg/create-black-24dp.png] Experiment by drawing different lines
Click on Digitize line again and try drawing a few different lines across your map in any direction you fancy to see what the terrain is like. You’ll need to click on all three buttons in the lower part of the tool again each time.
Adding a second profile to the same graph
It is possible to add multiple layers to provide z values on the same profile graph.
· You also have the interpolated gravity layer on your map. You can show both layers on the same profile to compare before and after the eruption.
· Click on the Define source DEMs button again and this time select both the MergedDTM and interpolated gravity layers, then click OK.
· Now follow the instructions above again to digitise a line across your map then view the profile. Using the Topographic Plot Parameters you can set each profile to a different colour so that you can tell them apart.
The output should look something like the image below. Changing the colour of one of the lines makes it simpler to remember which is which. In my profile the MergedDTM layer is green and the interpolated gravity layer purple.
[image: images/three_d/qProfProfile2_small.png]
The qProf tool with two elevation layers set - MergedDTM in green and interpolated gravity in purple.
When you’ve finished experimenting just close the qProf tool panel. This will clear the settings that you’ve been using.
Using a feature class for the line on the map
So far, you’ve only used a temporary line on the map for the line of the profile. When you close your map, this line will disappear. If you are going to include the profile on the map layout you also need to show the line of the profile on the map. To do this you can create a feature class and digitise a line across the map. It is also possible to use an existing line feature, such as a river or a road to create the profile, but we’ll digitise a line for now.
· Create a new line feature class called ProfileLine and add it to your Layers panel above the other layers. This feature class can be either a shapefile or a layer in a geopackage, it’s up to you. Double-check the data type is line and that you’ve set the CRS to the same as the project - EPSG:27700, British National Grid.
· Digitise a line across your gravity layer again.
· Open the qProf tool again in the same way as before.
· Add MergedDTM and your interpolated gravity layer under Input DEM.
· Under Input line click to check next to Line layer.
· Click on Choose layer button and set the Input line layer: to your ProfileLine layer.
As there is only one line in this feature class you don’t need to worry about the other settings.
· Click OK
· Click on the Read source data, Calculate profile statistics and Create topographic profile buttons again to generate the profile, setting vertical exaggeration to 1 and Plot z min value to a figure lower than the lowest measurement in your gravity layer. You can also change the colour of the lines so that you can tell them apart.
The result should look the same as the previous result with two lines.
[image: images/svg/create-black-24dp.png] Checking the data
Have a look at your profile graph. Does this look as you would expect it to? What are the differences between the before and after layers and are they as you would expect?
Saving the profile graph
You can save your profile graph as an image to add to other work, e.g. in Word or PowerPoint.
· If you still have the profile graph open you can close it now.
· Click on the Export tab at the top of the qProf panel.
· Click on the Figure button.
· You can change the size of the image and various other parameters here.
· Click on Choose to navigate to where you want to save the graph and give it a name. For now, give the file name an extension of .tif to save the output as an image.
· Click on Save then OK to actually save it.
· For now keep the qProf dialog open - you’ll use the same profile for the next section.
The resulting tiff file can be added to reports or map layouts as any other image can, but see below for an alternative.
This output is rather basic. It simply gives you the profile without any labels, titles, etc. If you are going to include a profile graph on a map layout or in a report you will need to annotate it with titles, labels, etc.
One way to add annotations is to export the figure as .svg format instead of .tif, open the file in an editor, such as Inkscape, and add the annotations there.
Viewing 3D topography in QGIS
Sometimes being able to view your data in relation to the land surface can really help you to interpret it. QGIS has a plugin which is an effective and simple way of allowing you to do this.
Recently QGIS has gained an inbuilt 3D map viewer. It is being actively developed as of August 2021 and the version in 3.20 of QGIS has more functionality than the version in the Long Term Release (currently 3.16), but for now the plugin I show you below is more reliable. The inbuilt 3D viewer is worth keeping an eye on in future, though.
The Qgis2threejs plugin
QGIS has a plugin which gives more options for viewing your data in 3D, including extruding vector layers, and it is worth installing this and trying it out.
Installing the plugin
· Install the Qgis2threejs plugin in the same way you’ve used for other plugins
[image: images/three_d/InstallQgis2threejsPlugin_small.png]
Installing the Qgis2threejs plugin.
Creating a 3D view
These instructions use the Qgis2threejs plugin.
· You can open the plugin either by clicking on the button on the toolbar or by going to Web > Qgis2threejs > Qgis2threejs Exporter
The window that opens will have a blank main window and a list of your layers on the left.
[image: images/svg/videocam-black-24dp.png] Viewing a map in 3D with the Qgis2threejs plugin
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Under the DEM heading in the layers on the left click to put a tick next to your merged DTM layer (remember to some extent DEM and DTM are the same thing).
Your map should appear and should already be shown as a 3D view.
[image: images/three_d/Qgis2threejsExporter_small.png]
The Qgis2threejs exporter with the Merged DTM ticked in the Layers and the map in a 3D view on the right.
· Use your mouse to navigate in the scene. The mouse wheel will let you zoom in and out. If you click on the map you get a pop-up menu with the coordinates at that point and an option to zoom in to that point or orbit around it (press Esc to stop orbiting). Just have a go!
· You can also use the navigation tool at the bottom right of the 3D map view - if it isn’t visible go to View > Widgets > Navigation widget and put a tick in the box next to it. It’s a bit limited, but try clicking on one of the coloured dots to see what happens.
[image: images/three_d/Qgis2threejsNavigationWidget_small.png]
The navigation widget showing the orientation of the main axes.
· Press F5 on your keyboard (reset) to get back to the original view
· Go to Scene > Scene settings.... In this view you can change the Vertical exaggeration - set it to 3.0 and click Apply to see what happens. Use this setting with care - for a scientific map it’s usually best to stay at 1.0 which is the actual vertical setting.
[image: images/svg/create-black-24dp.png] Look at how the geology layers relate to the elevation
Go back to your main map and turn off the interpolated gravity layer.
Now make the geological layers visible again and have a look at how they relate to the elevation. Does this view help you to interpret what is happening?
Exporting an image
Once you have a view that shows your data in a way that will enhance the interpretation you can export it as an image. The image can then be included in reports and map layouts.
· File > Save Scene as... > Image (.png)
· You can change the output size here if you wish, then click on Save
· Navigate to wherever you wish to save the image and give it a name then click on Save.
The DEM settings
There are other settings that you can experiment with.
· Right-click on the DEM layer in the left-hand panel.
· Click on Properties.
Some of the settings here control the quality of the output image.
· Raising the Resampling level increases how much of the data from the original DEM QGIS uses to render the 3D effect. Raise with care - the higher the setting the longer it will take the 3D view to draw. With a lower resolution DEM this may not make much difference as the more detailed data isn’t there to be resampled.
· If you zoom in to the 3D map it may not look particularly good quality. To increase the quality you can increase the setting for the Texture width (px).
· Try typing 2048 into the box, click Apply and have another look at the map view.
· Again, be careful how high you set this - higher numbers will make the 3D view take longer to draw.
[image: images/three_d/Qgis2threejsDEMProperties_small.png]
The DEM Properties panel showing the alterations you can make to the output quality.
Draping an aerial view on the 3D view
Aerial and satellite images can look very effective viewed in 3D.
· Close the 3D window to go back to your main map and make the geological layers invisible again.
· Use the instructions under XYZ Tile maps in QGIS to add the Bing Aerial XYZ tiles to your Browser panel, then add them to your map so that they are at the top of the list of layers.
· Open the Properties for your MergedDTM (height) layer in the 3D viewer and set the Texture width (px) to 2048. This makes a noticeable difference to the imagery layer. If you have a powerful computer you could even try 4096. Don’t rush it, though!
[image: images/three_d/3DView_small.png]
The Bing satellite layer draped over the DEM in Qgis2threejs.
Have a look around the result. This is an aerial imagery layer, but you could do the same thing with geological maps or other data layers.
Extruding vector layers
It is possible to show vector layers in 3D. A popular use for this is to extrude building polygons if you have the height of the roof. In this case we’ll extrude the depth of boreholes sunk in this area. The data is taken from the BGS Borehole Viewer.
· At the beginning of this chapter you downloaded borehole data for Llanbedr from Minerva in the form of a csv file. If you haven’t already added this to your map do so now. Remember that you’ll need to add this in the same way that you did the gravity points.
· The x field is called EASTING
· The y field is called NORTHING
· The Reference System is EPSG:27700 - OSGB36/British National Grid.
· Have a look at the attribute table and in particular the LENGTH field - this is the depth of the borehole below ground-level.
Now you have the vector layer ready to extrude.
[image: images/svg/videocam-black-24dp.png] Extruding data in a 3D view with the Qgis2threejs plugin
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the Qgis2threejs plugin again. Your borehole layer should be visible in the left-hand menu now, under the Point subheading.
· Put a tick in the box next to the layer. You should be able to see a series of spheres above your map.
· Right-click on the boreholes layer in the Layers list and go to Properties
· Change the Object type to Cylinder
· Under Z coordinate change Mode to Relative to "MergedDTM" layer (or whatever your DTM layer is called)
· Under Style you can change the colour and opacity
· The Height field is set to Expression so there is an E symbol on a button to the right of the field. Click on this now and enter the following expression: Use Fields and Values from the centre pane to find the field name if necessary.
“LENGTH” * -1
Multiplying the length by minus one will extrude the boreholes below the map. For extruding features above the map you will only need to include the name of the field.
· Once you’ve done that click OK and then click on OK again.
[image: images/three_d/BoreholesProperties_small.png]
The properties dialog for the extruded layer.
Your cylinders should disappear leaving only a patch on the terrain. If you use the mouse to tip the view up to see under the land surface you will be able to see the longest borehole - this is the Mochras Borehole. But what about the others?
· Right-click on the DTM layer in the Layers list and go to Properties
· Untick Build sides and tick Build frame
· Click OK
Your scene should redraw and you should be able to see all of the points extruded downwards. You can make these more obvious by changing the expression in the properties of the point layer to increase all of them, e.g. by doing * -2 instead of * -1, but that does make the Mochras Borehole very long indeed!
[image: images/three_d/BoreholesBelow_small.png]
The extruded boreholes seen from below the map.
Again, this can be exported as an image by going to File > Save scene as... > Image (.png).
Saving a 3D scene as an interactive web page
One of the fun things about Qgis2threejs is that you can export the 3D scene in a way that can be interactively viewed by anyone with an up-to-date web browser. In fact, this was originally the main point of this plugin.
· Go to File > Export to Web...
· Next to Output Directory click on Browse... to browse to the folder where you want to save the web output. I’d suggest you make a new folder within the project folder and call it something like Web.
· Leave the HTML Filename as index.html
· If you wish, enter a Page Title which briefly says what your scene shows.
· Tick next to Enable the Viewer to Run Locally.
· Then click on Export.
[image: images/three_d/3DExportToWeb_small.png]
The Export to Web settings.
Once you’ve done this a set of new files will appear in the folder that you selected, and you’ll see the Log which gives you a list of folders as links.
[image: images/three_d/3DExportToWebLog_small.png]
The Log for Export to Web showing the output folders as clickable links.
Depending on your default web browser, you should be able to click on the link next to Web page file to open a view which looks very like the one you have in Qgis2threejs.
You can also double-click on index.html in the folder.
You can share this with people who don’t have GIS by giving them the whole folder of files and telling them to click on index.html. Do be aware that the data in these is still liable to copyright, though. In particular, data from Digimap shouldn’t be shared with anyone who isn’t a member of UK Higher Education and signed up to the Digimap terms and conditions.
Further information about Qgis2threejs
· If you want to find out more about Qgis2threejs see the tutorial by Alasdair Rae.
Recommended reading: Elevation and 3D mapping
The general books in the module reading list[footnoteRef:1119] include sections on elevation and 3D mapping. [1119:  Reading list available from Minerva and from the module catalogue.] 

· For a quick overview look at Darkes (2017) - pages 46-47 look at Relief.
· Heywood (2011) has a section on Modelling the Third Dimension on pages 99-100.
· Longley (2015) covers User Interation and Representation in 2.5-D and 3-D on pages 282-284.
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Choose or create an authentication configuration

No Authenticatior ¥ %L-l

Configurations store encrypted credentials in the QGIS authentication database.

HTTP
Referer

‘ OK Cancel = Help
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Q Save Map as Image

v Extent (current: map view)
North 6541303.0134
West 12452961.8865

South 925386.0850

East 18097499.0031

Calculate from Layer ¥ lap Canvas Exter Draw on Canvas

Scale 1:24037952
Resolution 192 dpi
Output width 1775 px
Output height 1766 px

v/ Draw active decorations: none

v/ Draw annotations

v | K|~

—n— (4

OO

Append georeference information (embedded or via world file)

Copy to Clipboard Save  Cancel Help
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@ Project Properties — General

& Transformations
Default Sty

B8 Data Sources

B g Relations
Variable:

B Macros

QGIS Server

& Temporal

~ General Settings

Project file  K:\gis\GeolGeoph\gpsQ\ChanCourt.qgz
Project home ~ K:\gis\GeolGeoph\gpsQ

Project title  Chancellors Court, University of Leeds
Selection color |~ Background color

Saye paths  relative -

"Avoid artifacts when project is rendered as map tiles (degrades performance)
~ Measurements

WGS 84 (EPSG:7030)

Elipsoid
(for distance and area calculations)

Semi-major 6378137000 Semi-minor 6356752.314
Units for distance measurement  Meters
Units for area measurement Square Meters

~ Coordinate and Bearing Display
Display coordinates using Map units (degrees)
Coordinate precision © Automatic ' Manual 2 decimal places
Bearing format Customize.

> Project Predefined Scales
Generate Project Translation File

Source language Generate TS File

OK | Cancel  Apply

Help
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%2 Project Home
v [ getmapping_rgb_25cm
v Sse
=" se2934_rgb_250_01,pg
» £ se2934_rgb_250_01.xml
» & Aerial_Digimap_Terms_of_Use.pdf

» (X ChancellorsCourt
v [ StudyArea.gpkg
» (2 ChancellorsCourtBNG
» (9 stGeorgesFieldBNG
» & Waypoints_26-FEB-14.gpx
» & Waypoints_type_26-FEB-14_map.pdf
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Waypoints_26-FEB-14.gpx
2" route_points
routes

=" track_points
V" tracks
waypoints
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@ Layer Properties

Metadata

Preview  Attributes

Information from provider

Name
Path
Source

Storage
Comment
Encoding
Geometry
CRS
Extent

Unit

waypoints
Ki\gis\GeolGeoph\gpsQIGPS_data_ChanCourt_201711\Waypoints_26-FEB-14.gpx
K/gis/GeolGeoph/gpsQ/GPS_data_ChanCourt_201711/Waypoints_26-FEB-14.gpx|
layername=waypoints

GPX

UTF-8
Point (Pointz)

EPSG:4326 - WGS 84 - Geographic
-1.5559010000000000,53.8047609999999992 :
-1.5545730000000000,53.8053990000000013
degrees

Feature count 53

Identification

Identifier

Parent Identifier
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Q *Chancellors Court, University of Leeds - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEBRRY UPLrLHPP RABLIC &0 -R-&6-L,EE#Z&-0 0 >
LA A A N > - qE ® - +

Browser ®
DRYHO [}
» [] mastermap =
- @ @
(R LocationBNG.shp °

o o
=" Waypoints_type_26-FEB-14_map.pdf °

(R Waypoints_type_26-FEB-14_map.pdf

- » (X ChanCourt
%~ » [ Home
@~ » e °

% Layers ® o ©
@
@

MEZ T2 £52 % 1- ©
v © Waypoints 26-FEB-14 waypoints

o0

o ©

0
o

| Q Type to locate (Ctrl+K) Coordinate -1.5559299,53.8049874 § Scale 1:292 v @ Magnifier 100% % Rotation 0.0° |4 v Render €EPSG:4326 @
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(@ save Vector Layer as...

Format GeoPackage

File name  K:\gis\GeolGeoph\gpsQ\University.gpkg €

Layer name ‘Waypoinls

CRS EPSG:4326 - WGS 84

Encoding UTF-8
Save only selected features

» Select fields to export and their export options

» Geometry

v Extent (current: layer)
North |53.805399000

West |-1.555901000 East |-1.554573000

South |53.804761000

Current Layer Extent Calculate from Layer Map Canvas Extent
v Layer Options

DFSCRIPTION
V' Add saved file to map OK | Cancel

Help
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] university.gpkg

] University.gpkg-shm
] university.gpkg-wal
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Save edits Clear all selections Attributes (columns)

i oo T 5 P 3 — g %

Toggle Editing Mode

Q
/EER 50«80 WEELYESS T A Y Y Y Y
i e tme maguar  geodheight name E desc w -
Click in the grey box | 3 emen  PUE2 o uesons s s e
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select a feature 3 3 7sewess  0l02E o Loz L i o
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> e PHRE e
20140226
U 7aswse e oo wt o o
Features (rows) PEED
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10 38 70.60511 s,z 21] L MULLO38 n L zLL
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Selected features - | 3
these will also be —__ 7 5683792
ighli oy D140
highlighted on the map 0.468407 b
s a s 20022 L 043 L L L =
T Show Al Features,.
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Q University Waypoints :: Features Total: 53, Filtered: 53, Selected: 1

VAER: |
123fid v =
fid

1 1
2 2
5] 3
4 4
5 5
6 6
7 7
8 8
9 9
10 10
11 11
12 12

Y Show All Featuress

€

ele time

87.607727 2014-02-26T14:...

71.346558 2014-02-26T15:..

71.475174 2014-02-26T15:...

71.282623 2014-02-26T15:...

73.088913 2014-02-26T15:...

73.350418 2014-02-26T15:...

72.554642 2014-02-26T15:...

72.018021 2014-02-26T15:...

71.540848 2014-02-26T15:..

67.672897 2014-02-26T15:...

66.503128 2014-02-26T15:...

66.839432 2014-02-26T15:..

BEEx0 B $ENLTVTEDSD BRZE

magvar

= @,
geoidheight

NULL NULL 001
NULL NULL 002
NULL NULL 003
NULL NULL 004
NULL NULL 005
NULL NULL 006
NULL NULL 007
NULL NULL 008
NULL NULL 009
NULL NULL 010
NULL NULL 011
NULL NULL 012

name

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

cmt

v | Update All

desc
Sign post
Rock
Rock
Rock
Seat
NULL
Seat
Seat
NULL
Bike shelter
Information board

Seat

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

O

Ssrc

X

Update Selected

A
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Q Configure Attribute Table Sort Order X
V Defined sort order in attribute table
Expression Function Editor

0 Lt 2 Search... Show Values| |group field

"name" » Date and Time 4 Double-click to add field
v Fields and Values name to expression
NULL string.
123 fid Values ' @ Search...
1.2 ¢ele
L) time
1.2 magvar
1.2 geoidheight

Feature 001 >

Preview: '001' abe cmt h(

All Unique 10 Samples

v/ Sort ascending
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Layer Styling
" University Waypoints

Single symbol

Unit  Millmeters

All Symbols

L 4 L 4

diamond blue  diamond green
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Layer Styling

= University Waypoints.

& Categorized
Value abe desc

[Symbol o
Color ramp. Random colors.

Symbol ¥ Value  Legend

Ve Bike sh... Bike shelter
Informa... Information board
Rock  Rock
Seat  Seat
Sign post Sign post

Classify @ = Delete Al
» Layer Rendering
o o
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Layer Styling
* " University Waypoints

& 4 Bike shelter

~ i Marker
5 SVG marker

Symbol layer type SVG marker
Width  6.000000
Height 6.000000

Unit  Milimeters
Ao I -
stroke color | -

nofno|

Stroke width No stroke % Milimeters v

nofo|

Rotaton  0.00 ° v

x 0.000000
Offset: Millimeters
y 0.000000 %

oo

VCenter
Anchor point

nofo|

HCenter
SVG Groups

v O.

"] GPS_data_C...
~ [] App Symbols

[ accommodat...

[ amenity

[7 arrows

[~ backgrounds

v

mmodation/accommodation_shelter2.svg €1

6 e V' Live update Apply
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¥ Waypoints_type_26-FEB-14_map.5
> Waypoints_type_26-FEB-14_maps.
» @ crancout
» (] DigitiseDataQ.zip.
¥ TEIR dora Chancrt 0070

Loyers
“awTYEvIAQ
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(@ select Transformation for LocationBNG

Multiple operations are possible for converting coordinates between these two
Coordinate Reference Systems. Please select the appropriate conversion operation, given
the desired area of use, origins of your data, and any other constraints which may alter the "fit
for burpose" for particular transformation operations.
Source RS EPSG:27700 - OSGB 1936 / British National Grid
Destination CRS EPSG:4326 - WGS 84

Transformation Accuracy (meters)
bl Inverse of British National Grid + OSGB 1936 to WGS 84 (9) 1 Britain and UKCS

2 Inverse of British National Grid + OSGB 1936 to WGS 84 (6) 2 UK - Britain and UKCS 4¢

3 Inverse of British National Grid + OSGB 1936 to WGS 84 (2) UK - Britain and UKCS 4¢

>

Inverse of British National Grid + OSGB 1936 to WGS 84 (9)

Scope: Accuracy 1m.

Remarks: Parameter values taken from OSGB 1936 to ETRS89 (3) (tfm code 7709) assuming
that ETRS89 is coincident with WGS 84 within the accuracy of the tfm. Replaces 0SGB 1936 to
WGS 84 (7) (tfm code 5339).

Area of use: UK - Britain and UKCS 49°46'N to 61°01'N, 7°33W to 3°33°E

Identifiers: INVERSE(EPSG):19916, EPSG:7710

+proj=pipeline +step +inv +proj=tmerc +lat_0=49 +lon 0=-2 +k=0.9996012717
+x_0-400000 +y_0=-100000 +ellps=airy +step +proj=hgridshift
+gTids=0STN15_NTv2 OSGBLoETRS.gsb +step +proj=unitconvert +xy in-rad
+xy_out=deg

Show superseded transforms V' Allow fallback transforms if preferred operation fails = Make default
OK | Cancel Help
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% 3 Rotation 0.0° 5 vV Rendell & EPSG:27700
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(@ save Vector Layer as...

Format GeoPackage

File name  K:\gis\GeolGeoph\gpsQ\University.gpkg

Layer name WaypointsBNG

CRS Project CRS: EPSG:27700 - OSGB 1936 / British National Grid

Encoding UTF-8
Save only selected features

» Select fields to export and their export options

» Geometry

v Extent (current: none)
North 434434.9527

West 429344.7422 East [429432.6464

South 434363.4219

Current Layer Extent Calculate from Layer Map Canvas Extent

~ Layer Options
DESCRIPTION

V' Add saved file to map
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(X save Map as Image X

v Extent (current: map view)

North 434539.2358
West 429263.2807 East 429530.1395
South 434257.6133

Calculate from Layer ¥ Map Canvas Extent Draw on Canvas

Scale 1:1200 v | K|~
Resolution 192 dpi

Output width 1681 px

e O

44

Output height 1773 px
V' Draw active decorations: none
v Draw annotations

v Append georeference information (embedded or via world file)

Copy to Clipboard Save = Cancel| Help
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[ @ createvata — agls =

Project Edit View Layer Setings Plugins Vector Rester Detabase Web Mesh HOMGIS Progessing Holp
:

DEERRE @2 2LPRPPrQARaLIOR
MRV AMEB 1/ e = @
[ e on @ = 2

o QRYTO

o
» [ Spatil Bookmarks
© B pojetrome

I e b 25em

» @ CreateData

» & StudyAreagpkg
» [G] Home
» [ €\ (Windows)
| ] Layers
| Cleanva-3nn
} | 5

< VB 52934 rgh 250,01

@ pseron
M Band 2 (Green)
1 5and 3 Glue)

‘@
@-
B

Serscon @
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(@ New Table

Name Paths
Name Type Provider type Length
abe Label Text (string) string 250
<4
Geometry type \/’cLineString v

Geometry column name
Dimensions

CRS

Create spatial index

geom

Include Z dimension Include values (M)
Project CRS: EPSG:27700 - OSGB36 / British National ¢ ¥ @
v

Precision

0

Comment

Down

OK Cancel
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= University.gpkg
(= Buildings
/" Paths

2" Trees
. Waypoints
o WaypointsBNG
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Buildings - Feature Attributes

fid  Autogenerate
Label ‘School of Earth and Environment

OK | Cancel
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Vertex Editor
X

0429313.8771

1429330.1490

2 429330.1490

3/429418.4537

4429418.6521

5/429434.3287

Y
434476.6501

434476.9477
434455.4172
434455.8141
434477.5430

434477.2454
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Layer Styling
(9 Buildings

. =4 Single labels

& Value abe Label

abe 3 abe [}

Calibri

Regular MKE

u@e. sle 1@,

4.0000 e,
Map Units MR XS
coor [ - <.

Opacity m———— | 100.0 % - 4Z[v

All Settings

v Live update Apply
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Layer Styling

(O Buildings

[ & single Labels
@aValue abc Label

Placement
ol General Settings

The Placement Mode option controls the overall placement of

labels relative to their corresponding features.
Mode Horizontal =

Arranges label candidates scattered throughout the polygon. Labels
will always be placed horizontally, with placements further from the
edges of the polygon preferred.

Allow placing labels outside of polygons a,

> ‘Geometry Generator
Data defined
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Chancellors Court, University of Leeds

429300 429400

Key

% Trees
--- Paths

School of/Earth [T Buildings
& Envirenment

Building

0 10 20 30 40 50m
I  Eaae . Map created by Clare Gordon
August 2021

429300 429400
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A
SurveyArea
[MOCHRAS INFILL
'MOCHRAS INFILL
'MOCHRAS INFILL

MOCHRAS INFILL
HARLECH
HARLECH
HARLECH
HARLECH

B

StationlD
SH_52801
SH_52823
SH_52812
SH_53D37
SH_52813
SH_62A05
SH_62A07
SH_52825

c

D

E

Latitude Longitude Eastings.

528125
52.813671
52813
52.81517
52.817669
52.83667
52818169
52.838501

411517
-4.12483
410317
41175
-4.0695
-4.05083
-4.120:

256160]
257460
256810
258280
257320
260610
261810
257180

326140
326090
326300
326590
328620
326520
328920

G

H

il

K

L

M

StationEle BaseCode Observed_grav FreeAirAn TerrCorm BouguerAn CorrBA

41

69

1312.89
1316.13
1313.44
131957
1315.88
131254
130034
1318.54

368
091
247
10.65
148
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029
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035
075

-3.85
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14
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356
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249
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‘@ Plugins | Installed (1)

9 DB Manager

Installed Plugins

Here you only see plugins installed on your QGIS.
Click on the name to see details.

Click the checkbox or double-click the name to activate or deactivate the
plugin.

You can change the sorting via the context menu (right click).

Upgrade Al Uninsall Pugin Reinstall Plugin

Cose | Help
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@ Plugins | Not installed (931)

Q spreadsheet
% GooGIS

Spreadsheet Layers

Load layers from spreadsheet files (*.ods, *.xls, *.xIsx)

This plugin adds a "Add spreadsheet layer" entry in "Layer" / "Add new Layer"
menu and a corresponding button in the "Layers" toolbar.

These two links open the same dialog to load a layer from a spreadsheet file (*.ods,
*.xls, *.xIsx) with some options (use header at first line, ignore some rows and
optionally load geometry from x and y fields).

When this dialog is accepted, it creates a new GDAL VRT file in same folder as the
source data file and layer name, expanded with a .vrt suffix which is loaded into
QGIS using OGR VRT driver.

When reusing the same file twice, the dialog loads its values from the existing .vrt
file,

No need to install additional dependencies.

o7 ve7e7Y 99 rating vote(s), 179321 downloads

Tags excel, xisx, ods, xls, spreadsheet, calc
More info homepage bug tracker ~code repository
Author Camptocamp
Available version (stable) 2.0.1
Upgrade Al Install Plugin
Close | | Help
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(@ Create a Layer from a Spreadsheet File

File Name

Q/GP_datalL
Sheet LlanbedrGravity
Layer name [LlanbedrGravity

Rows Number of lines to ignore |0 % Header at first line

V' End of file detection
V Geometry
Fields. Xfield | Eastings ~ | Y field |Northings Show fields in attribute table
Reference system  Project CRS: EPSG:27700 - OSGB 1936 / British National Grid

SurveyArea StationID Latitude Longitude Eastings Northings StationEle BaseCode FreeAirAn

BouguerAn
String v |String v |Real v Real v |Integer v |Integer v Real v |Integer v Real ¥ |Real ¥ Real
MOCHRAS INFILL SH_52B01

52.8125 -4.1345 256160 326050
MOCHRAS INFILL SH_52B23 52813671

4.1 1312.89 -3.85

-4.11517 257460 326140 29

131613 -0.77
MOCHRAS INFILL SH_52B12

52.813 -4.12483 256810 326090 131344

. -2.84
MOCHRAS INFILL SH_53D37 52.81517 -4.10317 258280 326300 1319.57

8.04
Help
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Q Save Vector Layer as...

Format GeoPackage
File name ‘K:\gis\GeoIGecph\NorthWaIes@mg\GPﬁdata\LIanbedr.gpkg\

Layer name Llanbedr
CRS EPSG:27700 - OSGB 1936 / British National Grid

Encoding UTF-8
Save only selected features
» Select fields to export and their export options
v Geometry
Geometry type Automatic
Force multi-type

Include z-dimension

Extent (current: layer)

North {328920.0000

v Add saved file to map OK | Cancel  Help
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Apps Documents Web More ¥

Best match

@ QGIs Desktop 3.20.3
App

il QGIS Desktop 3.16.3 with GRASS 7.8.5

App

QGISs3
[y Open

QGIS Desktop 3.16.3
QGIS Desktop 3.16.11

Recent

Qt Designer with QGIS 3.16.11
custom widgets

Malham

Threlkeld
Qt Designer with QGIS 3.20.3 custom
widgets Skye

Search school and web Ingleton

pe) qgis - See school and web results DigitiseData

bathymeti
Folders (10+) athymetry

FullArea

£ QGIS Desktop 3.16.3 with GRASS 7.8.5 H 3 @ @ &
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Layer Styling
2" Llanbedr LlanbedrGravity

= Graduated
Value 1.2CorrBA
Symbol
J| Legend format %1 - %2 acision 2€3 5V Trim
Method Color

Color ramp - . -

Classes Histogram

Legend
-4.5600 - -0.8980 -4.56 - -0.9
-0.8980 - 4.5200 -0.9 - 4.52
4.5200 - 12.4880 4.52 - 12.49
12.4880 - 13.5460 12.49 - 13.55
13.5460 - 14.3400 13.55 - 14.34

Mode E}Equal Count (Quantile) ¥
Classify &b = Delete All

V' Link class boundaries

» Layer Rendering

b e v Live update Apply
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Layer Styling
2" Llanbedr LlanbedrGravity
= Graduated

Value 1.2CorrBA

[abe]
Symbol

A Legend format %1 - %2

Method Color

acision €1 5| 'V Trim

Color ramp

Classes Histogram

. Load Values

2 B
?- -

ED 5) 10
Histogram bins 30

‘[D HEN

a
Show mean value

Show standard deviation

» Layer Rendering
b

v Live update Apply
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Processing Toolbox
& LR
Q Search
» (U Recently used
» (@ Cartography
»  Database
» (Q File tools
» @ Interpolation
» @ Layer tools
» @ Mesh
» @ Network analysis
» QPlots
» (@ Raster analysis
» ( Raster creation
» (Q Raster terrain analysis
» (Q Raster tools
» (@ Vector analysis
» (@ Vector creation
» @ Vector general
» (@ Vector geometry
» @ Vector overlay
» (@ Vector selection
» (@ Vector table
» @ Vector tiles
> dm GDAL
» < GRASS
» & SAGA
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Q IDW Interpolation

Parameters  Log

Input layer(s)
Vector layer " Llanbedr LlanbedrGravity
Interpolation attribute 1.2CorrBA

Use Z-coordinate for interpolation

Vector layer Attribute Type
Llanbedr Lla... CorrBA Points

Distance coefficient P

2.000000

Extent (xmin, xmax, ymin, ymax)
255150.0,262660.0,325330.0,328920.0 [EPSG:27700]
Output raster size

Rows 719 < Columns 1503
Pixel size X 5.000000 < Pixel size Y 5.000000
Interpolated

K:/gis/GeolGeoph/NorthWalesQ_ceg/output/IDWgrav.tif
V' Open output file after running algorithm

0%
Run as Batch Process...

D

D

D

Cancel

Run  Close  Help
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Crown éopyriéhgaﬁd databa‘se rights ’2020. Ordﬁance Survey (100025252)
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Processing Toolbox

a0l T ¥
- Q 1DW
v ( Interpolation

IDW interpolation
v & GDAL
v Raster analysis

i, Grid (IDW with nearest neighbor searching)
v & GRASS
v Raster (r.*¥)
@ rfill.stats
@ r.surf.idw
¥ Vector (v.*)
@ v.surf.idw
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@ IDW Interpolation X
Parameters | Log
Input layer(s)

Vector layer 2 UanbedrGravity -
Interpolation atribute | 1.2CorrBA >

Use Z-coordinate for interpolation

| =
Vector layer Attribute Type
LlanbedrGra... CorrBA Points v
Distance coefficient P
2.000000 s
Extent.
255150.0000,262660.0000,325330.0000,328920.0000 [EPSG:27700] ]
Output raster size
Rows 719 < Columns 1503 s
Pixel size X |5.000000 4 Pixel size Y |5.000000 B
Interpolated
K:/gis/GeolGeoph/Geophys/NorthWalesQ/output/idw.tif €l
V' Open output file after running algorithm
| 0% Cancel

Run as Batch Process. Run || Close | Help
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| gb-overview

| GP_data

| raster-25k
NorthWales.qgz
| | OSM.gpkg
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Layer Styling
=" IDWgrav

[ Singleband pseudocolor
Band Band 1
Min  -4.5597684999999¢ Max  14.3040540000000(
v Min / Max Value Settings
User defined

Cumulative

count cut 204

Min / max

Mean +/-

a
standard deviation x 2006 v

Statistics extent Whole raster

Accuracy Estimate (faster)

Interpolation Linear

Color ramp -

Label unit suffix ~ mGal
Label precision 2

Value

Color Label
-4.5597685 . 4.56 mGa

0.15618712

Mode Continuous ~ Classes 5

Classify| (o8| | = | ® | B9
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Layer Rendering

Blending mode | Normal
Lighten
Screen
Saturation Dodge
Addition
Contrast Darken

Multiply

Burn

Brightness

Gamma

Grayscale Overlay
Soft light
Hard light
Difference

Hue

Subtract
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Layer Rendering

Blending mode |Multiply

Brightness
Saturation
Contrast
Gamma

Grayscale

Hue

—
—
—
- |
Off

Colorize
Strength

Reset

2 @3
; 0 S
} 0 s
100 %

“

e— | [100%)|

V' Live update  Apply
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Layer Styling
=" IDWgrav

. Global Opacity

» No Data Value
ol * Custom Transparency Options

Transparency band None

Transparent Pixel List
(SIS

From To Percent Transparent
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Parameters  Log
Input points layer
Uanbedr LianbedrGravity [EPSG:27700]

Selected features only
Name of the attribute column with values to be used for approximation [optional]
1.2CorrBA

WHERE conditions of SQL statement without 'where' keyword [optional]
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Interpolated RST [optional]
K:/gis/GeolGeoph/NorthWalesQ_ceg/output/RSTgrav.tif
V' Open output file after running algorithm
Slope [optional]
[Skip output]
Open output file after running algorithm
Aspect [optional]
[Skip output]

Open output file after running algorithm
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Browser panel for
managing spatial data
on your computer

Tooltips display when mouse pointer
is over a button or other item on a

toolbar or panel \

Map area

Open Data
Source Manager

Qev®o

v 5/ Favorites a

» [ K:\clare_downloads
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